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1. Release Notes for Mekorma Build x91
Mekorma Build x91 was released on Tuesday, June 20, 2023.

• Mekorma Build x91 is compatible with Microsoft Dynamics GP 18.4 and 18.5.

If you upgrade from Mekorma build 90 or an earlier build, and you are using Invoice Capture, you should be
sure the following processes are complete before the upgrade.

• All invoices listed in the Invoice Capture Validation window are processed.
• Stop sending invoices to the invoice email.

Follow the links below for detailed notes on:

• New Features
• Issues Fixed

PLEASE NOTE

If you are a new user, please go directly to: Introduction to the Mekorma Payment Hub.*

If you upgrade from Mekorma build x80, and you receive the error message shown in
the screenshot below, please run the installer again. If this error message persists,
please contact the Customer Success Team and open a support case for assistance:

!

You can always download the most recent version of Mekorma Payment Hub from our
website. Thank you!*
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IMPORTANT: If you are running a Mekorma customization for a version prior to your
current Microsoft Dynamics GP release, please contact Mekorma’s Customer Success
Team before upgrading to ensure compatibility with the new version.
*
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1.1. New Features & Changes
Release Notes for Mekorma Build x91 released Tuesday, June 20, 2023.

Mekorma Payment Hub

Users can choose to receive email notifications for only the batches for which they have requested approval.

Mekorma Enhanced ePayments

If you’re using Corpay, the existing fields Customer Account and Invoice Comments are customizable. The
data in GP tables can be mapped to these two fields and printed on the Corpay remittance. A customized
function is needed to support the mapping. Please reach out to Mekorma Customer Success team at
support@mekorma.com to discuss your needs.

Mekorma MEM Integration

• Users assigned to Approver security roles for workflow can select to be notified by email per
entity.

• The Entity ID column can be viewed in the Mekorma Batch Status, Approval, and Rejected
Payments lists.

Power Approvals

If MEM is installed and enabled, the Entity ID will appear on the main screen of Power Approval. Users can
filter the payments by entering Entity ID in the search box.

Invoice Capture Announcement

If you upgrade from Mekorma build x90 or an earlier build, be sure that all invoices listed in the Invoice
Capture Validation window are processed.

Do NOT send invoices to the dedicated Invoice Capture email address while upgrade is in progress.

PLEASE NOTE

If you upgrade from Mekorma build x80, and you receive the error message shown in
the screenshot below, please run the installer again. If this error message persists,

!
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please contact the Customer Success Team and open a support case for assistance:

IMPORTANT: If you are running a Mekorma customization for a version prior to your
current Microsoft Dynamics GP release, please contact Mekorma’s Customer Success
Team before upgrading to ensure compatibility with the new version.
*
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1.2. Issues Fixed
Release Notes for Mekorma x91 released Tuesday, June 20, 2023.

Mekorma Payment Hub

• When the PDF copy feature is disabled and checks are reprinted, the audit log displays the
correct value for all payments.

• When using a GP web client with MFA-enabled authentication, there are no unexpected
Exchange login authentication window pop-ups.

• When upgrading from a previous version of Mekorma, the registration window displays the
correct version.

• Batches with at least one of the following criteria can move to fully approved without issues.
◦ Batches with the same ID used across different companies.
◦ Both $0 and non-$0 payments included within a batch.
◦ Identical payment numbers used across different companies.
◦ Batches in “pending approval” status while approving another batch with the same batch ID

from a different company.

• For those not using Power Approvals and GP Document Attach, approval request times have
improved for batches with large amounts of transactions.

• When requesting approval for batches with large amounts of transactions, but not using
PowerApprovals and the GP Document Attach feature, performance is improved.

• When using Multi-Entity Management by Binary Stream, the split batches by threshold feature,
and a different checkbook currency than the company’s functional currency, both the original and
the split batch(es) are displayed in the Mekorma Batch Status list in the checkbook currency.

• When out-of-office delegates have overlapping dates, you can navigate to other fields in that field
group without continuously receiving a message about the overlapping dates.

Mekorma Invoice Capture

• Invoices attach to the intended PDF when a batch is processed from the Invoice Capture
Validation window, and no invoices will be incorrectly attached to the next batch.

• When the Email Body Action field in the Invoice Capture Setup window is set to Store, the email
body PDF is attached to the invoice.

Mekorma Mekorma Products User Guide for GP - Build x91_en
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• The Create New Invoice menu option in the Invoice Validation window will be available for all
invoice attachments, including when there is only one attachment on an invoice.

PLEASE NOTE

Last modified: Jun 19, 2023

If you upgrade from Mekorma build x80, and you receive the error message shown in
the screenshot below, please run the installer again. If this error message persists,
please contact the Customer Success Team and open a support case for assistance:

!

IMPORTANT: If you are running a Mekorma customization for a version prior to your
current Microsoft Dynamics GP release, please contact Mekorma’s Customer Success
Team before upgrading to ensure compatibility with the new version.
*
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2. Introduction to the Mekorma Payment Hub
Thank you for your interest in Mekorma products.

Mekorma Payment Hub is a payables solution integrated with Microsoft Dynamics GP®.

The Payment Hub offers:

• The Action Board for Robotic Process Automation (RPA) of your payment process in one unified
window

• A sophisticated payment approval security system
• Check printing and EFT Remittances with the ability to print on blank or pre-printed check stock
• Automated signature logic
• Check image archiving
• Fraud protection via enhanced security configuration options

Mekorma works with Accounts Payable, U.S. Payroll, Canadian Payroll, and is compatible with the
Dynamics GP Web Client.

Mekorma also offers fully integrated add-on products/services to optimize the payment process:

• PowerApprovals allows designated users to approve and reject payments from a mobile device or
web browser, without being logged in to Dynamics GP.

• MEM Connector integrates with Binary Stream’s Multi-Entity Management® product to provide
access to facility information for vouchers printed on Mekorma check stubs.

• Mekorma Remote Payment Services allows you to outsource your payments, ridding you of the
burden of check processing while paying your vendors by check, ACH, wire transfer or credit card and
paying for your costs with rebates.

How to Use This Guide

Last modified: May 16, 2023

Mekorma Mekorma Products User Guide for GP - Build x91_en

Copyright © 2022 Mekorma Enterprises. All Rights Reserved. Page 13 of 379

https://www.mekorma.com/products/micr-check-printing.aspx
https://www.mekorma.com/products/powerapprovals.aspx
https://www.mekorma.com/products/multi-entity-management-connector.aspx
https://www.mekorma.com/products/enhanced-epayments.aspx


2.1. Security and Fraud Prevention
A fundamental reason for Mekorma Payment Hub is its security features. Whether you are processing your
payments by check, EFT or outsourcing through Mekorma Remote Payment Services, security is crucial.
Knowing that your workflow is protected is what can give you peace of mind when you print checks with
automatic signatures or send payments out through your outsource provider or bank. It is a way of insuring
that the proper controls are in place for separation of duties and oversight, essential for fraud prevention.

With Mekorma Payment Hub, the same set of security rules apply whether you are processing checks in-
house, creating EFT files to send to the bank, or automating your payments completely with Mekorma
Remote Payment Services.

Mekorma Task-Based Security
As needs have grown, so has the security model, which is rich with capabilities. Our security model is called
Task-Based Security, which was introduced in Mekorma Payment Hub build x76. The fundamentals are
covered:

• Signature logic with encryption.
• Dollar-value ranges (a.k.a., Threshold Levels) for designing your security rules.
• The Approval Workflow Notification System lets approvers know by email or text when they need to

approve.
• Automatic batch splitting allows payments that are fully approved to go out without waiting for other

payments.
• Approval rules can be configured not only by dollar-value but also by Vendor Classes.

In addition, Mekorma security has been enhanced with the following, all driven by user request:

• You can break your dollar value groupings down as finely as you want for total control. No limit on the
number of levels.

• You can assign any number of approvers to a dollar value group/threshold level.
• Any one approver can be assigned to as many dollar value groups as you need.
• The Mobile approval system option, PowerApprovals, built from Microsoft Power Platform, lets

approvers approve on the go.
• Whole payments or even individual vouchers can be rejected when approving.
• Out-of-Office notification and approval delegation can be configured.

Thinking through what you want to do is an important part of implementing a fully functional approval system
and this guide will help you.

Mekorma Legacy Security
Mekorma is fiercely committed to our existing users, so we have continued to maintain our older security
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models, which we call Legacy Security. This is what Mekorma users have employed for builds previous to
x76 and includes security by:

• User ID
• Checkbook ID
• Default GP security

Because Mekorma is fiercely committed to ensuring your payment process is as secure as possible, we
continue to develop features and improvements for our Task-Based Security model. However, Mekorma
Legacy Security (checkbook/user-based) models will be deprecated as of build 84. Moving forward, if your
security is configured by checkbook or User ID, you can continue to use it but as of the March 2022
Payment Hub release, the functionality will no longer be supported. Please continue to watch our
newsletters and website for updates and announcements.

To understand the benefits of Task-Based security, please see this detailed list of features by security
model and how they compare. Our Customer Success team is happy to help with the transition and
implementation to our Task-Based Security model so you can continue to enjoy the peace of mind that
comes with more robust security to your payments.

What is the Default Setting and What Happens When I
Upgrade?
Task-Based security is the default setting. However, please be assured, if you are an existing customer
using Legacy Security, the Mekorma upgrade process honors your Legacy Security settings and you have
time to plan when you want to implement the new security system.

Last modified: May 16, 2023
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2.2. Remote Payment Services (Outsource
Your Checks)
Mekorma Remote Payment Services handles all your vendor payments through this process flow:

1. you send check batches to the service provider.

2. the service provider (AvidXchange or Corpay) will send payments on your behalf.

3. your vendor will get paid the way they want—by check or electronically.

All your processes, building, processing and posting, will still be done within Dynamics GP. In addition, you
will have access to a portal to download additional payment reports, view cleared status and see
remittances.

You maintain control by:

• approving payments in GP before ever issuing them to the service provider
• making vendor exceptions to print checks locally
• getting exceptional fraud protection from the service provider.
• being able to approve the payments from wherever you are via Mekorma workflow.
• keeping everything in your ERP system.

And you save all of this:

• ordering check supplies.
• folding, sealing and mailing checks.
• enrolling your vendors in EFT programs and managing that sensitive data.
• ease of reconciliation.

Last modified: May 16, 2023
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2.3. Action Board
If your organization can set certain basic policies for how you select your check batches, how often you pay,
which payment discounts you want to capture and what payment methods you want to use, then the
Mekorma Payment Hub provides a way to greatly streamline your processing efforts. This is called the
Payment Hub Action Board and it can save up to 75% of the time you spend in creating and processing
payment batches.

The Payment Hub Action Board allows Mekorma users to perform the following actions, all in one window:

• Build Payment Batches
• Request Batch Approval
• Process Checks and EFTs
• Update Remote Payment Services Status
• Post Payments
• Generate EFT files
• Generate SafePay files

You can select multiple checkbooks across all your companies and do each of these actions with one click.

https://www.youtube.com/embed/k19Brfw8Uww?rel=0&start=79&end=157
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2.4. Power Approvals
Power Approvals enables your Approver team to review and approve payables batches outside of
Microsoft Dynamics GP from your mobile device.

For more information see our website.

Last modified: May 16, 2023
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2.5. MEM Connector
The MEM Connector enables companies who use Binary Stream’s Multi-Entity Management® (MEM)
product to integrate the Mekorma Payment Hub with both payables and payroll.

For more information see our website.

Last modified: May 16, 2023
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3. How to Use This Guide
Welcome to Mekorma’s online User Guide, designed to equip you with the knowledge needed to install,
configure and run payment processes using Mekorma Payment Hub for Payables/ Payroll, the Action Board,
Remote Payment Services and the MEM Connector for Payables/Payroll. This guide can always be
accessed from our website.

The guide is organized into five topic categories:

• Preparing for the Mekorma Payment Hub: Learn what you need to know and plan for before installing
and processing payments with the Mekorma Payment Hub.

• Installing the Mekorma Payment Hub: Describes how to install our product or upgrade to the latest
build.

• Configuring the Mekorma Payment Hub: This section shows how to enable various Mekorma
Payment Hub features and set up your Dynamics GP environment for success.

• Using the Mekorma Payment Hub: Demonstrates day to day use of the Mekorma Payment Hub for
Dynamics GP Payables.

• Using Mekorma Payment Hub for US and Canadian Payroll: Demonstrates day to day use of the
Mekorma Payment Hub for Dynamics GP Payroll systems.

• Release Notes for the Mekorma Payment Hub This section is for existing customers who are getting
ready to upgrade. Read this section prior to upgrade for any important considerations you may have.

• Requesting Support, Implementation or Customization: Explains how the Mekorma Customer
Success team is standing by to help you with whatever you need.

New users can follow step-by-step installation, configuration and usage instructions delivered via written
content and video demonstrations. Experienced users can review this guide for any applicable new feature
information, or utilize it as an ongoing reference tool:

• Pull targeted results using the Search functionality in the top menu bar.
• Use the expandable menu on the left sidebar to discover topics of interest.
• Each page in the Guide has its own unique URL, so individual pages can be bookmarked or links

shared with colleagues.
• Print individual pages by clicking on the printer icon at the top right corner of any page.
• Download/ print the entire User Guide by clicking on the Download as PDF button at the very end of

the left-hand menu.
• At the bottom of each page you will find a general feedback form: please fill out and submit if you

require more information on any particular topic.

Last modified: May 23, 2023
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4. Preparing for the Mekorma Payment Hub
This section of the User Guide walks you through questions to ask yourself and information to gather prior
to implementing the Mekorma Payment Hub.

The first step is to read our Introduction and each of the sections there:

1. Determine in advance which of the major components that you want to implement and place them on
a time-line.

2. Use the Questions to Ask Before Install section to focus on each of these major components.

3. Gather the information and supplies you need for the functions you are implementing.

Last modified: May 23, 2023

Note that our Customer Success team is standing by with a full discovery and
implementation methodology, if you would like help implementing your system.*
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4.1. Questions to Ask Before Installing

Gather Information
Here are some of the Discovery items to consider to optimize your AP payment automation:

1. Gather bank account information
• From what companies and checkbooks will you be making payments?
• You will need the routing number and account information for each checkbook used for

payments.
• Decide what payment types will be made – outsource all payments? or manage separate

batches of checks, EFTs, credit cards, and wire transfers?

2. Review your security model if you want a payment approval process in place.
• How many signatures and approvers will you want on each payment depending on its Dollar

Value and its Vendor Class?
• Do I want to implement the approval system or just print signatures without an approval

system?

3. Gather Signatures
• Do you need signature files for approvers or authorizers?

4. Do you need to Assign Checkbooks to Vouchers or Vendors?

5. Do you want to Outsource some or all of your payments?

6. If you will not outsource any payments, will you be setting up and processing EFT payments in-
house?

a. Will you want your EFT Remittances to match your check Remittances?
b. Will you want your EFT Security to mimic your check security?
c. Will you want Mekorma to email your EFT Remittances so that you can avoid setting Microsoft

word templates?

7. Do you plan to use the Action Board? If so, you will want to review with your AP team their needs:
a. What are the exact processes and frequencies for building AP batches?
b. What are their needs around posting reports?
c. What payment batch types will they be processing—Checks? EFTs? Outsourced payments?
d. What is the printer configuration?

Note that our Customer Success team is standing by with a full discovery and
implementation methodology, if you would like help implementing your system.*
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8. How do you want to store your online check/remittance images?

9. Do you use Multi-Entity Management (MEM) by Binary Stream? In that case, you may need to
purchase the Mekorma MEM Connector and study how to configure it.

Will You be Printing Checks?
Most of our users want to print at least some checks in-house even if they send most of them through EFT
or outsourcing. If you want to print in-house, you will need to consider these supply questions:

10. Printers and Supplies
• Do you have a printer that can do the job? We recommend that you have 2 flat-bed trays—one

for check stock and one of overflows and EFT remittances
• Do you have a Magnetic printer toner?

11. Choose your check stock
• Will you use pre-printed or blank check stock?

12. Check Formats
• Mekorma comes with a library of pre-configured check formats that can be customized from

within the Mekorma Payment Hub Configurator. What formats do you need?

13. Gather images to include on your check
• Will you use a company logo?

14. Do you want enable or disable Blank Check Printing?

Will you use the Mekorma PowerApprovals mobile
application?
If you want to use a payment approval process and give Approvers the ability to approve/ reject transactions
remotely, then Mekorma PowerApprovals is for you! Our mobile application allows Approvers to get the job
done without needing to log in to Dynamics GP. Approvers can use a mobile device or a supported browser.

Please follow this link to get all the details on system requirements and IT considerations.

Last modified: May 16, 2023

Blank check stock is highly recommended as it is one of leading efficiencies that the
Payment Hub gives you. If you are using the Action Board for printing from multiple
checkbooks, you will need to use blank stock as the system will print different checking
account information in the check coding as it prints batches.

!
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4.2. How to Create a Digital Signature
If you will be using signatures as part of your security settings in Mekorma, you will need to gather all
needed signatures and transform them into a digital format. Please watch the video below to view step-by-
step instructions, as recommended by Mekorma:

1. Take a standard 8 ½ x 11 sheet of paper and draw a rectangle that represents the average signature
field.

2. Print (or make) as many copies as there are signers. For example, if six different signatures are
needed, print six copies of the sheet with the empty box.

3. Ask each signer to sign their name within the rectangle. There should be no more than one signature
per page.

4. Scan each sheet into a computer.

5. Open the signatures one at a time in the Microsoft Paint application.

https://www.youtube.com/embed/OaHylmDUuCM?rel=0
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6. With one of the signatures opened in Paint, click on the Select drop-down menu and choose
Rectangular selection. Draw the selection box around the signature as closely as possible and then
click Crop.

7. Click on Resize and choose the Pixels button in the Resize and Skew window. Be sure that
Maintain aspect ratio is checked, and adjust either the horizontal or vertical dimensions. A good
choice for use in GP is a signature file with approximate dimensions of 220 × 50 pixels.

8. Save your signature as a 16 color bitmap.

9. Repeat the same procedure for all needed signatures, and store in a location accessible to an
administrator for use in GP.

• If additional sizing is needed, you can always adjust within the Mekorma Configurator.

Last modified: May 16, 2023
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4.3. Recommended Printers and Supplies
Printers for Mekorma Payment Hub Check Printing

We recommend that you print Mekorma checks to a dedicated medium – higher quality check printer using
blank check stock. The printer should have the following capabilities:

• Speed of 45 ppm and up
• Two-tray capacity
• Recommended monthly printing volume of 5,000 pages and up
• Output capacity of 400 sheets and up

Recommended models

The HP M607 series printers combine exceptional performance and energy efficiency with professional-
quality documents to use as dedicated check printers. This printer series has a speed rating of 55 ppm. The
2-tray option makes it a perfect choice to print checks on one tray and overflow remittances on the second.
It has a recommended monthly volume of 5,000 to 20,000 pages and input / output capacity of 650 sheets /
500 sheets.

Mekorma in-house testing has been performed successfully on the HP M607dn model.

Check Printing Supplies

Check printing supplies include:

• Check stock (pre-printed or blank)
• Envelopes
• Magnetic Toner

You can order supplies by contacting Mekorma’s recommended vendor, Altec. Altec can be reached
by calling 877-201-2005 (Reference – Mekorma) or email. See more information on ALTEC’s flyer.

You can also search the Internet using the key words “blank check stock” or “magnetic toner” to locate
vendors. Mekorma Payment Hub will work with both blank and pre-printed check stock of almost any size.

Blank check stock has the following advantages over using pre-printed stock:

We sometimes get asked whether to purchase a Troy Printer. We have found that Mekorma
is not compatible with the security hardware add-ons or on-board MICR fonts that are found
in Troy Printers. Those features are handled in our product through software, so there is no
need to spend extra for them.

!
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• More secure: Blank stock does not already have the MICR line encoded; it is non-negotiable until your
payments have gone through an approval process and your check printing software generates the
check.

• Cost effective: Pre-printed stock can range from $50-$80 per 250 checks, depending on how
customized your data is. Blank check stock can be purchased in higher-quantity bulk orders, and you
can typically get 1,000 checks within the same price range.

• Less waste: If your company information changes, you have to get rid of pre-printed stock and order
new stock with the correct information. Blank stock does not have that limitation.

• Convenient: You do not have to switch stock in the printer when printing payments from multiple
companies.

Read our blog on the topic.

MICR gauge and check alignment

A free MICR gauge can be mailed to you after your Mekorma Payment Hub order is processed. The gauge
will assist you to determine the correct spacing for the MICR font on your checks. If you would like to
receive a gauge, please email our Sales department.

Last modified: May 16, 2023

Mekorma Payment Hub does not work with duplicating check stock (NCR) because we
only do laser printing which is not “impact” printing. If you want a self-sealing check stock
option, the Z-fold will work. Mekorma Payment Hub does not work with “C” fold check
designs.

*
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4.4. PowerApprovals System Requirements
Power Apps subscription

You will need a Power Apps subscription in order to access Mekorma PowerApprovals. The
subscription model offers per-app or per-user licensing.

• Option #1: Run single apps
◦ This option allows you to run applications around a single business scenario for an

individual user.
◦ $10 per user/per app/per month.
◦ Maximum 2 apps and 1 portal.

Here’s an example of a Single App licensing scenario:
Your organization has 3 Approvers that use Mekorma PowerApprovals. 3 × $10 per user/
per app/per month = $30/month. Yearly investment = $360

• Option #2: Run unlimited apps
◦ This option allows you to run unlimited applications for multiple business scenarios.
◦ $40 per user/per month.

Here’s an example of an Unlimited Apps licensing scenario:
Your organization has 3 Approvers that use Mekorma PowerApprovals. 3 × $40 per user/
per month = $120/month. Yearly investment = $1440

• For additional licensing information click here.
• In addition to the Power Apps license, a SQL Server premium connector is required:

◦ This is included with both the single app or unlimited app licensing. PowerApprovals makes
use of the connector in both the app and the triggered flow.

◦ It is needed to execute the approval procedures at the database server level.

On-premise Data Gateway

The Data Gateway can be installed on server (any server with line of site to SQL Server).

Deployment
The Data Gateway can be deployed centrally and allows you to manage data connections for multiple
cloud apps so you need to install only one gateway to enable cloud to on-premises data connections.
Once the gateway is installed, it is available in all supported apps and can be used to set up multiple
on-premises data connections.

Installation Requirements

• Windows 10, Windows Server 2012 R2, Windows Server 2008 R2, Windows Server 2012,

To purchase Power Apps for an organization, you must already be an Office 365 Global
or Billing Admin of a tenant, or you must create a tenant.*
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Windows 7, Windows 8, Windows Server 2016, Windows Server 2019
• Net Framework 4.7.2 or greater

Microsoft Dynamics GP

The following requirements must be met in order to run Mekorma PowerApprovals:

• Your organization must possess valid licenses for Microsoft Dynamics GP
• You must have valid licenses for Mekorma Payment Hub

◦ The Mekorma Action Board is not required
◦ Task-Based Security must be configured in advance and email settings configured to

match a GP user account with an Azure AD account
• You must have valid licenses for Mekorma PowerApprovals

Supported platforms for running PowerApprovals using the PowerApprovals mobile application
• Android 7 or later
• iOS 12 or later
• Windows 10 (minimum Windows 8.1)
• Power Apps application, downloaded from iOS or Android stores

Supported Browsers
• Google Chrome (latest version)

◦ Windows 7 SP1, Windows 8.1, and 10
◦ Android 5 or later
◦ iOS 8 or later
◦ macOS

• Microsoft Edge (Chromium version)
◦ Windows 10

• Mozilla Firefox (latest version)
◦ Windows 7 SP1, Windows 8.1, and 10
◦ Android 5 or later
◦ iOS 8 or later
◦ macOS

• Apple Safari (latest version)
◦ iOS 8 or later
◦ macOS

Once your system has met these requirements, continue to Setup for Remote Approvals. See here for
instructions on how to use the app to approve or reject vendor payments.

The Mekorma Customer Success team is available for assistance with implementation and
training on PowerApprovals or other Mekorma products.*
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4.4.1. Connecting a Third Party Document
System
If you use a 3rd-party document management system, you may want to consider having the Mekorma
Customer Success team create a connector to your invoice documents using our document bridge.

This will enable your users to drill down into scanned invoice documents during the payment approval
process.

Last modified: May 16, 2023
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5. Installing the Mekorma Payment Hub

Preparation
1. Determine your Microsoft Dynamics GP version before downloading your Mekorma product(s).

2. Download the product installer that corresponds with your GP version from the Mekorma downloads
page.

3. Follow the installation/upgrade procedures.

Last modified: May 16, 2023

Please note, you must install Mekorma on every workstation that performs operations
requiring the use of Mekorma features.*
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5.1. Find Your Dynamics GP Version

What version of Dynamics GP are you running?
Before downloading Mekorma, you need to know what version of Dynamics GP is running so you can
choose the correct Mekorma installer. Here’s how to check:

1. Log in to Dynamics GP.

2. Click on the GP Help ? icon in the top right-hand corner of your screen.

3. Select About Microsoft Dynamics GP…

4. In the example below, the major version is displayed in the title box: Microsoft Dynamics GP 2018.
(More specific version information will be listed under the Version Information column.) This means
that the Mekorma installer corresponding to GP2018 must be chosen from the downloads page.
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Last modified: May 16, 2023

If you need to find the build version of Mekorma you are running, please refer to the
Mekorma Products Manager.

!
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5.2. New Installation or Product Upgrade
Mekorma Payment Hub

Run the Mekorma Installer

1. Log in to Windows as an Administrator. If you are already logged in, make sure to close Dynamics GP
before attempting to install Mekorma.

2. Once the installer has been downloaded, launch the executable file. The file will follow this naming
convention: MICR + GP version + Mekorma build version. (ex. MICR2018b082.exe) – right-click and
select the option to Run as Admin.

3. Select the appropriate GP instance from the drop-down menu. If you only have one GP instance
available, that option will automatically be selected.

4. After following all prompts, click Finish and close the Installer.

5. After you install Mekorma, launch Dynamics GP as administrator and log in as the ‘sa’ user. The
system will ask if you want to upgrade tables now or later. Upon agreement, you must run the Table
Maintenance procedure for a first-time install or product upgrade to take effect.

a. Note that if you are also upgrading Mekorma Remote Payment Services (see below) you can
wait to run Table Maintenance until both modules are upgraded.

6. The Mekorma Products Manager will automatically retrieve registration keys for all installed Mekorma
Products if you are connected to the Internet. If Internet access is not available, please contact
Mekorma Sales.

Mekorma PowerApprovals

PowerApprovals functionality is build-specific unless otherwise noted in our product release notes. For
example:

• PowerApprovals build x80 is only compatible with Mekorma Payment Hub build x80
• PowerApprovals build x81 is only compatible with Mekorma Payment Hub build x81

To install or upgrade PowerApprovals, please refer to the PowerApprovals Implementation Guide.

Remote Payment Services Connector

Installation
The Mekorma Professional Services team and your payment outsource provider will handle the initial
installation of the Remote Payment connector. After the initial installation, you can upgrade yourself as
described below.
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Upgrade
When a new build of Mekorma Payment Hub is released, a corresponding MEEP Providers installer will be
available on the Mekorma downloads page for the Remote Payment Connector and must be installed when
upgrading the Payment Hub.

1. Download the MEEP Providers Installer.

2. Run the MEEP Providers Installer – this will enable Dynamics GP to connect with either the Corpay
or AvidPay platform.

3. Run Table Maintenance.

4. Enter the appropriate data on the Remote Payment Services Configuration window.

Last modified: May 16, 2023

The Mekorma version numbering of the MEEP Providers must correspond to the version
numbering of the Mekorma Payment Hub. Check your version numbering

!
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5.3. Run Table Maintenance
As third-party products are not included in the Dynamics GP upgrade process, Mekorma provides its own
unified table upgrade system for all your GP companies. Table Maintenance must be run anytime you install
or upgrade. You must also run table maintenance after a new company is created in GP. This process
serves to either create tables in the SQL database upon a new install, or to update them when there has
been a software upgrade.

Learn more in the video below:

This window below will appear automatically after you install or upgrade:

https://www.youtube.com/embed/RPbr5d_e4D8?rel=0
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Requirements
• Individual companies can be upgraded at the same time or separately within the Table Maintenance

window.
• No one should be working on a Mekorma product while the upgrade process is running. For example,

no one should be selecting AP or Payroll batches or processing payments via Print Mekorma
Payments, the Action Board, or Remote Payment Services.

• Registration keys are obtained automatically, so when the table update process is complete, Mekorma
Products should be ready to use. If any registration error occurs, see the section on product
registration for more details.

New Mekorma Installation or Product Upgrade:
1. Select the companies that need tables created or updated, and click Process & Enable Selected

Companies. (You do not need to update all companies at the same time).

Only the system administrator is prompted to run the table maintenance process, so be sure
to log in as ‘sa’ after installation. This is true whether you are creating tables for the first
time or upgrading.

!

To manually access the Table Maintenance window, Login as ‘sa’ and go to the Mekorma
Area Page > Setup > System > Table Maintenance. If you are not a system administrator, a
warning message displays and the window will close.
*
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2. When the process is finished, close the Mekorma Products Table Maintenance window.

Last modified: May 16, 2023
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5.4. Products Registration
Upon installation or upgrade, Mekorma keys are automatically retrieved by the system (although keys can
be entered manually if needed). In order to retrieve keys, an internet connection is required (allowing access
to our Mekorma Registration Web Service).

The Mekorma Products Registration window provides the ability to:

1. enter new registration keys

2. request trial period keys and

3. access our online keys retrieval system

The following products require keys:

• Payment Hub
• Payment Hub Action Board (Included with Payment Hub)
• Mekorma US Payroll
• Mekorma Canadian Payroll
• MEM Connector Payables
• MEM Connector Payroll

Last modified: May 16, 2023

For best results, create an inbound and inbound rule in your firewall to allow access to our
web service. Allow IP address 64.74.139.46.

!

To access the Mekorma Products Registration window, go to the Mekorma Area Page >
Setup > System > Registration*

Mekorma Mekorma Products User Guide for GP - Build x91_en

Copyright © 2022 Mekorma Enterprises. All Rights Reserved. Page 41 of 379



5.5. Mekorma Products Manager
The Mekorma Products Manager is a helper dictionary that manages table maintenance and product
registration for all Mekorma products. This dictionary is installed with Mekorma Payment Hub. It is a
required component necessary to run all Mekorma products.

The Products Manager window will tell you what version of Mekorma you are running. You will need this
information in the event you need to open a case with Mekorma Support.

To find the version of Mekorma currently installed:

1. Open the Mekorma Products Manager window.

2. Refer to the string of numbers after any of the listed products. The last four digits before the
parenthesis represent the build number referenced in this User Guide. For example, in the screenshot
below, the Mekorma version is 87.03

To access the Mekorma Product Manager window, go to the GP Help menu > About
Microsoft Dynamics GP > Additional > Mekorma Products Manager*
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Last modified: May 16, 2023

If you need to find the version of Microsoft Dynamics GP you are running, please refer to
this page.

!
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5.6. Print Client for GP Web Client
To print Mekorma checks out of the Dynamics GP Web Client, it is necessary to install the Mekorma Print
Client (MICRPrintClient.exe) on each workstation intended for Mekorma check printing from a Web Client
session. There are two methods for accomplishing this:

1. Install from the GP root folder
1. Open the Dynamics GP desktop root folder where you have installed Mekorma.
2. Go to the Mekorma MICR folder > Webclient folder to access the MICRPrintClient exe file.
3. Copy this file and install it on your desktop or network as administrator.

2. Install from within Mekorma software

1. Open the Mekorma Web Client Download and Installation window.
2. Click on the link to download and install the MICRPrintClient.exe file.

Last modified: Jun 19, 2023

To open the Mekorma Web Client Download and Installation window, go to the
Mekorma Area Page > Setup > System > Web Client Installation*
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6. Configuring the Mekorma Payment Hub
This section of the User Guide offers instruction on how to configure the Mekorma Payment Hub. It will get
you from 0 to live in 3 simple steps. Then you can configure the rest of the system:

Last modified: May 16, 2023
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6.1. Mekorma Quickstart
The goal of our quickstart is to get you a small win as early as possible and then build on it. Clients
purchase Mekorma Payment Hub for check printing and for overall AP automation. With check printing, you
can get from 0 to live in 4 steps, shown here. For the full payment automation, the rest of the Configuration
guide provides a step by step path to add security, signatures, the Action Board, Outsourcing or EFTs and
further refinements. As you add each of these, you will get more out of your investment.

1. Learn how to Navigate to Mekorma Windows.

2. Setup a Checkbook.

3. Setup Dynamics GP Security for Mekorma.

Print Your First Check

To print your first check:

1. Build a batch however you normally do in Dynamics GP

2. Print the Batch. If you are configuring for:
• Payables, Process a Single Payment Batch.
• US Payroll, Print US Payroll Checks.
• Canadian Payroll, Print Canadian Payroll Checks

3. Return to the next section Configuring Security.

This will get you to a live check printed on blank check stock with a MICR line. It will not be signed. Setting
up security and signatures comes next.

Last modified: May 16, 2023

We recommend doing this testing in a test environment, using plain paper or a .pdf printer
rather than check stock, and shredding anything printed. Once familiar, implement on
production.

!

The Mekorma Customer Success team is available if you need assistance.*
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6.2. Navigate to Mekorma Windows
Mekorma has its own Area Page within Dynamics GP, so that all Mekorma related windows can be
accessed from one screen. Traditional Mekorma navigation via Dynamics GP menus remains in effect.

You can configure GP’s Navigation Pane to make the Mekorma Area Page easily accessible. Watch (screen
action only) below:

Once on the Mekorma Area Page, you will find seven different panes that contain all Mekorma-related
windows:

• Transactions
• Cards
• Routines

https://www.youtube.com/embed/_5MN7mP0Ksg?rel=0

Throughout the Mekorma User Guide, navigation paths to Mekorma windows can be found
within these blue information boxes.*
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• Reports
• Setup
• Utilities
• Inquiry

Last modified: May 16, 2023
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6.3. Setup Dynamics GP Security for Mekorma
There are two steps to getting Dynamics GP security to recognize Mekorma windows and give access just
to the users that should have access:

1. Grant Access to Mekorma Alternate Windows

2. Assign Mekorma Security Tasks/Roles

Last modified: May 16, 2023
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6.3.1. Grant Access to Mekorma Windows and
Reports
Mekorma Payment Hub Security Tasks and Roles

As per standard practice for Dynamics GP, your AP team will need to have security access to both the
standard GP windows/reports and the Mekorma windows/reports based on their roles.

Mekorma Payment Hub supports Dynamics GP’s role-based security model by providing pre-configured
security roles that are automatically created when Mekorma Payment Hub is installed. A new user does not
have access to any third-party windows and reports in Dynamics GP unless they are assigned for that
security role. This means that Mekorma Payment Hub is not accessible for a newly created user.

For a non- administrator user to have access to Mekorma Payment Hub windows and reports, a Security
Task containing access to Mekorma Payment Hub windows must be created and eventually assigned to
the user.

To assist users in setting security access to Mekorma Payment Hub windows, 17 roles and 20 security
tasks have been created. Users can select the applicable Mekorma security role (containing the security
tasks) and assign it to the desired user. Each time a user logs into a Dynamics GP company, Mekorma
Payment Hub runs a check for existing Mekorma Payment Hub roles. If any of the six roles are missing,
the program recreates all of the security roles and tasks.

In Dynamics GP, security tasks are assigned to security roles. Mekorma Payment Hub provides security
tasks containing sets of related Mekorma Payment Hub windows and reports. The Mekorma Payment
Hub security tasks are assigned to a Mekorma Payment Hub security role, and then the role is assigned to
a user.

Reviewing the Mekorma Security Tasks

To view the Mekorma Payment Hub windows associated with a specific Mekorma Payment Hub security
task you can print a standard Dynamics GP report:

1. Open the Security Reports window (Administrative Area Page > Reports > System > Security).

2. Choose the Security Task Setup report and click New.

3. The list of Mekorma security tasks start with the letters MEK. To see a complete list of tasks provided
with the system, insert the range from MEK to N in the report.

For information in setting up Dynamics GP security roles and tasks, please refer to
SecurityPlanning.pdf located in the Documentation folder of your Dynamics GP directory.*
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4. Print the report or save it to a file to import into Excel.

Here are the names of the security tasks. On the report you will be able to see what windows and reports
are assigned to each task:

• MEKORMA MEEP ADMIN
• MEKORMA MEEP CLERK
• MEKORMA MEEP VCARD INV
• MEKORMA MICR ADMIN
• MEKORMA MICR BATCH RECOVE
• MEKORMA MICR EZADDS SETP
• MEKORMA MICR PM APPROVAL
• MEKORMA MICR PM BLNK CHK
• MEKORMA MICR PM CHK SETP
• MEKORMA MICR PM REQUEST
• MEKORMA MICR POWER USER
• MEKORMA MICR REGISTRATION
• MEKORMA MICR SETUP
• MEKORMA MICR SIG SETP
• MEKORMA MICR SUPPORT REQS
• MEKORMA MICR TEST CHECK
• MEKORMA MICR UPR BLNK CHK
• MEKORMA MICR UPR CHK SETP
• MEKORMA REGISTRATION
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• MEKORMA TABLE MAINTENANCE
• MEKORMA_BATCH_AUTHORIZER
• MEM CONNECTOR PAYABLES
• MICR VENDOR CLASS SECURIT
• MICR_APPROVER1
• MICR_APPROVER2
• MMM ACTION ADMIN
• MMM ACTION SETUP
• MMM ACTION USER*

You will also see the following Security Tasks—these are used to assign Approval permissions to your users
but not for access to any Dynamics GP or Mekorma Payment Hub windows. For more information about
this, see Assign Mekorma Security Roles and Tasks:

• MEKORMA_APROVER_LEVEL_1
• MEKORMA_APROVER_LEVEL_2
• MEKORMA_APROVER_LEVEL_3
• MEKORMA_APROVER_LEVEL_4
• MEKORMA_APROVER_LEVEL_5
• MEKORMA_BATCH_AUTHORIZER

Reviewing the Mekorma Security Roles

To review Mekorma Payment Hub roles, use the same Dynamics window. Simply change the report to
Security Role Setup and choose similar report options.
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Here are the names of the security roles. On the report you will be able to see what tasks are assigned to
each role:

• MEKORMA MEEP ADMIN
• MEKORMA MEEP CLERK
• MEKORMA MEEP POWER
• MEKORMA MEEP VCARD INV
• MEKORMA MICR ADMIN
• MEKORMA MICR PM APPROVER
• MEKORMA MICR PM CLERK
• MEKORMA MICR PM MNGR
• MEKORMA MICR PM REQUESTER
• MEKORMA MICR POWER USER
• MEKORMA MICR UPR CLERK
• MEKORMA MICR UPR MNGR
• MEKORMA PRODUCTS
• MEM CONNECTOR PAYABLES
• MMM ACTION ADMIN
• MMM ACTION SETUP
• MMM ACTION USER
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Last modified: May 16, 2023

Mekorma has developed Security tasks and roles using our best judgement but it is
important for you to reflect on whether these choices meet your companies policies. Our
Customer Success Team is available to do a policy audit with you and ensure that you use
the correct role settings.

!
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6.3.2. Grant Access to Mekorma Alternate
Windows
Mekorma Payment Hub uses alternate Microsoft Dynamics GP windows for processing payables transaction
and batch payments. Security must be granted to these alternate windows for each user printing checks.

Setup an Alternate/Modified Forms and Reports ID

The first step to grant security to alternate windows is to set up an Alternate/Modified Forms and Reports
ID that gives access to the Mekorma Windows. If you already have other Alternate/Modified Forms and
Reports, you will want to add this to the existing ID that applies to your AP team. If you also use Mekorma
Payment Hub for US or Canadian Payroll you can add payroll access to the same Alternate/Modified
Forms and Reports ID:

1. Log in to Microsoft Dynamics GP as a system administrator.

2. Open the Alternate/Modified Forms and Reports window (Administration Area Page > Setup >
System > Alternate/Modified Forms and Reports).

3. Select an Alternate/Modified Forms and Reports ID (or create a new one) and enter the following
values in the fields:

• Product: Mekorma MICR
• Type: Windows
• Series: All

Note that Mekorma MICR was the original product name for the Mekorma Payment Hub and was
retained to avoid disruption to existing users.

4. In the Alternate /Modified Forms and Reports List, open the folders (by clicking the + sign) and
verify that Mekorma MICR is selected.
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Assign Alternate/Modified Forms and Reports ID to Users

The second step is to assign the Alternate/Modified Forms and Reports ID to each of your Payables and
Payroll Users

Dynamics GP Role and Task security will still be used to allow or prevent user access to
each window. The Alternate/Modified Forms and Reports ID in effect tells Dynamics GP:
for users that are allowed to use any particular window, use the Mekorma version instead of
the GP version. Since Dynamics GP allows you to assign a single Alternate/Modified
Forms and Reports ID the simplest setup is to create one Alternate/Modified Forms and
Reports ID for everyone and use individual Role and Task assignments to turn the windows
on and off.

*
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1. Open the User Security Setup window (Administration Area Page > Setup > System > User
Security).

2. For each User/Company combination, ensure that you have designated a Alternate/Modified Forms
and Reports ID that includes the Mekorma windows.

Last modified: May 16, 2023
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6.4. Setup a Checkbook
The fundamental steps of your Checkbook setup are to:

1. Configure the MICR line. This is the primary thing needed in order to switch from pre-printed check
stock to blank check stock.

2. Choose a Check Format

The following two steps are OPTIONAL:

3. Use the Mekorma Payment Hub Configurator to customize your check format.

4. Add a Logo to your checkface.

Last modified: May 16, 2023

Before setting up your checkbooks for Mekorma Payment Hub check printing, please be
sure you have already created the necessary Checkbook ID(s) within the Dynamics GP
Checkbook Maintenance window. Consult your GP documentation if you need assistance
with this. Also the Mekorma Customer Success team is available if you need assistance.

*
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6.4.1. Configure the MICR Line
The MICR line is the coded banking information at the bottom of your check which is printed in the E13B
MICR font. By printing the MICR line, the Mekorma Payment Hub can provide the capability of printing on
blank, rather than pre-printed, checkstock.

The video below gives detailed instructions on how to configure the MICR line.

Note that this MICR line setup is based on the Checkbook, so it is set up the same way whether you are
using Mekorma Payment Hub for your AP, US Payroll and Canadian Payroll checkbooks:

1. Open the Checkbook Setup window. You can do this in 2 ways:
a. from the Dynamics GP Checkbook Maintenance Additional menu (Financial Area Page > Cards

> Financial > Checkbook). Enter a Checkbook ID by using the lookup, then: (Additional >
Mekorma Check Setup).

b. from the Mekorma Area Page (Mekorma Area Page > Setup > Purchasing > Checkbook Setup).
Enter a Checkbook ID by using the lookup.

2. Open the MICR Line Quick Entry window by clicking on any of the hyperlinks within the MICR Line

https://www.youtube.com/embed/nB7S2_rLoQQ?rel=0

Mekorma Mekorma Products User Guide for GP - Build x91_en

Copyright © 2022 Mekorma Enterprises. All Rights Reserved. Page 59 of 379

https://www.youtube.com/embed/nB7S2_rLoQQ?rel=0


Setup field.

3. Add any information that has not been automatically pulled in from the GP Checkbook Maintenance
window:

a. Number of Check Digits
b. Right-most position of Check Digits*
c. Routing Number
d. Region Code*
e. Account Number
f. Right-most position of the Account Number*

4. Click OK.

5. The Transit (ABA) Number will automatically be calculated and entered for you upon entry of the
correct routing number/ region code.

6. If you need to make edits to the information, you can either open the MICR Line Quick Entry window
and make changes there, or edit directly on the graphical interface by clicking on a value and scrolling
through the options.

Please ask your bank for this information *

Last modified: May 16, 2023

Mekorma Mekorma Products User Guide for GP - Build x91_en

Copyright © 2022 Mekorma Enterprises. All Rights Reserved. Page 60 of 379



6.4.2. Choose Check Formats from the Check
Format Library
The Mekorma Checkbook Setup window allows you to select pre-configured check formats for the
Purchasing, US Payroll and Canadian Payroll modules.

Formats for Dynamics GP Payables and Dynamics GP Financial > Miscellaneous
Checks

You must select a Primary Check Format and may select up to 6 additional formats for the different
purposes used by Dynamics GP. The selected formats do not have to be unique; the same format can be
used for multiple purposes:

• The Primary Check Format is the main check that is sent to your vendors. This is the only format you
are required to designate.

• The Check Copy Format allows you to print a physical copy of the primary check, and can be
different than the format you send to your vendors.

https://www.youtube.com/embed/3_mYpPlZl0s?rel=0
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• The Check Overflow format and Check Copy Overflow format are used when you want to have a
different format for overflows. For example, you may use 3 part checkstock for your primary format
and print just a short list of invoices on the remittance stub but then overflow to a whole page of blank
paper to maximize the list of invoices on the overflow sheet.

• The EFT Remittance Options defaults to Check Face/Overflow Stub. If you leave this default, then
Mekorma will use the exact same formats for EFTs as it does for your checks. However, since EFTs
don’t require the check portion of the format, we recommend full page formats for EFT remittances.

• The Refund Check and Refund Check Overflow formats are used if you will be using the Refund
Checks feature for printing Microsoft Dynamics GP SOP refunds as checks. This feature allows you to
convey the line items that are being refunded to your customers.

Formats for Dynamics GP US Payroll

There are two formats available for the US Payroll module:

1. The Primary Check Format is the main check that is sent to your employees. This is the only format
you are required to designate.

2. The Check Copy Format allows you to print a physical copy of the primary check, and can be
different than the format you send to your employees.

Formats for Dynamics GP Canadian Payroll

There are four formats available for the Canadian Payroll module:

1. The Primary Check Format is the main check that is sent to your employees. This is the only format
you are required to designate.

2. The Check Copy Format allows you to print a physical copy of the primary check, and can be
different than the format you send to your employees.

3. The Earnings Statement allows you to designate a different format for the earnings statement you
send to your employees.

4. The Earnings Statement Copy allows you to print a physical copy of the earnings statement, and
can be different than the format you send to your employees.

Choose Formats:

Note that you will not be able to convey these special refund formats if you are using
Remote Payment Services. In that case you can either print the refund checks locally or
convey that information in a different manner. In this situation, please contact our Customer
Success team for advice.

*

To access the Mekorma Checkbook Setup window, go to the Mekorma Area Page > Setup
> Purchasing > Checkbook Setup*
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1. Open the Checkbook Setup window.
2. Select the checkbook and the module (Purchasing, US Payroll, Canadian Payroll) that you want to

configure.

3. Click on the lookup to the right of Primary Check Format, and choose an appropriate option from
Mekorma’s library of pre-configured formats (in the Check Format Library). The name of each format
file indicates key information included on that format.

4. If you want to customize your chosen format, open the Mekorma Configurator by clicking on the
Primary Check Format link. You can then edit within the Configurator. This process can be repeated
for any additional format selections.

Last modified: May 16, 2023

Within the same company, you cannot print some checks using Mekorma and others using
Microsoft Dynamics GP, unless you have a second Microsoft Dynamics GP user configured
through the Alternate Security to print checks. It is important to note that any change to your
operating system, server, or printer could cause printing variations. Always retest the
formatting of your checks and the MICR line if you have altered your system configuration
or peripherals in any way.

!
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6.4.3. Customize Check Formats Using the
Configurator
The Mekorma Payment Hub Configurator is a report editing tool that allows you to modify Mekorma-
generated checks and stubs. The Configurator handles any size paper and any system font.

Use the Configurator in conjunction with the pre-prepared stub files provided in the Mekorma Check Format
Library to create check stub formats designed specifically for your company’s check printing needs. The
Configurator is a feature-rich, easy-to-use editing tool with drag-and-drop functionality, multiple windows,
menus, and toolbars.

• To add fields, labels, lines and images/ logos, use the Add Elements button. The element will be
added to the upper left corner of the format. It can then be moved to the check or stub of your choice.

https://www.youtube.com/embed/38kZKM29A0o?rel=0

To open the Mekorma Configurator, click on any of the check format links from within the
Mekorma Checkbook Setup window.*
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• For quicker alignment of fields, use the Alignment tools on the Layout tab at the top of the
Configurator window.

• Use the Zoom In and Zoom Out buttons to see more of the page or get a closer look at a field.
• Select entire regions to move or delete the region and all fields. A region will appear as blue when

selected. To de-select a region, click on white space or any unselected element.
• Use the mouse to select fields to move, re-size or delete. You can use the control key to select

multiple fields.
• For finer manipulation, to change font, for alignment and other adjustments, select a field and use the

Properties box in the lower left of the Configurator window.
• You can select and copy entire regions to make duplicate remittance stubs.
• For any Amount field on a check stub, you can choose to hide it when there is no value populating

the field. Click on the field itself, and use the Properties pan to check the box next to Hide When
Empty.

Last modified: May 16, 2023

Follow this link for a complete list of all check stub fields available in the Configurator.*
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6.4.3.1. Mekorma Fields for Check Stubs
All available check stub fields within the Mekorma Configurator are listed below by section. Any of these
fields can be added by clicking on the Add Elements button once the Mekorma Configurator has been
opened:

These fields are available for Payables, US Payroll and Canadian Payroll check
stubs:

General Information

• Approver 1
• Approver 2
• Bank Account Number
• Bank Address
• Bank Branch
• Bank Fax Number
• Bank ID
• Bank Master Transit Number
• Bank Name
• Bank Phone 1
• Bank Phone 2
• Bank Phone 3
• Check Comment 1
• Check Comment 2
• Check Comment 3
• Checkbook Description
• Checkbook ID
• CM User Defined 1
• CM User Defined 2
• Company Address
• Company Contact
• Company Fax Number
• Company Location Name
• Company Name
• Company Phone 1
• Company Phone 2
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• Company Phone 3
• GL Posting Date
• Printed By
• Requester
• Transit Number
• User ID

Commonly Used Labels

• AMOUNT
• Amount
• Canadian Funds
• Check Date
• CHECK NO
• Cheque Date
• CHEQUE NO
• Date
• DATE
• DDMMYYYY
• Description
• Description Reference
• Discount Taken
• Dollars
• GL Account Number
• Invoice Date
• Invoice Number
• MMDDYYYY
• Net Check Amt
• Net Cheque Amt
• Net Paid Amount
• Net Paid Amt
• ORDER OF
• Outstanding Amt
• Paid Amount
• Pay
• PAY
• Pay to the Order of
• Payee
• Payment Number
• PO Number
• TO THE
• to the Order of
• US Funds
• Voucher Amount
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• Voucher Number
• Write Off
• YYYYMMDD

Logical Fields

• EFT Comment
• EFT Logo
• EFT Non-Negotiable
• EFT VOID
• Facility Signature 1
• Facility Signature 2
• Line 1
• Line 2
• Continued
• Signature File 1
• Signature File 2
• Signature File 1 Based on PO Number
• Signature File 2 Based on PO Number
• Signature Line 1 Based on PO Number
• Signature Line 2 Based on PO Number

Payables

Detailed Addresses for Payables

• Bank Address 1
• Bank Address 2
• Bank Address 3
• Bank City-State-Zip
• Bank Country
• Company Address 1
• Company Address 2
• Company Address 3
• Company City-State-Zip
• Company Country
• Payment Address 1
• Payment Address 2
• Payment Address 3
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• Payment Address ID
• Payment City-State-Zip
• Payment Contact
• Payment Country
• Payment Zip
• Vendor Main Address 1
• Vendor Main Address 2
• Vendor Main Address 3
• Vendor Main City-State-Zip
• Vendor Main Country

GL Distribution

• 1099 Amount
• Account Alias
• Account Description
• Account Number
• Account User Defined 1
• Account User Defined 2
• Credit Amount
• Debit Amount
• Distribution Reference
• Document Type
• Enhanced Net Check Amount
• Freight Amount
• Intercompany ID
• Misc Charges Amount
• Multi-Currency Debit Minus Credit Amount
• New Amount Paid (Tech Knowledge 18381)
• New Document Amount (Tech Knowledge 18381)
• Originating Credit Amount
• Originating Debit Amount
• Payment Terms ID
• Posting Date
• Purchase Order Number
• Purchases Amount
• Shipping Method
• Tax Amount
• Tax Schedule ID
• Trade Discount Amount
• TRX Source
• Voucher Amount Paid
• Voucher Credit Amount
• Voucher Credit Document Amount
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• Voucher Discount Date
• Voucher Discount Taken Amount
• Voucher Discount Taken Total
• Voucher Document Amount
• Voucher Document Date
• Voucher Document Number
• Voucher GST Discount Amount
• Voucher Net Check Amount
• Voucher Net Paid Amount
• Voucher Outstanding Amount
• Voucher Paid Total
• Voucher PPS Amount Deducted
• Voucher Total Document Amount
• Voucher Transaction Description
• Voucher Voucher Number
• Voucher Write Off Amount
• Voucher Write Off Total

MEM Centralized (only available with MEM Connector, sold separately)

• Facility ID
• Facility Name
• Facility Company Name
• Document Number
• Transaction Description
• Discount Taken Amount
• Purchase Order Number
• Net Paid Amount
• New Amount Paid (Tech Knowledge 18381)
• Document Date
• Voucher Number
• Voucher Date
• Document Amount
• Internet User Defined 1
• Internet User Defined 2

MEM Decentralized (only available with MEM Connector, sold separately)

• Facility ID
• Facility Name
• Facility Company Name

Mekorma Mekorma Products User Guide for GP - Build x91_en

Copyright © 2022 Mekorma Enterprises. All Rights Reserved. Page 70 of 379



• Facility Address
• Internet User Defined 1
• Internet User Defined 2

Payment

• Amount in Words
• Amount in Words with Word Wrapping
• Amount in Words (Techknowledge 857824)
• Amount in Words (Techknowledge 857824) with Word Wrapping
• Check Comment
• Check Amount with ***
• Check Number
• Check Total
• Document Date
• Document Date-D1
• Document Date-D2
• Document Date-M1
• Document Date-M2
• Document Date-Y1
• Document Date-Y2
• Document Date-Y3
• Document Date-Y4
• EFT or Regular Check Total
• Payment Comment (from Edit Payables Checks)
• Payment Number

POP Single Line Per Invoice

• 1099 Amount
• Amount Paid
• Credit Amount
• Credit Document Amount
• Discount Date
• Discount Taken Amount
• Discount Taken Total
• Document Amount
• Document Date
• Document Number
• Document Type
• Due Date
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• Enhanced Net Check Amount
• Freight Amount
• GST Discount Amount
• Misc Charges Amount
• Net Check Amount
• Net Paid Amount
• New Amount Paid (Tech Knowledge 18381)
• New Document Amount (Tech Knowledge 18381)
• Outstanding Amount
• Paid Total
• Payment Terms ID
• POP Extended Cost
• POP Item Description
• POP Item Description or Voucher Description
• POP Item Number
• POP or Voucher PO Number
• POP QTY Invoiced
• POP Receipt Date or Voucher Date
• POP Receipt Number or Voucher Number
• POP Reference or Voucher Description
• POP Unit Cost
• POP Unit of Measure
• POP Vendor Document Number
• Posting Date
• PPS Amount Deducted
• Project Contract Name
• Project Contract Customer
• Project Contract Number
• Project Contract ID
• Project Cost
• Project Customer Number
• Project Number
• Project Purchase Order Number
• Project User Defined1 Contract
• Project User Defined2 Contract
• Purchase Order Number
• Purchases Amount
• Shipping Method
• Tax Amount
• Tax Schedule ID
• Total Document Amount
• Trade Discount Amount
• Transaction Description
• TRX Source
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• UD Date01
• UD Date02
• UD Date03
• UD Date04
• UD Date05
• UD Date06
• UD Date07
• UD Date08
• UD Date09
• UD Date10
• UD Date11
• UD Date12
• UD Date13
• UD Date14
• UD Date15
• UD Date16
• UD Date17
• UD Date18
• UD Date19
• UD Date20
• UD List01
• UD List02
• UD List03
• UD List04
• UD List05
• UD Text01
• UD Text02
• UD Text03
• UD Text04
• UD Text05
• UD Text06
• UD Text07
• UD Text08
• UD Text09
• UD Text10
• Voucher Number
• Write Off Amount
• Write Off Total

POP Multiple Lines Per Invoice

• 1099 Amount
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• Amount Paid
• Credit Amount
• Credit Document Amount
• Discount Date
• Discount Taken Amount
• Discount Taken Total
• Document Amount
• Document Date
• Document Number
• Document Type
• Due Date
• Enhanced Net Check Amount
• Freight Amount
• GST Discount Amount
• Misc Charges Amount
• Net Check Amount
• Net Paid Amount
• New Amount Paid (Tech Knowledge 18381)
• New Document Amount (Tech Knowledge 18381)
• Outstanding Amount
• Paid Total
• Payment Terms ID
• POP Extended Cost
• POP Item Description
• POP Item Description or Voucher Description
• POP Item Number
• POP or Voucher PO Number
• POP QTY Invoiced
• POP Receipt Date or Voucher Date
• POP Receipt Number or Voucher Number
• POP Reference or Voucher Description
• POP Unit Cost
• POP Unit of Measure
• POP Vendor Document Number
• Posting Date
• PPS Amount Deducted
• Project Contract Name
• Project Contract Customer
• Project Contract Number
• Project Contract ID
• Project Cost
• Project Customer Number
• Project Number
• Project Purchase Order Number
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• Project User Defined1 Contract
• Project User Defined2 Contract
• Purchase Order Number
• Purchases Amount
• Shipping Method
• Tax Amount
• Tax Schedule ID
• Total Document Amount
• Trade Discount Amount
• Transaction Description
• TRX Source
• UD Date01
• UD Date02
• UD Date03
• UD Date04
• UD Date05
• UD Date06
• UD Date07
• UD Date08
• UD Date09
• UD Date10
• UD Date11
• UD Date12
• UD Date13
• UD Date14
• UD Date15
• UD Date16
• UD Date17
• UD Date18
• UD Date19
• UD Date20
• UD List01
• UD List02
• UD List03
• UD List04
• UD List05
• UD Text01
• UD Text02
• UD Text03
• UD Text04
• UD Text05
• UD Text06
• UD Text07
• UD Text08

Mekorma Mekorma Products User Guide for GP - Build x91_en

Copyright © 2022 Mekorma Enterprises. All Rights Reserved. Page 75 of 379



• UD Text09
• UD Text10
• Voucher Number
• Write Off Amount
• Write Off Total

UK Cheques

• UK Cheque Amount
• UK Vendor Name Only
• UK Vendor Name*
• UK Vendor Name
• UK Document Date
• UK Amount in Words with Word Wrapping

Vendor

• 1099 Amount YTD
• 1099 Type
• Account Number With Vendor
• Account Type
• Bank Account Number
• Bank Name
• Bank Transit Number
• Contact Name
• Fax Number
• Governmental Corporate ID
• Governmental Individual ID
• Parent Vendor ID
• Payment Address
• Payment Address with Country
• Payment Priority
• Payment Terms ID
• Phone 3
• Phone Number 1
• Phone Number 2
• Shipping Method
• Tax ID Number
• Tax Registration Number
• Vendor Address with Contact Name
• Vendor Check Name
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• Vendor Check Name – SAFE PAY
• Vendor Class ID
• Vendor Comment 1
• Vendor Comment 2
• Vendor Contact
• Vendor ID
• Vendor Main Address
• Vendor Name
• Vendor Name – SAFE PAY
• Vendor Note
• Vendor Short Name
• Vendor User Defined 1
• Vendor User Defined 2

Voucher

• 1099 Amount
• Amount Paid
• Credit Amount
• Credit Document Amount
• Discount Date
• Discount Taken Amount
• Discount Taken Total
• Document Amount
• Document Date
• Document Number
• Document Type
• Due Date
• Enhanced Net Check Amount
• Freight Amount
• GST Discount Amount
• Misc Charges Amount
• Net Check Amount
• Net Paid Amount
• New Amount Paid (Tech Knowledge 18381)
• New Document Amount (Tech Knowledge 18381)
• Outstanding Amount
• Paid Total
• Payment Terms ID
• Posting Date
• PPS Amount Deducted
• Purchase Order Number
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• Purchases Amount
• Shipping Method
• Tax Amount
• Tax Schedule ID
• Total Document Amount
• Trade Discount Amount
• Transaction Description
• Transaction Long Description
• TRX Source
• Voucher Number
• Write Off Amount
• Write Off Total

Refund Single Document

• Document Amount
• Document Date
• Document Description
• Document Number
• Document Type
• Customer Name
• Customer Number
• Customer PO Number
• Extended Price
• Freight Amount
• Item Description
• Item Number
• Markdown Amount
• Misc Amount
• Quantity
• Salesperson ID
• Sales Territory
• Shipping Method
• Tax Amount
• Trade Discount Amount
• U Of M
• Unit Price

Refund Multiple Documents

• Document Amount
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• Document Date
• Document Description
• Document Number
• Document Type
• Customer Name
• Customer Number
• Customer PO Number
• Misc Amount
• Salesperson ID
• Sales Territory
• Shipping Method
• Tax Amount
• Trade Discount Amount

US Payroll

Benefits

• Benefit Amount Array
• Benefit Amount YTD Array
• Benefit Code Array
• Benefit Description
• Total Benefits

Check

• Amount in Words
• Amount in Words with Word Wrapping
• Check Amount with ***
• Check Date
• Check Date-D1
• Check Date-D2
• Check Date-M1
• Check Date-M2
• Check Date-Y1
• Check Date-Y2
• Check Date-Y3
• Check Date-Y4
• Check Number
• Facility Name
• Facility Stub String
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• Facility Check String
• Facility ID
• Facility Company Name
• Facility Address
• Internet User Defined 1
• Internet User Defined 2
• Net Wages Pay Run
• Check Direct Deposit Amount

Deductions

• Deduction Amount Array
• Deduction Amount YTD Array
• Deduction Code Array
• Deduction Description
• Total Deductions

Detailed Addresses

• Bank Address 1
• Bank Address 2
• Bank Address 3
• Bank City-State-Zip
• Bank Country
• Company Address 1
• Company Address 2
• Company Address 3
• Company City-State-Zip
• Company Country
• Employee Address 1
• Employee Address 2
• Employee Address 3
• Employee City-State-Zip
• Employee Country
• Employee Country Code
• Employee County
• Employee Fax
• Employee Foreign Postal Code
• Employee Foreign State Province
• Employee Phone 1
• Employee Phone 2
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• Employee Phone 3
• Employee Zip
• First Name
• Last Name
• Middle Name

Direct Deposit

• DD Array12 Account Number
• DD Array12 Amount
• DD Array12 Transaction Code
• DD Array12 Transit Number
• DD Number of Accounts
• Net Wages Pay Run (Stub Only)

Earnings

• Business Expense Earnings
• Charged Tips Earnings
• Commission Earnings
• Double Time Earnings
• EIC Earnings
• Holiday Earnings
• Min Wage Bal Earnings
• Overtime Earnings
• Pension Earnings
• Piecework Earnings
• Piecework Units
• Regular Earnings
• Reported Tips Earnings
• Sick Time Earnings
• Special Earnings
• Total Earnings
• Vacation Earnings

Employee

• Alternate Name
• Class Description

Mekorma Mekorma Products User Guide for GP - Build x91_en

Copyright © 2022 Mekorma Enterprises. All Rights Reserved. Page 81 of 379



• Department
• Department Additional Description
• Department Description
• Division Address 1
• Division Address 2
• Division City-State-Zip
• Division Code
• Division Name
• Employee Address
• Employee Class
• Employee Full Name – SAFE PAY
• Employee ID
• Employee Name
• Employee Name with Suffix
• Employee Note
• Employee Suffix
• Employee User Defined 1
• Employee User Defined 2
• Federal Classification Code
• First Name
• Job Title
• Job Title Description
• Last Name
• Location ID
• Middle Name
• NickName
• Rate Class
• Social Security Number
• Social Security Number-MASKED
• Supervisor Code
• Type of Employment
• Union Code

Federal Taxes

• Federal Additional Withholding
• Federal Filing Status
• Federal Withholding Exemptions
• Federal Withholding YTD
• Federal Withholding Pay Run
• FICA Withholding YTD
• FICA Medicare Withholding YTD
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• FICA Medicare Withholding Pay Run
• FICA Social Security Withholding YTD
• FICA Social Security Withholding Pay Run
• Total FICA Tax Withheld
• Uncollected FICA Med Tax Pay Run
• Uncollected FICA SS Tax Pay Run
• Employer ID Number

Hours

• Days Worked YTD
• Double Time Hours
• Holiday Hours
• Hours Worked YTD
• Overtime Hours
• Regular Hours
• Sick Time Available
• Sick Time Hours
• Time Available Array
• Time Code Array
• Time Code Description Array
• Total Hours
• Vacation Available
• Vacation Hours
• Weeks Worked YTD
• Work Hours Per Year

Local Taxes

• Local Tax Array
• Local Tax Description
• Local Tax Withholding Array
• Local Tax YTD
• Local Withholding YTD

Pay Data

• Pay Code Array
• Pay Code Description
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• Pay Earnings Array
• Pay Hours Array
• Pay Hours Array-Blank for Salary
• Pay Rate Array
• Pay Rate Array-Blank for Salary
• Pay Type Array
• Pay YTD Array
• Total YTD Pay Code Earnings

Pay Stub Information

• End Pay Period
• Federal Wages Pay Run
• Gross Wages YTD
• Gross Wages Pay Run
• Net Wages YTD
• Payment Adjustment Number
• Start Pay Period
• Total Taxes
• Total Taxes YTD
• User ID

State Taxes

• Additional Allowances
• State Additional Withholding
• State Filing Status
• State Name
• State Number of Dependents
• State Tax Array
• State Tax Withholding Array
• State Tax YTD
• State Withholding YTD

Tips

• Allocated Tips YTD
• Charged Receipts YTD
• Charged Tips YTD

Mekorma Mekorma Products User Guide for GP - Build x91_en

Copyright © 2022 Mekorma Enterprises. All Rights Reserved. Page 84 of 379



• Federal Tax On Tips YTD
• Federal Tips YTD
• FICA Med Tax On Tips YTD
• FICA Med Tips YTD
• FICA SS Tax On Tips YTD
• FICA SS Tips YTD
• Reported Receipts YTD
• Reported Tips YTD
• Uncollected FICA Med Tax YTD
• Uncollected FICA SS Tax YTD

Canadian Payroll

Detailed Addresses

• Bank Address 1
• Bank Address 2
• Bank Address 3
• Bank City-State-Zip
• Bank Country
• City
• Company Address 1
• Company Address 2
• Company Address 3
• Company City-State-Zip
• Company Country
• Country
• Employee Address 1
• Employee Address 2
• Employee City-Province-Postal Code
• First Name
• Last Name
• Middle Name
• Phone
• Postal Code
• Province

Detailed Advice

• Income Pay Code
• Income Description
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• Income Rate
• Income Units
• Income Current $
• Income YTD Units
• Income YTD Dollars

Employee

• Address
• Birth Date
• City
• Class ID
• Country
• Department
• Employee ID
• First Name
• Full Name
• Last Name
• Middle Name
• Phone
• Position
• Postal Code
• Province
• SIN
• Start Date
• Taxable Province
• User Defined 1
• User Defined 2
• User ID

Payment Details

• Deduction Description
• Deduction Employee Share
• Deduction Employer Share
• Deduction Paycode
• Deduction Rate
• Deduction Taxable Benefit Amount
• Deduction Units
• Earnings Amount
• Earnings Dept
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• Earnings Description
• Earnings Paycode
• Earnings Rate
• Earnings Transaction Date
• Earnings Units

Summary Advice

• Income Pay Code
• Income Description
• Income Rate
• Income Units
• Income Current $
• Income YTD Units
• Income YTD Dollars
• Benefit Pay Code
• Benefit Description
• Benefit Rate
• Benefit Units
• Benefit Current $
• Benefit YTD Units
• Benefit YTD Dollars
• Deduction Pay Code
• Deduction Description
• Deduction Rate
• Deduction Units
• Deduction Current $
• Deduction YTD Units
• Deduction YTD Dollars

Payment Summary

• Accumulated Days
• Accumulated Overtime Hours
• Accumulated Regular Hours
• Accumulated User1
• Accumulated User2
• Accumulated User3
• Accumulated User4
• Advance Amount Drawn
• Advance Amount Reclaim
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• Arrears Amount Created
• Arrears Amount Reclaim
• Batch Number
• Bonus Income
• Cheque Amount with ***
• Cheque Date
• Cheque Date-D1
• Cheque Date-D2
• Cheque Date-M1
• Cheque Date-M2
• Cheque Date-Y1
• Cheque Date-Y2
• Cheque Date-Y3
• Cheque Date-Y4
• Cheque Number
• End Date
• Net Pay
• Net Pay Words
• Net Pay Words Numbers
• Overtime Income
• Payment Method
• Regular Income
• Retroactive Income
• Start Date
• Total Withholdings

Vacation

• Accrual Amount
• Accrual Units
• Accrual Unpaid Units
• Accruing Amount
• Accruing Available After Date
• Accruing Units
• Accruing Unpaid Units
• Available Amount
• Available Payout After Date
• Available Units
• Available Unpaid Units
• Opening Balance
• YTD Accrued Vacation
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YTD Tax Return

• Basic Personal Amount – AB
• Basic Personal Amount – BC
• Basic Personal Amount – Federal
• Basic Personal Amount – MB
• Basic Personal Amount – NB
• Basic Personal Amount – NL
• Basic Personal Amount – NS
• Basic Personal Amount – NT
• Basic Personal Amount – NU
• Basic Personal Amount – ON
• Basic Personal Amount – PE
• Basic Personal Amount – SK
• Basic Personal Amount – YT
• CPP Deducted 16
• CPP Pensionable 26
• EI Deducted 18
• EI Insurable 24
• Employment Income 14
• Income Tax Deducted 22
• Quebec TP-1015.3-V Base
• Registered Pension 20
• Taxable Benefits
• Taxable Income

Last modified: May 16, 2023
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6.4.3.2. Adding Elements to Check Formats
Our existing check formats can be customized by adding elements using the Mekorma Configurator. Fields
can be added to any of our check formats, and can be easily placed or re-located with the Configurator’s
drag-and-drop interface.

1. Open the the Checkbook Setup window and use the look-up to select a Checkbook ID.

2. Select the module for which you want to configure a check stub: Purchasing, US Payroll or
Canadian Payroll

3. Be sure a primary check format is selected, then click on the Primary Check Format hyperlink. This
will open the Configurator to display the selected format.

4. Click the button Add Elements to open the Add Elements window. The available elements will differ
depending on which module you are working with.

5. Expand any of the the listed categories by clicking on the + sign. This will display available fields
within each category.

To access the Mekorma Checkbook Setup window, go to the Mekorma Area Page > Setup
> Purchasing > Checkbook Setup*

Mekorma Mekorma Products User Guide for GP - Build x91_en

Copyright © 2022 Mekorma Enterprises. All Rights Reserved. Page 90 of 379



6. Choose the desired field to add to your check stub.

7. Click Add Elements.

8. The field will automatically be placed at the top-left of the format. You can change the field’s location
as desired by dragging and dropping it, or by adjusting its location according to its place on the X and
Y axis.

Last modified: May 16, 2023
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6.4.3.3. Configure Refund Check Formats
This feature allows you to convey the line items that are being refunded to your customers. Watch this video
to find out more:

Last modified: May 16, 2023
https://www.youtube.com/embed/R5z2TnUCeQQ?rel=0
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6.4.4. Add a Logo to a Checkbook
A company logo can be associated with individual checkbooks, and used within multiple companies. This
feature is useful if you use one check format in many companies and checkbooks, but you’d like a different
logo for each checkbook. The logo defined for each checkbook will automatically print on any check paid
from that checkbook, as long as the company logo field is included on the check stub.

This feature works for payables and US/ Canadian payroll.

1. Open the Checkbook Setup window (Mekorma Area Page > Setup > Purchasing > Checkbook
Setup).

2. Choose a Checkbook ID by using the look-up.

3. Click on the look-up to the right of the Logo field to open the Mekorma Logo Files Lookup window.

4. Select an existing logo, or add a new one by clicking on New to open the Mekorma Logo Library.

5. Click Import, then choose the correct logo file. _Files can be in the following formats: .bmp, .gif, .jpg
and .png

6. If you would like the logo to be available in more than one company, mark the box next to additional
companies in the Available in Company column.

To add a logo, a User must have permission to access the Mekorma Logo Library in
addition to the Checkbook Setup window.

!
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7. Select the Logo File you just imported in the Company Logo field, and Save.

8. Please note: In order for the logo to print on the check stub, you need to take the additional step of
adding an element to your checkstub in the Mekorma Configurator. Select Logical Fields > Company
Logo to add the field to the desired check layout, and drag the field to the appropriate location.

Last modified: May 16, 2023
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6.4.5. Test Check Layout
Printing test checks help you verify the correctness of your check layouts. Print the test checks from the
same workstation and printer you will be using for live checks.

Differences in printers and operating systems can lead to size and placement variations on the printed page.
The Test Check Layout is used for primary check regions, stubs, and overflow stubs. Use the MICR Gauge
to confirm the placement of the MICR line.

1. Open the Test Check Layout and Security window (Mekorma Area Page > Setup > Purchasing >
Test Layout and Security).

2. Select a Check Type from the drop-down list (Payables, US Payroll or Canadian Payroll).

3. Use the look-up on the Checkbook ID field to select a checkbook you have set up for Mekorma
Payment Hub check printing.

4. In the Check Amount field, enter the amount to print in the currency fields on the check or leave it as
a default.

5. In the Number of Vouchers field, enter the number of remittance lines to print on the stub. For
example, if you want to see a stub that is paying five invoices, enter “5”. If you are using an overflow
format, enter a number large enough to force the stub information to overflow to the next page.
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6. Click Print.

7. On the Mekorma MICR Check Printing screen, confirm that the Check Printer is the printer you will
be using for checks. If not, select the check printer from the drop-down list of printers.

8. Click Print to send the check to the printer and review the check layout.

Fields
Field Name Use of Field

Check Type Specifies whether the checks are for payables or for US or Canadian payroll.

Checkbook ID
Use the magnifying glass to select the correct checkbook from which to make the
payments.

Check Amount Enter the value of the check.

Number of
Vouchers

Enter the number of remittance lines to print on the check stub.

Additional Resources
For more information about how to configure and test check printing in Mekorma, see:

Configure the MICR Line
Choose Check Formats from the Check Format Library
Mekorma Fields for Check Stubs
Adding Elements to Check Formats

Please note, MEM Connector fields will not be displayed on a test check. You must print an
actual check in order to test.

!
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Configure Refund Check Formats
Add a Logo to a Checkbook

Last modified: May 16, 2023
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6.5. Configure and Test Your Signatures
Adding automatic signatures to the system is one of the primary ways of increasing efficiency. Note that it is
optional and not all Mekorma Payment Hub users configure automatic signatures. But we encourage it—it
saves lots of hand cramps or rubber stamping!

You may want to have automatic signatures on most of your checks but not all of them. The Threshold ID
lets you control that with dollar-value thresholds so you decide when your checks print signed and when
they require manual signatures.

This section of the guide and the next, Enhance Security with Approvers and Authorizers, go together. We
recommend that you do both to optimize security.

This section is an important pre-requisite to using Threshold IDs to create Approvers and Authorizers.
You’ll learn how to:

1. Assign Signature Files to Users

2. Configure a Threshold ID for Signatures

3. Apply a Threshold ID to a Checkbook

From doing these 3 steps you can be printing automatic signatures on your checks in no time.

Last modified: May 16, 2023
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6.5.1. Assign Signature Files to Users
Before using signatures to set up Threshold IDs, an administrator must first assign signature files to
individual users.

First, gather all needed signatures in a digital format and store them in an accessible folder. Then follow the
steps here to assign them to users.

1. Log in as System Administrator (‘sa’).

2. Navigate to the Signature Assignment window (Mekorma Area Page > Setup > System > Signature
Assignment).

3. Click on the User Name for which you’d like to assign a signature.

4. Use the lookup to find the correct signature file.
• If the file has already been imported into the system, simply choose the file to complete the

assignment.
• To import a new signature file, click New from within the Mekorma Signature Files Lookup

window. This will open the Signature Library, and you can then import the correct signature
file.

• Return to the Signature Assignment window and associate the User Name with the newly
imported signature.

How to Confirm Your Signature

A User can confirm that a signature file has been assigned to their User ID within the Mekorma User
Preferences window.

To access the Mekorma User Preferences window, go to the Microsoft Dynamics GP drop-down > User
Preferences > Additional > Mekorma User Preferences. Verify the correct signature image name is
associated with the User ID.

Signature files cannot be added or removed from this window by the User. Only Administrators can perform
this function in the manner described on this page.

A signature can be setup in the system even for a user that does not normally use
Dynamics GP. For example, if your checks require the CEO’s signature but they are not a
Dynamics GP user. In that case, go directly to Import Signatures to the Signature Library to
import their signature and skip the rest of the steps here.

*

To remove a signature assignment, click on the User Name and select the ‘X’. This will not!
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Last modified: May 16, 2023

remove the signature file from the Signature Library, but does remove the association with
the User Name.
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6.5.1.1. Import Signatures to the Signature
Library
Start by gathering all signatures needed for your security in a digital format. Files can be the following
formats: .bmp, .gif, .jpg and .png.

1. Open the Mekorma Signature Library window (Mekorma Area Page > Setup > System > Signature
Library).

2. Choose Import.

3. Browse to select the signature image file you wish to use on your checks and click Open. .

4. Signature files can then be assigned to one or more companies. In the Available in Company section
of the Signature Library window, simply check the box next to each company that the signature will
be used for:
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6.5.1.2. Mekorma Signature Assignment

Click on the User Name of an Approver to highlight a row. Use the magnifying glass icon to choose a
signature from the library.

Assign Signature Files to Users fully explains the use of this window.

Fields
Field Name Use of Field

User Name Identifies all the users in the system.

Signature File Name Identifies a signature file, if any was assigned to this Approver.

Additional Resources
For more information about how signatures are used in Mekorma as part of the Task-Based Security setup,
see:

Configure and Test Your Signatures
Import Signatures to the Signature Library
Configure a Threshold ID for Signatures
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Apply a Threshold ID to a Checkbook

Last modified: May 16, 2023
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6.5.2. Configure a Threshold ID for Signatures
Configuring Threshold IDs for Signatures gives you the ability to automatically print signatures using dollar-
value ranges and to print blank lines for handwritten signatures.

Configure One or Two Signatures for all Dollar-Value Amounts

1. Make sure all necessary signatures have been assigned to the appropriate User IDs.

2. Open the Threshold Maintenance window (Mekorma Area page > Setup > System > Threshold
Maintenance).

3. Create a new Threshold ID.

4. To override a default signature with an approver signature at the individual threshold level, click on
the icon next to the Signature Line check box.

• Checkmark: The default signature entered in the field will be printed for the payments in a
particular threshold level.

• Two people icon: The approver signature will overwrite the default signature selected and
will be printed for the payment in a particular threshold level.

5. Add a signature, using the look-up in the Default User/Signature 1 field. This opens the Mekorma
Signatures Files Lookup window.

For testing purposes, use a test company to experiment with your Threshold ID until you
build the scenario that you want and then replicate it in your production environment.*
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a. There are two ways to add a signature: Signature assigned to a User ID, or a signature file that
has been imported to the signature library but is not associated with a User ID. You may want to
do this, for example, if your CEO is a check-signer but is not a Dynamics GP user. In that case,
you can Import Signatures directly to the Signature Library and then follow the steps below to
select a signature file from the library that is not associated with a User ID.

Signature Assigned to a User ID
In the User ID view, select a signature assigned to a User ID.

Signature File Only
To change the view to Signature Files, click the dropdown and select Signatures.
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Now you can select a signature file from the signature library that is not associated with a User
ID.

6. If you want two signatures to print, perform the same action in the Default User/Signature 2 field.
This will again open the Mekorma Signatures Files Lookup window.
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Here the Threshold ID is configured to produce a single signature assigned to all dollar values.

7. Assign the Threshold ID to the checkbook to which you would like to apply these signatures.

8. Using Edit Vendor Payment make a test batch with a payment of any dollar amount. Print that
payment.

If everything went according to plan, your check will come out signed. Now we’ll enhance that with
Signature lines and different numbers of signatures based on dollar-value ranges.

Adding Conditional Logic based on Dollar-Value Ranges

You can print the signatures conditionally based on dollar-value ranges. In the example below, one
signature will print for the lowest range, 2 will print in the second range and none will print in the top
range—those go for manual signatures.
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Adding Signature Lines

Finally, signature lines can be added simply by checking a checkbox and are also conditional based on
dollar value ranges and you can have a line with or without a signature. The following configuration prints
one underlined signature in the first range, one underlined signature along with a blank line to be manually
signed in the second range and two blank lines at the top range.

To test this configuration, create a batch and input 3 payments, for example:

1. $500 — will show just Karen’s signature (underlined)
2. $5500 — will show Karen’s signature (underlined) and a blank line
3. $60000 — will show two blank lines

But first, Apply your Threshold ID to a Checkbook.

Last modified: May 16, 2023
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6.5.3. Apply a Threshold ID to a Checkbook
The final step in setting up signatures is to assign the Threshold ID you created to the checkbooks from
which you will be paying.

1. Open the Mekorma Checkbook Setup window (Mekorma Area Page > Setup > Purchasing >
Mekorma Checkbook Setup).

2. Choose the checkbook to which you want to assign a Threshold ID by clicking on the lookup.

3. Threshold IDs can be assigned to the Purchasing, US Payroll, or Canadian Payroll modules using the
Module dropdown menu.

Choose the Threshold ID you want to assign using the lookup next to the Threshold ID field.

4. Save to save the threshold information. The form will clear and a blank form will be displayed.

Last modified: May 16, 2023
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6.6. Setup Approvers for Payables
This section of the Mekorma Payment Hub configuration guide assumes that you already have done the
following:

1. Setup a Checkbook and printed your first check

2. Configured and Tested your Signatures

Now we’ll explain how to add an Approval workflow for separation of duties.

There are two basic roles in the Approval Workflow:

1. The Requestor is the person who creates payment batches but they can’t print them until they are
approved.

2. The Approver reviews the payments and can accept or reject a voucher on a payment, a whole
payment or a whole batch

There are options:

1. You can have some payments go through with no approvers—for example
a. payments below a certain dollar amount
b. payments to a certain vendor class that may need oversite because they repeat, such as RENT

2. You can have a second approver on some payments—for example
a. payments about a certain dollar amount
b. payments to a certain vendor class that needs more oversight, such as EMPLOYEE

Setting up the workflow is easy once you understand how the components fit together. To get started, we
have provided an Approval Workflow Quickstart.

Note that Approvals and Signatures can be configured independently. For example, you could require
approvers on payments and still have them come out unsigned. In practice, the approval system is what
takes the place of manual signatures and OK’s the payments for release—whether they are checks or
whether they are electronic payments. So you would generally want to configure signatures for any dollar-
value levels with approvers. For more information on signatures, review Configure and Test Your
Signatures.

Last modified: May 16, 2023
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6.6.1. Simple Approval Workflow--All
Payments Must be Approved
A Basic Workflow

Let’s start with a basic workflow: ALL Payments Require One Approver. We’ll do it with these 4 steps:

1. Choose one or more Users to be in the Approvers group and assign each of them the Security Role :
MEKORMA_APROVER_LEVEL_1.

2. Configure a Threshold ID using MEKORMA_APROVER_LEVEL_1.

3. Set up email notifications.

4. Test the system

Choose your Approvers and Assign an Approval Security Role to them.

To start, familiarize yourself with the concept of Mekorma Security Roles and Tasks. Then below, we’ll
put that info to work.

In our system we are going to refer to these theoretical people. When you are configuring, please
substitute your actual users:

• RYAN : A Requestor—he creates batches and submits them for approval
• KAREN : An Approver
• DEBBIE : An Approver

In our scenario we will only require one Approver, but we are configuring two potential users who have
that level of authority. Either of them could Approve and once one of them does it, the other does not
need to. We need to designate MEKORMA_APROVER_LEVEL_1 to our Approvers with the following
steps:

1. Open the User Security window (Administration Area Page > Setup > System > User Security)
2. Choose User ID DEBBIE
3. Choose each company that DEBBIE needs to be an Approver
4. Find MEKORMA_APROVER_LEVEL_1 on the list and Check it
5. As you change companies, the system will ask if you want to Save—click Save

Here is an example for just one user and one company showing the MEKORMA_APROVER_LEVEL_1
security level. Set this level for each approver and all of the companies that they need.
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Configure a Threshold ID where all Payments Require a Single Approver

Using the same security level, setup a Threshold ID that expects someone with Security level
MEKORMA_APROVER_LEVEL_1 to approve all payments as follows:
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Assign that Threshold ID to Your Checkbook

Important: now you need to go to Mekorma Checkbook Setup (Mekorma Area Page > Setup > Payables
> Checkbook Setup) and make sure to assign that Threshold ID to the checkbook you want to use.

Setup Notifications for the Approvers and Requestors

The Email/Text Notification topic explains how to setup the notification system. Read through to the
section where the Administrator can setup multiple users and setup RYAN, DEBBIE and KAREN to get
email.

Test the system

To test this:

1. Login as RYAN to create a batch using the Checkbook with the Threshold ID you are testing.
2. Go to the Print Payments (Mekorma Area Page > Transactions > Payables > Print Payments)

and pull up the batch.
3. You should see that instead of being able to process the batch, the system makes you Request

Approval.
4. Click Request Approval.
5. Both DEBBIE and KAREN should get email. Find out if they did.
6. Either DEBBIE or KAREN should log in to Dynamics GP and access the Approval window

(Mekorma Area Page > Left Side Bar > Mekorma Approval)
7. Follow the directions in Review and Approve to approve the batch, or, for testing purposes, just

check the batch and click Approve
8. RYAN should get email. Find out if he did.
9. RYAN should now be able to process the batch.

Last modified: Jun 19, 2023
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6.6.2. Mekorma Security Roles and Tasks
Dynamics GP System Security Roles and Tasks are used to designate groups of Approvers and
Authorizers.

The Difference Between Approvers and Authorizers

The word Approver or Authorizer is used depending on the workflow:

1. Approver is used for individuals with authority to approve payments using the AP workflow. This
workflow includes the ability for a Requestor to select batches and send them for approval. One or
two Approvers can approve from a remote location and send them back. The Approval workflow
includes notifications and out-of-office settings. An optional mobile app, PowerApprovals, is also
available.

2. Authorizer is used for individuals with the authority to approve Payroll batches. With Authorization,
there is no notification workflow. The Authorizers approve by typing in their user ID and password at
the time the payroll batches are printed.

Mekorma Task and Role IDs Work in Pairs

Task IDs and Role IDs are used in two different contexts, but there is a one-to-one correspondence
between them:

1. Role IDs are assigned to users.

2. Task IDs are assigned to dollar-value ranges of a Threshold ID in the Mekorma security system

A User can Approve a particular dollar-value range when their Role ID matches that level’s Task ID
assignment.

Mekorma-Supplied Task and Role IDs Have Generic Names

Mekorma-Supplied Task and Role IDs have generic names as shown here:

Please note, the PowerUser Role is not sufficient to designate a GP User as an Approver or
an Authorizer; PowerUsers must also be assigned a Mekorma Security Role in order to
perform those functions.

!
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You could potentially create your own roles and tasks for the security system. For simplicity, the rest of this
guide will assume that you are using the Mekorma-Supplied Task and Role IDs.

Assign the Roles to Users

To assign the Roles to Users:

1. Open the GP User Security window (GP Administration module > Tools > Setup > System > User
Security).

2. Choose the User, the appropriate company (Fabrikam), and the correct Role ID to ensure that the
user is able to perform the corresponding security task.

3. The associated Task IDs can be used to configure the desired dollar-value level in the Threshold ID
for the Approval (Payables) or Authorization (Payroll) system.
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6.6.3. Email/Text Notifications
Setup for individual users

Users assigned to Approver security roles can configure their own email and text notification requirements
for optimal workflow: You must have email functioning in GP for notifications to work.

1. Log in and open the Mekorma User Preferences window (Microsoft Dynamics GP drop-down > User
Preferences > Additional > Mekorma User Preferences)

• Any GP User can do this to configure their own notification preferences.

2. Enter a valid email address in the E-mail Address field.

3. Enter a valid text number in the Text Number field.
• The number must be in the following format: phonenumber@provider.xxx. Please check with

your mobile provider to verify the correct format for sending texts via email or computer. (ex.
1234567899@vtext.com)

4. Click the Notification Events arrow button to open the Threshold Email Notifications window.
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5. If there are multiple companies, and the same notification is required for all companies, you can click
All Companies and select the type of notification required. Otherwise, click the company to set email
notifications for and select the type of notification required.
A notification event that has a green circle with a white check mark indicates that all options below are
marked. A notification event that has a green check mark in a white circle indicates that at least one,
but not all, options are marked.

6. Select the type of notification required.
• Notify first approver when payment is… – This is the first approval notification when AP sends

requests.
◦ Below approver’s threshold range – If you are an approver, you can choose to receive

email notification for the payments that are below your threshold range.
◦ Within approver’s threshold range – If you are an approver, you can choose to receive

email notification for the payments that are within your own threshold range.
◦ Not approvable – notification only – If you are not an approver, you can choose to be

notified when payment approvals are created.
• Notify second approver when payment is… – The second approval notification after the

payments are approved by the first approver.
◦ Below approver’s threshold range – If you are an approver, you can choose to receive

email notification for the payments that are below your threshold range.
◦ Within approver’s threshold range – If you are an approver, you can choose to receive
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email notification for the payments that are within your own threshold range.
◦ Not approvable – notification only – If you are not an approver, you can choose to be

notified when payment approvals are created.
• Notify when… – A notification when the approve, reject, or cancel action has taken place.

Typically, an AP clerk who sends approval requests will want to get email notifications on all the
events.

◦ Only my requested batch statuses change – If you are a requestor, you can choose to
receive email notifications for only the batches for which you have requested approval. If
you select this option, you also must select one or more options below to receive email
notifications for the indicated batch status changes.

◦ Batch has been canceled
◦ Batch has been fully approved
◦ All payments in a batch have been rejected
◦ A payment pending approval has been rejected
◦ A voucher within a payment pending approval has been rejected

If Multi-Entity Management is installed and enabled, you can select an email notification per entity.
Users can only view the entities to which they have access.
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Administrators: Set up multiple users

System administrators have the power to setup email notifications for any User involved in the approval
process. Approvers can set up their own email/ text notifications in their User Preferences window (see
above), but as an added convenience, an admin user can set it up initially for all Approvers.

1. Log in as System Administrator (‘sa’).

2. Open the Mekorma Security Maintenance window (Mekorma Area Page > Setup > System >
Security Setup).

3. Click on Approval Email Setup.

4. For each GP User ID you would like to assign an email address to, enter the correct email address.
This effectively links a GP User ID to an email address. You must enter a unique email for each User
ID.

Please note, the setup in the Approval Email Setup window does not override any settings
as configured by individual users in the Mekorma User Preferences window.

!
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5. Adminstrators can expand the rows by clicking on the chevron arrows:

This allows them to view (but not configure) any out-of-office delegations the user has configured.
Each GP user will still need to go to their own User Preferences (as described above) to configure
both out-of-office delegates and text notifications. Administrators cannot perform those functions
for other users.
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6. Click the Notification Events field for a specific user to indicate the events for which a notification
should be sent.

7. If there are multiple companies, select the company to set specific notification events for, and then
select the type of notification needed. Refer to step 6 in the Setup for individual users section above
for details about the notification types.
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If Multi-Entity Management is installed and enabled, you can select an email notification per entity.
Users can only view the entities to which they have access.
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8. Click OK to close the window.

Example: Notification Assignment Options

When a user requests approval for a batch, their user ID is attached to that batch. We call this user the
Requestor. The user who approves the batch is called the Approver.

Suppose you have the following users:

• Requestor A
• Requestor B
• Requestor C
• Approver S

The following batch approvals are requested:

• Requestor A requests approval for ‘BATCH-A’
• Requestor B requests approval for ‘BATCH-B’
• Requestor C requests approval for ‘BATCH-C’
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The following Notification Assignment Options are selected:

• All requestors and approvers have ALL of the batch status checkboxes marked.
• Only Requestor A has ‘My batch status ONLY has changed’ marked so he will receive email

notification about only the batches for which he has requested approval.
• Requestors B and C have ‘My batch status ONLY has changed’ unmarked so they will receive

email notifications about all batch status updates.
• Approver S has ‘My batch status ONLY has changed’ unmarked.

When BATCH-A is fully approved, the following users receive the email notification:

• Requestor A
• Requestor B
• Requestor C
• Approver S

When BATCH-B or BATCH-C are fully approved, the following users receive the email notification:

• Requestor B
• Requestor C
• Approver S

Requestor A DOES NOT get the email notification because he did not request approval for the batch
and his user ID is not attached to the batch.

Last modified: Jun 19, 2023
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6.6.4. Intermediate Approval Workflows--
Approvals Based on Dollar Amount
An Intermediate Workflow with One Approval Group and Different Range Rules

In an intermediate workflow scenario, you may have the same three theoretical people that you have in a
Simple Approval Workflow:

• RYAN : A Requestor—he creates batches and submits them for approval
• KAREN : An Approver
• DEBBIE : An Approver

However, in this scenario, they want the workflow to handle some of their payments without approval, and
some of the payments require two approvers. This is how it looks:

In this scenario payments under $1K can be processed without approval. Either KAREN and DEBBIE could
approve payments in the $1K-$5K range by themselves. However, both of them need to approve payments
over $5K.

An Intermediate Workflow with Two Approval Groups and Different Range Rules

Now we’ll introduce different approver levels. Let’s introduce a new user, KEN, with Mekorma Security
Role MEKORMA_APROVER_LEVEL_2. You can review how to do this in Mekorma Security Roles and
Tasks.

As above, the workflow will handle some of their payments without approval, and some of the payments
require two approvers. However, in this case, once DEBBIE approves the group of payments > $5K,
KAREN can no longer approve them. Payments in that range require one approver at
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MEKORMA_APROVER_LEVEL_1 and another at MEKORMA_APROVER_LEVEL_2. So now we need
KEN to step in to approve them.

As you can see, there is a lot of flexibility in designating higher approval groups by using ranges and
up-leveling the Mekorma Approver Role.

Last modified: May 16, 2023

Mekorma Mekorma Products User Guide for GP - Build x91_en

Copyright © 2022 Mekorma Enterprises. All Rights Reserved. Page 128 of 379



6.6.5. Vendor Class Security
The Vendor Class Security feature provides the flexibility to customize Mekorma’s security settings on a per
Vendor Class basis. The rules configured for vendor security override the basic security model that you
have setup.

Before setting up Vendor Class Security, please make sure of the following:

• Vendor Classes are set up in Dynamics GP and assigned to the vendors that should have different
security rules.

• Configure a Threshold ID for each vendor class that needs special rules.
◦ These Threshold IDs would be different than the ones assigned to the underlying checkbook

and will overrule the default rules on that checkbook.

Please see Advanced Approval Workflows for specific examples of how you could use this.

To assign those Threshold IDs to Vendor Classes:

1. Open the Mekorma Vendor Class Security Setup window (Mekorma Area Page > Setup > Company
> Vendor Class Security). Each of your existing vendor classes will be displayed.

2. Click to the right of a vendor class to which you want to apply security rules, in the column marked
Threshold ID.

3. Click the look-up next to Threshold ID to open the Threshold ID look-up window. Choose the
Threshold ID that defines the correct security rules.

4. Click OK to close the window.
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6.6.6. Advanced Approval Workflows--
Approval based on Dollar Amount and Vendor
Class
Advanced Approval Workflows use a combination of Checkbook Threshold ID and Vendor Class Security
Threshold ID to designate powerful rule variations. In some cases, this will save work for the Approvers
when certain payments can be automatically approved. In other cases, this can tighten controls when
certain payments need extra levels of protection.

Here is one specific set of rules that includes both examples:

The basic rule for the company is this:

• payments < $1K are automatically approved
• payments > $1K and < $5K require one approver
• payments > $5K require two approvers

However, let’s say the company wants to make two exceptions:
• For vendors in the EMPLOYEE class (expense reimbursements), they always want to require two

approvers regardless of payment amount and one of them has to be the CFO (i.e. higher level
approver).

• For vendors in the RENT class, they always want the payment to go out automatically without
approval.

For this scenario there are 3 Threshold IDs :
• BASICRULE is configured and then assigned to the checkbook.
• EMPLOYEE is configured and assigned to the EMPLOYEE vendor class.
• RENT is configured and assigned to the RENT vendor class.

In all cases the checks print with one signature.
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BASICRULE

EMPLOYEE
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RENT

Please see Vendor Class Security for information on how to designate these Threshold IDs to their
respective Vendor Classes.

Last modified: May 16, 2023
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6.6.7. Power Approvals: Configure Mobile
Approvals
PowerApprovals is our Microsoft Power Platform-based mobile application for remote payment approval.
PowerApprovals allows any designated company approver within the organization to easily approve
payments from their mobile device, or from any computer using a browser of choice.

Before setting up PowerApprovals, please make sure you have met the system requirements.

Requirements
Before an Approver can make use of PowerApprovals, there are a few setup tasks that must be
accomplished.

Administrators

1. Secure Approval Workflow
• Administrators must configure Task-Based security. Any companies still functioning using

Mekorma Legacy security (User ID or Checkbook security) must convert to Task-Based security
to take full advantage of PowerApprovals.

2. Credentials
• In order to use the app, Approvers must have a valid email account associated with their GP

User ID. A valid email account is defined as an Office 365 account or a Azure Active Directory
federated domain account.

• System Administrators can handle the email setup for all Users, within the Approval Email
Setup window.

3. Grant Access to PowerApprovals
• An Administrator must share or give access to PowerApprovals for each Approver. For more

information on sharing Power Apps applications, please consult the following Microsoft Docs
documentation: Share a canvas app in Power Apps

Approvers

1. Download PowerApps
• Your company must hold valid Power Apps licenses and have an environment to deploy

PowerApprovals.
• A System Administrator must contact Mekorma to obtain a copy of PowerApprovals to be

uploaded and deployed in the PowerApps environment.
• For mobile deployment, Approvers must install Power Apps on their devices. Power Apps can

be obtained from the Google Play Store for Android devices or Apple store for iOS devices.
• Once an Administrator has shared PowerApprovals with a User, the application can be
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accessed by opening Power Apps on a mobile device.

Approvers are then ready to use the mobile app to review, reject and approve payments!

Last modified: May 16, 2023
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6.6.8. Optional Security Settings
The settings in this section enable you to tune your workflow with various options:

Enable Split Batches tells the system to split the batches based on Threshold ID Dollar-value ranges. The
purpose of this is that if one range is fully approved it can continue to be processed while other ranges are
awaiting approval.

Out-of-Office allows an Approver to designate another Approver of equal or great authority to cover for them
and get notified while they are away.

Enable EFT/Direct Deposit Security applies the same rules to electronic payments that apply to check
batches.

Quick messages allow users to enter frequently used reasons for rejecting a payment or voucher.

“Setup Security Rules for Transaction Checks” explains how the Threshold IDs apply when it comes to
Transaction checks, our recommendations and limitations in this regard.

Last modified: May 23, 2023
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6.6.8.1. Enable Split Batches
The Split Batch feature prevents entire batches from being held up when only some of the transactions
require approvals.

• If transactions within a certain threshold range do not need to be approved, those transactions can be
placed into their own batch to continue through the workflow.

• Transactions that do require approvals are split into separate batches according to threshold level and
then go through the configured approval process.

You can split payables batches based on the threshold levels designated in the applied Threshold ID.

1. Open the Mekorma Threshold Maintenance window (Mekorma Area page > Setup > System >
Threshold Maintenance).

2. In the Threshold ID field, create a new Threshold ID that has at least 2 dollar-value ranges or use the
lookup to select an existing Threshold ID.

3. Mark the checkbox labeled Split Batches.

The split batch functionality will now activate and your batches will split by threshold level if each
threshold level has a different set of approvers.

To see how split batches works when processing payments, click here.

Last modified: Jun 19, 2023
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6.6.8.2. Out-of-Office Feature Setup
If an Approver needs to delegate another GP user to take over their duties for a period of time, they can do
so in the Mekorma User Preferences window. The delegate must have access to the Mekorma Navigation
lists.

1. Login and navigate to the Mekorma User Preferences window (any GP User can do this).

2. Open the Mekorma User Preferences window.

3. Check the box Enable Out-of-Office Re-Route of Approval.

4. Use the look-up to select the desired Delegate. All GP users will be listed, but you must choose a
User with access to the Mekorma Approval or Batch Status List so they are able to approve
transactions.

5. Choose the Start Date and End Date for which you would like the Delegate to approve on your
behalf.

6. Click OK on the GP User Preferences window and the delegation will go into effect.

To access the Mekorma User Preferences window, go to the Microsoft Dynamics GP
drop-down > User Preferences > Additional > Mekorma User Preferences*
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Please note, if the Delegate wishes to be notified that their approval is needed during the
specified time period, they must setup email notifications in their own Mekorma User
Preferences window.

!
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6.6.8.3. Enable EFT/ Direct Deposit Security
The same security settings that are applied to your MICR check printing process can be enabled for EFT
and Direct Deposit processing.

1. Open the Mekorma Security Setup window.

2. Make sure the Task-Based Security tree is expanded.

3. Check the box next to EFT Security (Purchasing) and/or Direct Deposit Security (Payroll).

4. Click Save.

Last modified: May 16, 2023

To open the Mekorma Security Setup window, go to the Mekorma Area Page > Setup >
System > Security Setup.*
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6.6.8.4. Configure Quick Messages
Quick messages allow users to enter frequently used reasons for rejecting a payment or voucher. The
messages are entered on the Quick Messages window and then become available for selection on the
Reject Reason window when a payment or batch is rejected.

1. Open the Security Setup window.

2. Click on Quick Reasons to open the Quick Reasons window.

3. Use the drop-down to choose the company in the Company Name field.

4. Type Quick Reject Reasons – an individual company can have up to 10 different saved reasons.
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5. Click OK to save and close the window.

6. Approvers can then use Quick Reasons during the approval process, when a payment or voucher
rejection reason is needed.

Last modified: May 16, 2023
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6.6.9. Security for Transaction Checks
Recommendation: Separation of Duties = Disable Transaction Checks

Giving access to the same person to enter an invoice into the system and to cut a payment is a security
concern. Best practice recommends separation of duties.

For that reason we recommend withholding access to the alternate window for Mekorma Transaction
Checks. This will effectively disable transaction check printing by making any checks printed unusable. The
system will offer regular GP check printing but since you are printing checks on blank check stock they will
not have the MICR line, signatures, or other necessary features.

Option Two: With Secure Approval Workflow Implemented, Transaction Check
printing is limited to Approvers

Since Transaction checks are printed on-the-fly, we cannot send them through a workflow. However, the
security rules that you have setup still apply. If you choose to give access to transaction checks, they can be
printed if the following conditions hold:

1. the GP User entering the transaction and printing is set up as an approver with a security task.
2. the check is within the threshold level that that user is allowed to approve.
3. only one approver is required.

If two approvers are required for the check in question, the invoice will need to be posted and the payment
will need to be submitted through the Approval workflow.

The user who prints the check is recorded as the Approver the audit log.

Last option: No Security

Finally, if you do not enforce security rules in your setup, for example you use signatures only but no
approvers, you will be able to print a transaction check if the user has Alternate window access.

Last modified: May 16, 2023

Note that if the vendor being paid has a Threshold ID assigned to their Vendor Class, those
rules will override the rules on the checkbook.*
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6.7. Security for Miscellaneous Checks
Coming soon
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6.8. Setup Authorizers for Payroll
The US and Canadian Payroll systems benefit from Threshold ID security. However, they do not have the
same kind of workflow. The way that Payroll works is that one user must Build, Calculate and Print the
checks and cannot interrupt the flow to send a notification to an Approver.

Instead of going through a workflow, you can designate an Authorizer Task ID on your Payroll system to
impose one or two Authorizers. Anyone that has the Authorizer Task ID assigned to them will be able to put
in the their Dynamics GP User ID and Password right before the payments are generated in order to
authorize. If you configure for 2 Authorizers, then two people will need to put in their credentials. They will
have to be present in person or via a remote desktop session to enter their credentials.

To set this up:

1. Open the Mekorma Security Maintenance window (Mekorma Area Page > Setup > System >
Security Setup).

2. Click the word Authorizers under the Payroll Tree. A form will appear to the right.

3. Change the number of Authorizers to 1 or 2.

4. Choose the Authorization Task ID. Mekorma supplied the ID MEKORMA_BATCH_AUTHORIZER for
this purpose.

5. Click the DD Security checkbox if you want to impose the same Authorization rule on both checks
and Direct Deposits (recommended).

6. Click Save.
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6.9. Automate the Selection of Printers
There are two options for automating your printer selection so you don’t have to choose a printer every time
a batch is printed:

1. Use the Action Board printing options when printing payments from the Action Board.

2. Configure GP’s Named Printers

Action Board Printer selection
Action Board printer selection allows you to configure, in advance, which printer you are going to use to print
your MICR checks, check copies, overflows and EFT remittances. This prevents the automated actions of
the Action Board from being interrupted by prompts to select your printers.

Follow this link for instructions on how to set up your Action Board printers.

GP Named Printers
Mekorma leverages Microsoft Dynamics GP’s Named Printers feature to bring more convenience and
security to the in-house check printing process. Named Printers can save you time and eliminate printing
errors by allowing you to configure, in advance, which printer you are going to use to print your MICR
checks, check copies, overflows and EFT remittances and you will not have to choose a printer each time
you process payments.

This is how to automate the selection of printers if you are not using the Action Board

Follow this link for instructions on how to setup your Named printers.

Last modified: May 16, 2023

Please be advised of the following:

• If using the Action Board to print payments, either the Action Board printers or Named
Printers MUST be setup! The Action Board printer configuration will override Named
Printers.

• Named Printers is NOT currently supported by Dynamics GP or Mekorma for Session or
Redirected printing. Action Board printing is recommended in these circumstances.

!
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6.9.1. Action Board Printer Selection
You can set up print tasks on a system, company, or on a per-user basis for payments printed from the
Action Board. For context, Action Board Setup will give you broader overview of the Action Board.

The Action Board’s automation capabilities require that a printer is pre-defined. Where proper functioning
previously depended on GP’s Named Printers, now users can select/change default printers just prior to
printing. This makes it particularly useful if you use redirected or session printing because printers can be
selected right from the Action Board itself.

• Action Board printer selection overrides Named Printers configuration.
• When the Action Board printer selection is configured, user settings override company settings >

company settings override System/Default printers.

Admin Printer Selection
To configure default Action Board printers, either for all companies or for specific companies the System
Admin can do this setup in advance:

1. Open the Action Board Setup window (Mekorma Area Page > Setup > System > Action Board
Setup) and click on the Printers button. This will open the Action Board Printer Setup window.

Note that because of the variety of printer and operating system configurations, especially
with Citrix and Terminal Server environments, this selection needs to be activated by our
Customer Success Team. Please contact Customer Success if you would like to use it and
they will enable it free of charge and make sure it works in your environment.

!

If you are currently processing payments from the Action Board, and Named Printers is
configured and working effectively, there’s no reason to change your settings to this option.*
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2. Select System/Default printers. To configure default Action Board printers for individual companies
that override the system-level settings, follow the same steps except select a company, or choose
multiple companies that should have the same printer assignments instead of selecting System/
Default printers.

3. Click on the Select Printers button to open the Printer Selection window.

4. Using the drop-down in the column labeled Printer, choose the printer you’d like to designate for each
needed printing task:

• Check Printer—your actual checks.
• Check Overflow—your remittances if you are using overflow pages. You could designate the

same printer as checks but a different printer bin in order to get your checks and overflows to
collate.

• Copy Printer—non-negotiable check copies (but see PDF Check Archive for an electronic way
of doing this).

• Copy Overflow—remittance overflows for copies.
• EFT Remittance—if an EFT remittance needs to be printed you can direct it elsewhere so that it

doesn’t use check stock.

You can also assign a Paper Bin in the second column.
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5. Save the settings. The default printer setting will then apply to all companies. When processing
payments from the Action Board, checks and EFT remittances for all companies will print from the
System/Default printer.

User-level printer selection
Users can configure their own printers directly from the Action Board itself, which makes it easy to choose
the correct redirected or session printers prior to printing. User-level settings override both company and
system-level settings:

1. Open the Action Board and click on Options to open the Action Board Options window.

2. In the Options window, click on Printers to open the Action Board Printer Setup window.

3. By default, the User ID of the person currently signed in will populate the Printers set up for. Be sure
that your User ID is selected if you want to configure your own printer settings. It’s also possible to
choose ‘General’, which will apply the printer settings to all users.

To open the Action Board, go to the Mekorma Area Page > Transactions > Payables >
Mekorma Action Board.*
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4. Choose either System/Default printer to apply your individual settings across all your GP companies.
Or, choose one or multiple companies to customize the printer selection. Click the Select Printers
button to open the Printer Selection window.

5. You can adjust the company selection using the drop-down:

6. Using the drop-down in the column labeled Printer, choose the printer you’d like to designate for the
selected companies corresponding to each needed printing task (see above explanation).
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7. Save the settings. The printers specified will only apply to payments printed by that user, for the
specific tasks configured. User settings will override Company and System/Default printer
settings.

Last modified: May 16, 2023

This feature only works for Action Board processing! If you print batches on an
individual basis, and want to automate the printer selection, please configure GP Named
Printers instead. If there are no printers setup in this window, it will look to the printers set
up in GP Named Printers.

!
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6.9.2. Named Printers with Mekorma Payment
Hub
The video below will walk you through the steps necessary to configure Named Printers; or follow the written
instructions on the following pages, in the following order:

1. Setup Named Printers

2. Assign Named Printers to Mekorma Tasks

Last modified: May 16, 2023
https://www.youtube.com/embed/8_RlBvtUrG4?rel=0
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6.9.2.1. Setup Named Printers
The first step in configuring Named Printers is to name them! Printers must be setup with Printer IDs:

1. Login as an Administrator.

2. Navigate to the Assign Named Printers window (Microsoft Dynamics GP drop-down menu > Setup >
System > Named Printers).

3. Confirm that a Machine ID is entered, and that a default printer has been assigned in Dynamics GP.

4. Click on Setup to open the Setup Named Printers window.

5. Create a new Printer ID by typing the desired name in the Printer ID field.
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6. Choose the Printer Class from the drop-down menu options:
a. System: Applies the same designated printer across companies and for every GP user.
b. User: Allows each individual user to be assigned a unique printer, applied to every company the

user prints from.
c. Company: Gives the option to assign a printer on a per-company basis, no matter which user is

printing in that company.
d. User & Company: Ties printers to individual users on a per-company basis.

7. Fill in the rest of the fields as required by the Printer Class; a Printer Name must be selected by using
the lookup.

When setting up a printer for check copies, you must enter the integer value (1, 2, 3) for the
number of copies desired in the ‘Extra Description’ field. Check copies will not print if this

!
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8. Click Save.

9. Proceed to assign printers to Mekorma Tasks…

Last modified: May 16, 2023

field is left blank.
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6.9.2.2. Assign Named Printers to Mekorma
Tasks
Once Named Printers have been set up, you can now assign different printers for MICR checks, check
copies, overflows and EFT remittances in the Assign Named Printers window:

1. Log in as System Administrator (‘sa’).

2. Navigate to the Assign Named Printers window (Microsoft Dynamics GP drop-down menu > Setup >
System > Named Printers).

3. Choose 3rd Party from the Task Series drop-down menu.

4. Click on a Mekorma Task Description. Example: Mekorma MICR Checks

5. Select the Printer Class you’d like for that task. Example: System
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6. The Named Printers window will open, listing available printers within the System Printer Class –
click on the desired printer, then Select. Example: CHECKS

7. The Named Printer has now been assigned to that particular Task.

If I want to use a printer that is designated with the User & Company Printer Class, I must choose the
correct User ID and Company Name in the fields at the top of the window. Example: The
APFABRIKAM Printer ID assigned to Debbie in Fabrikam:

Please Make Note of the Following:

You must make the necessary adjustments in User ID and Company Name fields of
the Assign Named Printers window, depending on the Printer Class you want to
assign.

!
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6.10. Configuring Assign by Checkbook

Decide whether to Assign Checkbooks to Vouchers or to
Vendors
Some companies need to ensure that certain invoices are paid from certain checkbooks. This happens
often in the non-profit sector if they have an operating checking account for some payments and another
account for making grant payments. Or perhaps it is a property management company that pays each
invoice out of a specific checkbook based on the property.

You can assign Payables invoices, POP Shipment/Invoices and POP invoices to checkbooks using the
Assign by Checkbook option available from the Additional menu on transaction entry screens.

When you assign checkbooks to vendors it is to ensure that ALL the invoices for certain vendors are paid
by a specific checkbook. So, using one of the examples above, it is possible that if you were a non-profit
paying grants, a vendor receiving a grant would never be paid from the operating account. In that case, you
can designate a vendor checkbook right on the GP Vendor Maintenance screen rather than having to
specify checkbooks for each voucher.

Note that trying to Assign Checkbooks by both Vendor and Invoices would lead to unpredictable results. So,
before configuring, choose which method you plan to use.

Enable Assign by Checkbook
For either type of assignment, the feature must be enabled to take effect.

1. Open the Mekorma System Options window (Mekorma Area Page > Setup > System > System
Options).

2. In the Assign by Checkbooks Options section, mark the box next to Enable Assign by
Checkbook.
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Once this feature is enabled, you can Select Vouchers by Voucher Checkbook ID or Select Vouchers by
Vendor Checkbook ID during the batch building process.

Setup Default checkbook by Vendor
To set this up, all you need to do is include a Checkbook ID on the Vendor Master screen for each of your
vendors (Mekorma Area Page > Cards > Payables > Vendor > Options).
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Setup Default checkbook by Invoice
If you decided to Assign Checkbooks by Invoice, you can designate a checkbook on each and every
voucher. The additional two settings shown here are shortcuts that you may be able to use to default for
most vouchers, depending on how you have divided your workflow between team members or batches. This
can save you data entry keystrokes!

Default checkbook from Invoice Batch

When you start create a voucher batch, you can designate a checkbook with that batch. In general, the
checkbook assigned to the batch will be automatically assigned to all of the vouchers in the batch. So you
will not need to purposely designate a checkbook with each voucher unless you want to override the default.
You could easily create a different batch for each checkbook so that you never have to think about
specifically assigning the checkbooks to each voucher.

Default checkbook from Users

There is an optional setup feature for Assign by checkbook that allows default checkbooks to be assigned
on a per-user basis. This is useful if you have different users designated for each checkbook but perhaps
the users are sharing batches. If a user has a default, they can just enter all of their invoices without having
to think about what checkbook to assign them to. Please note: the default checkbook for the user will
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override the default checkbook assigned to a batch.

1. Open the Mekorma Assign by Checkbook window (Mekorma Area Page > Setup > Purchasing >
Mekorma Assign by Checkbook).

2. Click into the Default ID field for a user.

3. Use the look-up to select the appropriate checkbook.

4. Repeat this step for all users needing default checkbook assignments.

5. Click OK to save.

Last modified: May 16, 2023

Mekorma Mekorma Products User Guide for GP - Build x91_en

Copyright © 2022 Mekorma Enterprises. All Rights Reserved. Page 163 of 379



6.11. Setting up Check, Check Remittance
Copies and EFT Remittances
You can store your checks and check remittance copies electronically instead of on paper. There are two
methods to do this and you can use one or both:

1. The Check Image Archive displays images of payments right from the Dynamics GP Inquiry
windows.

2. The PDF Check Archive generates PDF copies of posted checks to a hard drive location.

Why do we have two options and how do EFTs fit in?

The Check Image Archive helps you answer vendor questions on-the-fly. It gives you a quick way to see
the remittances that the vendor received right from the Inquiry windows. You can also reprint the remittance
if you need to send or email it to your vendor.

The PDF Check Archive stores images outside the system and is primarily used when the company has an
external document management system that wants to pull in the check and remittance images. It is also
available if you have users outside of GP that need access to this information.

The PDF Check Archive is also needed when you use Mekorma to email EFT remittances to your vendors.
These are the PDFs that get emailed. So it is important to set up this repository before you set up your EFT
processing.

Setting up the Check Image Archive
The Check Image Archive shows the Payment Images automatically by default when you access the
payment inquiry screens.

It is possible to disable either the automatically displayed Image or the entire image archiving feature as
follows:

1. Open the System Options window (Mekorma Area Page > Setup > System > System Options).

2. Under Additional Printing Options, toggle the box labeled Auto Show Inquiry Check Preview to
enable or disable the automatic preview feature.

3. Under Additional Printing Options, toggle the box labeled Disable Check Archiving to enable or
disable the entire feature
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Setting up the PDF Check Archive
From the same window, you can enable your PDF Check Archive if you need to store .pdfs out on the hard
drive or you are sending EFT remittances through Mekorma.

1. Click the Enable PDF Check Copies option to enable the automatic Printing Check Copies to PDF
feature.
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This window gives you quite a bit of control over how to structure folders and how you structure the
filenames for the .pdf files.

2. Define the path of the Base Folder to store the PDFs. If the Base Folder field was populated prior to
upgrading, the Enable PDF Check Copies option is automatically checked. Mekorma recommends
designating a UNC folder. If this folder cannot be accessed for any reason, the check copies will be
created in the Data subfolder of your Microsoft Dynamics GP installation folder.

3. Choose from the options listed under the Available Fields for Folders section. If you choose one it
will be a sub-folder under the Base Folder field location. If you choose more than one, the system will
create a hierarchy of folders based on your choices.

4. Choose from the options listed under the Available Fields for Filename to name your file. You can
choose as many as you want and the system concatenates them together to form .pdf.

Last modified: May 16, 2023
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6.12. Setup for EFT Processing

This section explains how to setup Dynamics GP EFTs to use the Mekorma Payment Hub’s advanced
remittance features. This section assumes that your checkbook(s) are already configured for EFT
processing in Dynamics GP.

The benefits of processing Dynamics GP through the Mekorma Payment Hub are:

• You can maintain the same remittance fields as you use for your checks
• The remittances are archived in the check copy archive
• You can use special EFT fields on the check stock to void the checks but still print remittances
• The security system for approving EFT payments can be the same as with your checks
• You can process both check and EFT batches easily in the Action Board

Note that this section only applies if you will be configuring in-house processing to generate
EFT files and send them to your bank. If an outsource provider is processing for you, they
will pay your vendors via checks, EFT or credit card, and you don’t have to do any of these
setups. For more information, refer to Remote Payment Services.

*
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Follow these steps:

1. Specify Check or Remit Numbers.

2. Configure Email Settings for sending remittances.

3. Choose EFT Remittance Options in the Checkbook Maintenance window.

4. Enable EFT Comments and Logos for check formats if you want special logos or comments to show
just for EFT payments.

5. Setup for EFT Processing in the Action Board.

Last modified: May 16, 2023

https://www.youtube.com/embed/-Shy7OwUr5Q?rel=0
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6.12.1. Specify Check or Remit Numbers

This section shows how to configure check numbers instead of the EFT numbering sequence for your EFTs.
This option must be configured in Dynamics GP.

1. Open the Checkbook Maintenance window.

2. Select a Checkbook ID.

3. Click the EFT Bank option to open the Checkbook EFT Bank Maintenance window.

Note that this section only applies if you will be configuring in-house processing to generate
EFT files and send them to your bank. If an outsource provider is processing for you, they
will pay your vendors via checks, EFT or credit card, and you don’t have to do any of these
setups. For more information, refer to Mekorma Remote Payment Services.

*

The reason you may want to use check numbers for EFTs is if you are printing EFT
remittances instead of emailing them and you have pre-printed check stock. With Mekorma
Payment Hub the best practice is to use EFT numbers and email remittances or print
remittances on blank check stock.

!

To open the Checkbook Maintenance window, go to the Mekorma Area Page > Cards >
Financial > Checkbook*
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4. Select the Payables Options button to open the Checkbook EFT Payables Options window.

5. Select an EFT Payment Number option based on the following:

Use Check Numbers

• When using blank check stock, EFTs will print with check numbers as non-negotiable checks using
Mekorma Payment Hub and as reports based on the EFT Remittance Option selected.
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• If using pre-printed check stock, EFTs will print in the same way. However, be advised that you must
select Microsoft Dynamics GP Report Writer as the EFT Remittance option.

Use EFT Numbers

• When using blank check stock, EFTs will print with remittance numbers as non-negotiable checks
using Mekorma Payment Hub or reports based on the EFT Remittance Option selected.

• When using pre-printed check stock, EFTs will print in the same way. We do not recommend using
pre-printed check stock when printing EFT remittances with EFT numbers.

6. Click OK when you are finished and close any open windows.

Last modified: May 16, 2023

If your checkbook is configured for EFT and you print check copies to PDF, the check
copies will use EFT numbers for the naming convention instead of check numbers.*
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6.12.2. Setup your Vendor EFT Remit-tos
In Dynamics GP, the way that the system determine whether a vendor’s invoices will be selected for an EFT
batch or a check batch is via the Remit-To address on each invoice. Note that the Remit-To address on the
invoice defaults from the Remit-To address on the Vendor Maintenance card, but you can override it if you
have created multiple Address IDs for that particular vendor.

A Remit-To address is considered an EFT Remit-To address if the EFT Bank information screen is active as
shown below.
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For further information about this topic, please refer to your Microsoft Dynamics GP documentation.

Last modified: May 16, 2023
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6.12.3. Configure Email Settings

Email settings must be configured within Dynamics GP to ensure that vendors will receive EFT remittances.

1. In the GP Company Email Setup window, check the box labeled PDF, otherwise Mekorma cannot
generate EFT files.

2. Create a Remittance Message ID in your GP Email Settings. The EFT file is attached to this
message when sent.

Note that this section only applies if you will be configuring in-house processing to generate
EFT files and send them to your bank. If an outsource provider is processing for you, they
will email remittances to your vendors for you and you do not have to configure this. For
more information, refer to Remote Payment Services.

*
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3. For each vendor who accepts EFT payments, enter the appropriate email address so the system
knows where to send your EFT remittances. Go to the Vendor Address Maintenance window >
Internet Information window:
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4. This is where you enter the email address:

Last modified: May 16, 2023
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6.12.4. Choose EFT Remittance Options

In order to email EFT remittances to vendors, you must choose an appropriate remittance format.

1. Open the Checkbook Setup window (Mekorma Area Page > Setup > Purchasing > Checkbook
Setup).

2. Select the checkbook you would like to use for your EFT payments by clicking on the look-up to the
right of Checkbook ID. Mekorma allows you to process both checks and EFTs using the same
checkbook, but the formats are handled differently.

3. Using the drop-down, choose one of the options found in the EFT Remittance Options field.

• Dynamics GP Report Writer: This option only allows you to use GP’s Word templates. Do NOT
choose this option if you’d like access to Mekorma’s full library of PDF formats for your EFTs.

• Check Face/Overflow Stub: If selected, the Overflow format you have configured will be chosen first.
If you do not have an Overflow Format selected, the Primary Check format will be used instead.

Note that this section only applies if you will be configuring in-house processing to generate
EFT files and send them to your bank. If an outsource provider is processing for you, they
will email your vendor remittances for you. For more information, refer to Remote Payment
Services.

*
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• EFT Remittance Format allows you to choose from any of Mekorma’s formats by using the look-up
next to the EFT Remittance Format field.

EFT Remittance Format

Any Mekorma Payment Hub format used to generate EFTs will differ from check formats in the following
ways:

• The MICR line will not appear.
• The signature lines will not have any signatures. Instead, logical fields EFT non-negotiable and EFT

Void will print.
• EFT non-negotiable will print instead of a check value amount.

Last modified: May 16, 2023

Please note: In newer GP builds, you cannot process EFTs using Mekorma AND choose
the Print Separate Remittances for Overflows feature in GP for the same checkbook.
This feature requires that GP Report Writer be selected for the EFT Remittance Option.

!
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6.12.5. Enable EFT Comments and Logos for
Check Formats

The EFT Comment field prints a comment if the format is being used for an EFT transaction. EFT comments
configurations are stored on a per-checkbook basis.

1. Open the Checkbook Setup window (Mekorma Area Page > Setup > Purchasing > Checkbook
Setup).

2. Use the look-up to select a Checkbook ID.

3. Open the Additional menu > Additional Features.

4. In the Additional Features window, check the box for EFT comment to activate EFT comments.

5. Click the blue arrow that appears when you check the box. This will open the Options window.

6. Type in content that you would like to populate the EFT comment fields for the checkbook that you’ve
selected. When the EFT comment field is added to a layout in the Configurator, the information saved
here will be used to populate that field upon printing.

7. The EFT Comment is a field that can be placed on the check face or on the header of the remittance
portion. It will only show if the payment is an EFT payment. Once you have activated this feature, you
should go into the Payment Hub Configurator and add that field to the format.

Note that this section only applies if you will be configuring in-house processing to generate
EFT files and send them to your bank. If an outsource provider is processing for you, they
will configure your remittances for both EFT and Virtual Credit Card payments. For more
information, refer to Remote Payment Services.

*
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8. Click OK to save or go on to click the right arrow if you want to add an EFT Logo, which also only
prints if the payment is an EFT payment:

9. Navigate to the location where the desired logo is stored, and select the logo. When the EFT logo
field is added to a layout in the Configurator, the information saved here will be used to populate that
field upon printing.

10. Click OK a couple of times to save.

11. Once you have activated this feature, you should go into the Payment Hub Configurator and add that
field to the format.

Last modified: May 16, 2023
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6.13. Action Board Setup
Since the Action Board is the heart of the Payment Hub, understanding the Action Board is key. It is the
WAY to process payments, providing a single-window method of managing the entire payment process,
across companies and checkbooks.

The basic concept for setting up the Action Board is to create your Build IDs and Process IDs. With these
basics you can start testing your process:

• Create a Build ID
• Create a Process ID

The Action Board mimics the processes that you otherwise would do manually. In order to be a fully
automated process, you have to use various tools to tune the system to your requirements. The Action
Board needs to know how to deal with any dialogs that would pop up asking you questions or choices to be
made during the process. The rest of these steps detail both required and optional settings you can
configure in this regard:

1. Configure Printing and Posting Reports (Required)

2. Automate Printer Selection (Required)

3. Optional:
• Control Your Batch Names
• Results Reports Email Setup
• Options for Building Batches
• EFT Options for the Action Board
• Check Sorting Options
• Show/Hide Dynamics GP windows during processing

Note that implementing the Action Board is built upon the underlying manual processes. So before you can
embark on this level of automation, it advisable that you have fully configured and tested your check printing
and your EFT processes and that they are working to your satisfaction. Then, with those building blocks in
hand, you can fully automate your process.

Last modified: May 16, 2023
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6.13.1. Create a Build ID
A Build ID allows you to save rules for selecting your batches. You then assign the Build IDs to Process IDs
to build numerous batches with different criteria.

The function of Build IDs is to select the filters and sorts for the batches> However, these rules are not yet
linked to any particular company or checkbook. Process IDs are then used to assign these rules to
companies and checkbooks in any number of combinations to create your fully automated process.

1. Open the Build Maintenance window (Mekorma Area page > Setup > System > Action Board Build
Maintenance).

2. Type in the name of your new Build ID and an optional description.

3. The Action Board builds using Dynamics GP’s Build Payment Batch window and the selections mimic
that window. Select build criteria using any of these options from the Select: drop-down menu.
Multiple selections can be inserted:

• Vendor ID
• Vendor Name
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• Class ID
• Payment Priority
• Voucher Number
• Document Number
• Payment Number
• Due Date / Discount Date Cutoff
• Document Currency

4. Use the look-up to define the parameters of chosen criteria.

5. Click Insert to add selected criteria.

6. Save your Build ID. This set of criteria can now be added to a Process ID to automate the batch
building process.

The Action Board provides these additions to the normal selections:

• The Due Date and Discount Date cutoffs are calculated fields. They are calculated when you build,
using your Dynamics User Date. So you can set up a rule such as “Pay everything due in 7 days” or
“Pay everything whose Discount Date is prior to the end of the month”.

• The Payment Hub provides the ability to Assign Checkbooks to Vendors so you can choose to build
for only vendors assigned to this checkbook.

• The Payment Hub provides the ability to Assign Checkbooks to Vouchers so you can choose to build
for only vouchers assigned to this checkbook.

You can mix and match build criteria. For example, the Build ID above is being set up to do 3 things:

1. Only paying the UTILITIES Vendor Class

2. The user is in process of adding a Due date calculation to pay everything due in 7 days.

3. The Assign Checkbooks feature is being used to indicate only vendors from the Build checkbook
should be included in the batch

• Note that the build checkbook will be specified when they define the Process ID in the next
configuration step.

Another example of how customers use this is Payment Priority, which they use to divide up their batches
so that each batch relates to a specific payment priority. By mixing and matching the filtering criteria in
combination with different checkbooks, you can get quite clever.

Last modified: May 16, 2023
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6.13.2. Create a Process ID
A Process ID allows you to specify all of the batches that you want to build. You assign Build IDs to specific
checkbooks so you can filter what vendors and vouchers to pay in each batch. The Process ID lets you list
these sequentially so that one batch after the other is built each time, without error and without intervention.

Basic

There are two forms of the Process ID Maintenance window. This section describes the Basic form of the
window and below we describe an Advanced form of this window. The Advanced form is handy if you have a
lot of checkbooks and companies, but we suggest you start with the Basic window to get the hang of it.

1. Open the Action Board Process Maintenance window (Mekorma Area Page > Setup > System >
Action Board Process Maintenance).

2. To create a new Process ID, type the desired name in the Process ID field or use the look-up to bring
up an existing Process ID for editing.

3. Using the look-up next to each corresponding field, choose a company, a checkbook, and a Build ID
that contains the desired build criteria.

4. Choose the payment types you would like to include by checking the boxes next to Checks and/ or
EFTs.

5. By default, EFT batches will be processed using the Domestic format. If you need to create an EFT
batch using a different format then select the EFT format for this batch.

6. Press Insert.
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7. Save after adding desired criteria.

In the example above, the user is creating a monthly process for utility payments. They have some vendors
setup for check payments and some for EFT so they are inserting both types of payments. They have
already created the UTILITIES Build ID to limit the selection of vendors to the UTILITY vendor class and
have added batches for their Balanced Business company. And the screen shows that they are about to add
batches for their Complete Solutions company to this process. In their scenario, they could also create
another Build ID for monthly processing, such as RENT payments, and add it to this Process ID for both
companies.

Advanced

The Advanced form of the Process ID Maintenance Window allows you to apply a single Build ID to any
number of companies and checkbooks while minimizing your button clicks. Here we’ll learn how to create
the Process ID above for more companies with fewer clicks.

1. From the Action Board Process Maintenance window, click on Advanced in the top menu bar.
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2. To create a new Process ID, type the desired name in the Process ID field. Or, use the look-up to
bring up an existing Process ID for editing.

3. First, in the upper right quadrant, choose the Build ID that you want to use. Here we have selected
UTILITIES and it is showing in grey instead of blue to indicate it is selected.

4. Next, in the left column, when the Checkbooks radio button is selected, all available companies and
their associated checkbooks will be listed. Hold down the control key and click each company/
checkbook you want to use. Here we have selected Balanced Business, Complete Solutions and
Fabrikam, Inc.

5. Click on the Checks and/or EFTs button, depending on which payments types you want to include.
This will add the information to the Linked Checkbooks and Build IDs section on the right-hand side
of the window. The applied Build ID will be listed as DEFAULT. You can see the result of this example
below:
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6. Repeat this process until the Process ID contains all checkbooks, payment types and Build IDs you
want to include.

7. Save and close the window.

Other Currencies

When you click the Checks or EFTs button, all of the lines in the Process ID default to the functional
currency. After you have inserted them, you can change their currencies.

1. Select Currencies in the upper right quadrant to see your currency list.

Note that the Advanced Setup window only supports the default EFT format, which is
Domestic. If you use EFT using Foreign format, you can set that up using the Basic setup
window.

!
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2. Using the control key, click on each line in the Linked Checkbooks & Build IDs list that you want in
a different currency.

3. Click the currency you want to change to.

Credit Card Batches

Note that in the left column, you can also list credit cards that you have configured for paying vendors.
Choose companies and credit cards and link them to a Build IDs to create credit card batches, similarly to
the above.

Copying From Another Process ID

Lastly, the left column may be used to copy all or some of the lines from another Process ID.

1. Choose Copy

2. A list of Process IDs will appear, choose the one you want to copy from.

3. The whole Process ID will show as a list in the left column. You may select all or some of the lines
that you want to copy from that list using control click.

4. Click Copy to copy the selected items over to the Linked Checkbooks & Build IDs list.

Last modified: May 16, 2023
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6.13.3. Configure Printing and Posting
Reports
There are certain settings that need to be in place to ensure the Action Board’s automated processes are
not interrupted. The following steps are required for the Action Board to perform as intended:

Automate Printer Selection

Automating the printer selection will ensure that checks and EFT remittances can print without interrupting
the process – you must set up GP Named Printers or configure Action Board printers.

Define Paths for Reports/Lists

Posting Reports and edit lists should be set up so they can be generated without interfering with the Action
Board’s automated processes.

1. Open the Posting Setup window (Administration > Setup > Posting > Posting)

2. Use the drop-down to set the Series as Purchasing.

3. Use the drop-down to set the Origin as Computer Checks.

4. For each report that you want to generate, assign it to a file and not to a query, monitor or to a
printer by checking the box in the file column and unchecking the other boxes in the Send To column.
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5. You can assign a destination for each individual posting journal type as needed. Click on the Path
field directly underneath a particular posting journal, then on the folder icon under Append/Replace.

6. Choose the file where you would like this posting journal to be sent. The file path will display:

In standard functioning, if you posted multiple checkbooks in the same company, it would
overwrite your posting journal each time. However, the Action Board will capture the
path name and insert this phrase: (Checkbook id _ YYMMDD_HHMMSS_) between
the names of the folder and the file in order to create a unique name. The Posting setup is
done on a per company basis in Dynamics GP. Therefore, you can setup each company to
point to its own path if you want to separate your posting journals on a per company basis.

*
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6.13.4. Control Your Batch Names
Mekorma Action Board ‘Build Batch’ requires unique batch numbers. A suffix is added to your batch
numbers when you build and is automatically incremented. The batch name format will be -### based on
the current date.

We have reserved only 3 characters for the unique suffix and have used a 3-character Alpha-Numeric value,
from ‘001’ up to ‘ZZZ’ for this sequence. Although we try to avoid being overly cryptic, batch names in
Microsoft Dynamics GP are limited to 15 characters. The Mekorma Payment Hub uses some of them when it
splits a batch and for other significant third-party products that require batch naming conventions (e.g. Multi-
Entity Management from Binary Stream). So, we have come up with this convention to create unique batch
names while using limited characters.

Without configuration, the daily start suffixes will always start at 1 for all companies and batches will just be
named in sequence as they are created. The Daily Start option allows you to start the suffix sequence at
different starting points for each company. If you do this, then all the batches from one company will be
grouped together when they are sorted.

To set this up:

1. Open the Action Board Setup window (Mekorma Area Page > Setup > System > Action Board
Setup).

2. Add the desired suffix in the column labeled Batch No. Suffix for every company you want to
differentiate. In our example, Fabrikam’s batch suffix was set to 100, Balanced Business is 200, and
Complete Solutions is 300. If you have 36 companies or less, we recommend just using the most
significant digit like we have done in this example, going from 100, 200, … to A00, B00, … Z00.
However, if you have more than 36 companies, you will want to use 2 digits such as 050, 100, 150,
etc. The third digit will be used to name the batch from within the company. This second example
double the number of company starting points to 72 and leaves up to 50 unique batches per day per
company before there is a duplicate batch name. Most of the time in a large multi-company situation
only a handful of batches are created each day and this naming convention supplies ample room for
unique names.
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3. After running a batch-building process in the Action Board, the appropriate suffix is added to the end
of each batch number according to the suffix assignment. The suffix increases by one increment for
each batch:

4. The Batch No. Suffix can be changed at any time within the Action Board Setup window.

5. Click OK.

Last modified: May 16, 2023

Mekorma Mekorma Products User Guide for GP - Build x91_en

Copyright © 2022 Mekorma Enterprises. All Rights Reserved. Page 194 of 379



6.13.5. Results Reports Email Setup
After batches are built in the Action Board, a Build Results Report is generated.

After processing checks and EFTs in the Action Board, the Print Process Results Report is generated.

After posting checks and EFTs in the Action Board, the Posting Results Report is generated.

By default, these reports are created/displayed immediately after the corresponding process is completed.
You can choose to send them to a chosen email address instead. For example, you can send the Build
Results Report to Approvers when using the approval workflow to notify them with a single report, rather
than having them notified with every batch that is built.

Configure Email Settings for Results Reports

1. Open the Action Board Options window (Mekorma Area Page > Setup > System > Action Board
Setup > Options)

2. In the All Actions section, check the box next to Email Report After Processing.

3. Enter the correct email address in the Email Address field.
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4. Click Save.

Last modified: May 16, 2023
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6.13.6. Options for Building Batches
Automated approval requests/edit lists

When building payment batches using the Action Board, you have the choice to automate approval
requests, print edit lists, or disable those options.

1. Open the Action Board Options window (Mekorma Area Page > Setup > System > Action Board
Setup > Options).

2. In the Build Payment Batches section, choose one of these options:
• No Edit Lists or Approvals: This will disable edit lists and approval requests entirely.
• Request Approvals: This will automatically send approval requests as each batch is built.
• Print Edit Lists

◦ If you generate Edit Lists, you can print them or send them to a folder:
▪ Printer: send to a printer
▪ File: Saved as a text, tab-delimited, comma-delimited or HTML file type and stored

in a file location of your choosing. The Action Board will give them unique file
names to help you identify them.
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6.13.7. EFTs in the Action Board
When you use the Action Board, your system can select both your checks and EFT batches in one process.
As you saw, you use a Build ID to set your rules for what invoices to include and a Process ID to tell the
system what checkbook to use and whether to build checks, EFTs or both.

The EFT Options enhance the workflow of EFTs compared to that of checks. This what the workflow for
Checks looks like:

This is one way the EFT workflow could look with the optional automation that the Action Board can do for
you:

This is because with EFTs, further automation is possible:

1. You can post automatically instead of checking for printer jams
2. You have the option of having the process generate the EFT files automatically.

Note that in both cases, Request Approval can be done automatically as you build batches or as a separate
step.

Choose Automation Options
1. Open the Action Board Options window (Mekorma Area Page > Transactions > Payables > Payment

Hub Action Board > Options).

2. Choose options in the EFT & Safepay section:
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Posting Options

• Post EFT immediately after Print or Send: This option ensures that EFTs are posted immediately
after printing or emailing remittances.

• Generate EFT after Posting: This option automatically generates the EFT file (to be sent to your
bank) immediately after posting.

If you do not mark Post EFTs Immediately after Print or Send option, you will post the EFTs along with
your checks using the Post action on the Action Board.

If you do not mark Generate EFT File after Post, you will generate your EFT file using the Generate EFT
File action on the Action Board.

You may choose not to post the EFTs automatically and/or not generate the EFT file for the bank
automatically for any of these reasons:

• You want to combine more than one batch from the same checkbook in the same company into a
single ACH file.

• Your organization has a separation of duties that requires different users to post EFTs and generate
the EFT files.

• You need to change the Transmission Date or Settlement Date in the ACH file. By default, the
transmission date will be set to the Dynamics GP User Date.

EFT Remittance Options

In addition to the above automation options, there are switches you can use to select the EFT remittance
processing flags, so that the process can mimic what you would normally choose in your EFT process:

• Print Document: The remittance will be sent to the printer specified by Named Printers configuration.
• Send Document in Email: The vendor will receive an email containing the remittance – if the vendor

does not have an email address or internet access is not available, the remittance will print instead of
being emailed.

Last modified: May 16, 2023

You cannot use GP Report Writer when processing EFTs with the Action Board. The
settings for EFT Remittance options (as configured in the Mekorma Checkbook Setup
window) must be set to Check Face/Overflow Stub or a Mekorma EFT Remittance
Format.

!
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6.13.8. Check Sorting Options
You can choose how to sort your checks during the Action Board printing process. Note that this sort only
applies within a batch, not across batches.

1. Open the Action Board Options window (Mekorma Area Page > Transactions > Payables > Payment
Hub Action Board > Options).

2. Use the drop-down next to the Sort Checks By field to choose from the options as shown below:

Note that Company Default defers to the default value from the Payables Management Setup
window.

3. Click Save.
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6.13.9. Show/Hide Dynamics GP Windows
While the Action Board is processing, it will display the windows that it is processing so that you can see
what it’s doing. It is designed so that you can also continue to use your computer while the Action Board is
processing as long as you don’t try to use anything in GP. This options allows you to hide the windows if the
window flashing is disruptive.

1. Open the Action Board Options window (Mekorma Area Page > Transactions > Payables >
Mekorma Action Board > Options).

2. In the All Actions > User Interface Automation Control section, check the box next to Show Dynamics
GP windows if you would like to view all windows as the system processes. If not, unmark the box.

3. Click Save.

Last modified: May 16, 2023

Even if you choose to hide window flashing, unfortunately this option will not be able to hide
the login window that shows as the system changes through companies.

!
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6.13.10. Exclude a Company from the Action
Board
When you install Mekorma Payment Hub, all of your companies can be used with the Action Board.
Likewise, if you create a new company, it is automatically enabled for the Action Board. Generally, there is
no disadvantage to this because you are not required to select any of your companies when you create your
Process IDs.

However, if you would like to limit the list of companies you see when setting up Process IDs, you can
choose to exclude a company from using the Action Board.

1. Open the Action Board Setup window (Mekorma Area Page > Setup > System > Action Board
Setup).

2. To exclude a company from using the Action Board, unmark the box in the column labeled Enable for
Action Board for that company.

3. Click OK.

Last modified: May 16, 2023
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6.13.11. Testing the Action Board
If you would like to test the Action Board payment process in a test environment or even a single test
company, but you want to avoid actually generating any transactions, you can do so by designating your
companies as test companies. By doing this, you render all the checks and EFTs generated by the testing
processes to be unusable.

• Checks will print without a MICR line or signatures
• EFT files will be in a test format that is not usable by the bank.

Note that this option is provided for testing and learning, but it is not required for implementation.

1. Open the Action Board Setup window (Mekorma Area Page > Setup > System > Action Board
Setup).

2. Mark the box in the column labeled Test Company.

3. Click OK.

The following companies will always be marked as test companies in both production and test
environments:

• Microsoft Dynamics GP sample company, Fabrikam, Inc.
• Companies with ‘‘ in the name
• Companies with ‘‘ in the name

Last modified: May 16, 2023
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6.14. Remote Payment Services Configuration
Mekorma and your payment outsource provider will handle the initial implementation and configuration of
the Remote Payment connector in Dynamics GP. This is necessary as Mekorma needs to implement and
test the authentication to the provider’s portal. However, once the system is up and running, you should be
able to apply updates yourself.

If you’re using Corpay, the existing fields Customer Account and Invoice Comments are customizable. Data
in GP tables can be mapped to these two fields and printed on Corpay remittance. A customized function is
needed to support the mapping. Please reach out Mekorma Customer Success team at
support@mekorma.com to discuss your needs.

Remote Payment Services Configuration

Once Table Maintenance has been run in a given company, the Remote Payment Services Configuration
window defines how that particular company is configured for payment outsourcing.

• The Check printing location field determines whether your payments are processed with the Remote
Payment service (Outsourced), or printed and processed in-house (Locally).

• The Integration base folder is configured to store the files sent to and received from the outsource

To open the Remote Payment Services Configuration window, go to the Mekorma Area
Page > Setup > Purchasing > Remote Payment Services Configuration*
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provider. The system will automatically create the following subfolders if they do not exist:
◦ OutPayments: Will store payment files sent to the outsource provider
◦ InPayments: Will store processed payment (response) files received from the outsource

provider
• All checkbooks that have been configured for outsourcing are listed in the Checkbook ID area. You

will see the following information:
◦ Checkbook ID and description
◦ Bank account number as configured in Dynamics GP
◦ Remote Bank Account: This field lists the name of your outsource provider (AvidXchange or

Corpay) and the funding method (see below for more information)
◦ Account Type: Displays whether the checkbook is configured using the pre-funded or credit

model; this refers to the method the outsource provider uses to fund your vendor payments.
Only a pre-funded model is currently available – this means the outsource provider will withdraw
funds from your company’s bank account before generating and sending payments to vendors.

Choosing a Funding Method

Before the outsource provider can send payment to your vendors, they will withdraw the funds to cover the
full amount of the payments.

• Transaction funding: We recommend this method, where every GP payment corresponds to a
withdrawal from your company’s checkbook. The withdrawals are treated like checks and each
individual payment clears the checkbook.

• Bulk funding: All payments for the day for each checkbook are funded by a single withdrawal. Bulk
Funding simplifies the number of banking transactions for funding. This can reduce costs and benefit
your reconciliation processes. However, this method creates some complexity in the AP setup by
using a pseudo Credit Card vendor as a holding tank to net out those funding transactions. When you
first implement, our implementation team will work with you to determine the best funding method for
your situation.

Corpay customers: Choose Corpay.
AvidXchange customers: Transaction Funding is the only Funding method so no choices will show.

Last modified: Jun 19, 2023
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6.14.1. Add Checkbooks for Remote
Payments
The Remote Payment Services Configuration window is used to configure checkbooks for outsourcing.

Step 1: Checkbook is configured in the ePayment Portal

You will need to contact your provider (AvidXchange or Corpay) and fill out the necessary paperwork. The
first checkbooks are included as quoted in your original implementation and additional checkbooks can be
added for a fee.The provider will then configure the checkbook within their payment portal.

Step 2: Add the Checkbook in the Remote Payment Services Configuration window (Mekorma Area
Page > Setup > Purchasing > Remote Payment Services Configuration.)

The new checkbook must then be added in Dynamics GP.

1. Log in to Dynamics GP and open the Remote Payment Services Configuration window.
2. Click on the next available line in in the checkbook fields at the bottom of the window. Use the look-up

to choose the Checkbook ID of the checkbook you want to add. This will pull in the GP account
description and bank account number.

3. Match the GP checkbook with the correct provider by using the drop-down menu under the Remote
Bank Account column.

• For AvidXchange customers, there will only be one choice (AvidXchange)
• For Corpay customers, choose Corpay. This funds each payment individually, by transaction.

4. Click Save to close the window, and from that point on the checkbook can be used to pay vendors
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remotely.

Step 3: Ensure your Check Numbers are Unique.

1. Go to each Checkbook (Financial Area Page > Cards > Checkbook)
2. Please make sure that all check numbers sent to the outsource provider are unique by unmarking the

Duplicate Check Number and Override Check Number settings in the lower right corner of this
window.

Last modified: Jun 19, 2023

Mekorma Mekorma Products User Guide for GP - Build x91_en

Copyright © 2022 Mekorma Enterprises. All Rights Reserved. Page 209 of 379



6.14.2. Enrolling Vendors
With Remote Payment Services, your vendors get to choose their payment type of check, virtual credit card
or ACH.

When first implementing the system, the vendors are enrolled by communicating the vendor information to
the outsourced provider as follows:

1. Follow the procedures in Add Checkbooks for Payment Outsourcing
2. Reopen the Remote Payment Services Configuration window (Mekorma Area Page > Setup >

Purchasing > Remote Payment Services Configuration) and click the Enroll Vendors button.

You will click Enroll Vendors at initial implementation. Running Enroll Vendors changes any vendors with
no record showing that they are Enrolled or Excluded to set them as Enrolled. There is no harm in clicking
this button at any time because it will not change anyone who already has a status set.

All active vendors are enrolled when you click Enroll Vendors in this window. See below for information
about Ongoing Enrollment.

Ongoing Enrollment

Once Mekorma Remote Payment Services is installed, and when you add a new vendor to the system, it will
automatically enroll the vendor into outsourced processing. If you do not enter an address for the vendor,

Note that if you want to make exceptions and process some vendors locally, you can do so.
See Local Printing Options.*
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the enrollment status remains as ‘Pending’ enrollment but not actually enrolled until it has an address
because otherwise the outsource provider won’t know where to send the check.

Communication with Outsource Provider

This information is communicated between Dynamics GP and the Outsource Provider so that they can pay
on your behalf:

Vendor Records Address Records

Vendor ID Vendor ID

Vendor Name (Check Name) Address ID

GP Status Address Lines 1 to 3

Is 1099 State/Province

Payment Terms ID Postal Code

Main Address ID Country

Remit-to Address ID Contact Name

Class ID Phone Number

Tax ID Number Email-to Address

Email-cc Address

Payment Method (0:Check, 1:EFT)

Check Name

Bank Account Name

Bank Account Number

Bank Routing Number

Bank Account Type (CHECKING or SAVINGS)

Last modified: Jun 19, 2023
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6.14.3. Local Printing Options
There may be circumstances in which you need to print checks/payments locally that are normally sent to
the outsource provider for processing. You can do this by changing a vendor, payment, checkbook, or
company’s status.

Change an individual vendor’s status to Excluded

This setting allows you to exclude a vendor from the outsourcing service; all payments to that vendor will be
processed locally.

1. Open the Vendor Maintenance window and select a Vendor ID using the look-up (Mekorma Area
Page > Cards > Payables > Vendor).

2. Click on Additional > RPS Status to open the Remote Payment Services Status window. In this
example, Allenson is currently enrolled as a vendor who receives payment from the outsource
provider.

3. Use the drop-down menu in the Remote Payment Services Status window to change the status to
Excluded.
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4. Click Apply; then Save in the Vendor Maintenance window.

There are three possible Enrollment Statuses for your GP vendors:

1. Excluded: This vendor’s information is not sent to the outsource provider, and payments to this
vendor are processed locally.

2. Enrolled: Payments to this vendor are sent to the outsource service for processing, unless another
type of local processing exception has been set up (see Exceptions for Remote Payments).

3. Pending: This vendor was not automatically enrolled for outsource processing and will be processed
locally. This happens if a vendor does not have a Remit-To address. In this case, the system cannot
send them to the outsource provider since they would not know where to send the payment if the
vendor chooses to receive a paper check.

The status of your vendors’ enrollment can be viewed in the Vendor Enrollment Inquiry window (Mekorma
Area Page > Inquiry > Payables > Remote Payment Services Enrollment Status).
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Change an individual payment’s settings to Locally

This is a one-time action that allows you to exclude a particular payment in a batch from being sent to the
outsource provider. You access this from the Print Mekorma Payments window.

1. Open the Print Payments window (Mekorma Area page > Transactions > Payables > Print
Payments).

2. Select a batch that contains a payment you want to switch to Local Processing.
3. Click Additional > Payment Processing Options to open the Payment Processing Options

window.
4. Select the payment you want to print locally.
5. In the Process Type column, use the drop-down to choose Locally and click OK to apply the change.
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Notice that all the rest of the payments will be processed with their Default setting. So if the vendor is set up
for Local processing, they will process locally and if the vendor is Enrolled in outsourcing they will be sent
out.

Disable a checkbook that has been configured for outsourcing

1. Open the Remote Payment Services Configuration window (Mekorma Area Page > Setup >
Purchasing > Remote Payment Services Configuration).

2. Right-click on the row for the checkbook you want to disable and choose Delete Row. Delete the
Checkbook ID and associated data.
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3. Save the changes.

Any payments from the checkbook will be processed locally.

To add the checkbook back to the Remote Payment Services configuration, add the checkbook back.

Change an entire company’s printing location

This action disables the Remote Payment Services Connector for a particular company. No payment files
from this company will be sent to the outsource provider.

1. Open the Remote Payment Services Configuration window. (Mekorma Area Page > Setup >
Purchasing > Remote Payment Services Configuration)

2. In the Check printing location field, use the drop-down to choose Locally and Save.

Last modified: May 16, 2023
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6.15. MEM Connector Setup
MEM stands for Multi-Entity Management®, a product written for Dynamics GP by Binary Stream Software.
This product allows organizations to manage multiple legal entities (companies) in one single database.
MEM also uses the term facility interchangeably with entity or company. The facility is assigned as payables
transactions are entered or batches created.

What does the MEM Connector do?

The MEM connector provides an interface between MEM and Mekorma providing several functions:

1. If you are printing checks, the facility information can be printed on payables checks. The software
uses SQL scripts to access Binary Stream tables to retrieve the necessary information.

2. If you are sending payments to outsourcing, the facility information can also be printed on your
remittances. This works for MEM Decentralized processing only, where each facility has its own
designated checkbook(s).

3. If you are selecting your batches using the Payment Hub Action Board, the connector supports the
ability to create MEM batches.

Depending on which version of Multi-Entity Management is set up for your company, you will find the facility
(entity) fields for payables in either the MEM Centralized category, or the MEM Decentralized category.
Payroll can only use the Decentralized category.

MEM Decentralized:

A Decentralized process uses a dedicated checkbook to pay each facility. Only one facility is reported per
check. The Facility Name, ID and Address will be printed in the header area of the check or stub.
Configuring this way provides an advantage because it paves the way to outsource your payment
processing and have the correct entity reported on each payment.

MEM Centralized:

A Centralized process uses one checkbook to pay multiple entities. Transactions for multiple entities can
appear on one payables check. In this case, the Facility Name or ID will be printed on each voucher line.
You can also choose to group your vouchers by facility and show sub-totals. Facility Address is generally
not used in this setup. For correct alignment of columns on the check stub if using subtotals, the connector
provides common voucher line fields which must be used with the Facility ID or Name when creating the
stub layout.

Note that MEM Centralized processing is not support when you send your payments
through an outsource service provider. If you want to outsource your MEM payments, each

!
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Please note: Binary Stream has changed the process for entering and storing a legal name for entities when
using MEM for Payables in Decentralized mode. The Facility Company Name should now be retrieved from
the BSSIEntityLegalName column of table B3900400 starting from the MEM version listed in the table
below.That is, entity description will be printed with entity legal name.

A1 GP Version MEM Version

2013 N/A N/A

2015 14.00.1079 506s11 (and later)

2016 16.00.0404 601s05 (and later)

2018 All Builds All Builds

All prior versions should use the former process, which retrieves the entity name from the GL Segment table
(GL40200).

Last modified: May 16, 2023

facility must have its own checkbook.
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6.15.1. Enable MEM Connector for Individual
Checkbooks
The MEM Connector must be enabled on a per checkbook basis for both Payables and US Payroll. This will
enable the MEM integration buttons to display on the necessary windows.

Payables

1. Open the Mekorma Checkbook Setup window (Mekorma Area Page > Setup > Purchasing >
Checkbook Setup).

2. Choose the checkbook you want to be used with the MEM Connector.

3. Click on Additional > Additional Features.

4. Check the box next to MEM Connector for Payables.

5. Click Save to close the window.

6. Repeat these steps for any additional checkbooks you would like to configure.

Payroll

1. Open the Mekorma Checkbook Setup window (Mekorma Checkbook Setup* window, go to the
Mekorma Area Page > Setup > Payroll > Checkbook Setup).

2. Choose the checkbook you want to be used with the MEM Connector.

3. Click on Additional > Additional Features.

4. Check the box next to MEM Connector for Payroll.
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5. Click Save to close the window.

6. Repeat these steps for any additional checkbooks you would like to configure.

Last modified: May 16, 2023
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6.15.2. MEM Connector for Payables
The Mekorma MEM Payables Connector module integrates with Binary Stream’s Multi-Entity Management®
product to provide access to facility (entity) information for vouchers printed on Mekorma Payment Hub
check stubs. The MEM Connector for Payables requires a separate registration key.

There are two setup options available for the MEM Connector: Sorting and Subtotals.

Facility Check Sorting Options

Sorting options are available for both Centralized and Decentralized. For Centralized, checks are sorted by
the Facility ID or Name of the first voucher on the check. For Decentralized, checks print in Facility ID or
Name order.

1. Open the MEM Connector for Payables Setup window (Mekorma Area Page > Setup > Purchasing
> Mekorma MEM for Connector for Payables Setup).

2. Select an option in the first section to define Facility Check Sorting:
• No Facility Sorting

◦ The Decentralized category is used to print the Facility ID or Facility Name and Address
on the header.

• Sort by Facility ID
◦ For MEM Centralized, the Centralized category is used to print vouchers on the stub in

Facility ID order and checks in Facility ID order.

Please note, to populate the setup tables, this window must be opened and the OK Button
clicked even if no options are selected.

!

Mekorma Mekorma Products User Guide for GP - Build x91_en

Copyright © 2022 Mekorma Enterprises. All Rights Reserved. Page 221 of 379



◦ For MEM Decentralized, checks print in Facility ID order.
• Sort by Facility Name

◦ For MEM Centralized, this option uses the Centralized category to print vouchers on the
stub in Facility Name order and checks in Facility Name order.

◦ For MEM Decentralized, checks are printed in Facility ID order.

3. Click Save to save your changes.

Facility Check Stub Subtotal Options

This option is available for Centralized only. Vouchers are grouped and subtotaled on the stub by Facility ID
or Facility Name. If this option is selected, all fields on the voucher line must be from the MEM Centralized
category or they will not align properly.

1. Open the MEM Connector for Payables Setup window.

2. Select an option in the second section to define Facility Check Stub Subtotal Options:
• No Facility Subtotals

◦ Uses Centralized category to print vouchers on the stub with no subtotal line.
• Subtotal by Facility ID

◦ Sorts and groups vouchers by facility ID and prints a subtotal line after each group.
• Subtotal by Facility Name

◦ Sorts and groups vouchers by facility name and prints a subtotal line after each group.

See here for a detailed list of how sorting and subtotal options effect the printing results.

Last modified: May 16, 2023

For correct alignment of columns on the stub when using the subtotal options, all normal
voucher line fields should be replaced with fields from the MEM Centralized Payables
category of the Configurator.
*
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6.15.3. Configure MEM Connector Payables
Check Formats
Depending on which version of Multi-Entity Management is set up for your organization, you will find the
facility fields in either the MEM Decentralized Payables category, or the MEM Centralized Payables
category.

The following fields are provided for placement on the stub layout and can be added using the Mekorma
Configurator:

Centralized Payables

• Facility ID, Facility Name, and Facility Company Name are multi-line fields (to print on each
voucher line).

• Internet User Defined 1 and Internet User Defined 2 are single-line fields in both Centralized and
Decentralized categories.

The MEM Connector must be enabled in order to print MEM fields on checks and stubs.!
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Decentralized Payables

• Facility ID, Facility Name, and Facility Company Name are single-line fields (to print in the header).
• Internet User Defined 1 and Internet User Defined 2 are single-line fields in both Centralized and

Decentralized categories.
• Facility Address is a multi-line field which contains one line each for Address 1, 2, and 3 (if they are

populated) and a final line containing city, state, and zip code. This field is only available for
Decentralized Payables.

Setup options for payables Sorting and Subtotals can be configured.

Last modified: May 16, 2023

Please note, MEM Connector fields will not be displayed on a test check. You must print an
actual check in order to test.

!
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6.15.4. MEM Connector for Payroll
When Binary Stream’s Multi-Entity Management is installed, each employee is assigned to a facility, and
each facility is assigned to a payroll checkbook. When payroll is processed, multiple checkbooks may be
accessed.

Check numbers are assigned according to the checkbook associated with the employee’s facility.

The MEM Connector for US Payroll provides the following custom sort order for payroll checks:

• Facility ID
• Division Code
• Class ID
• Last Name of Employee
• First Name of Employee

Setting Up Facility Signature IDs

In standard MICR payroll processing when security is by checkbook, a default Signature ID is assigned for
all payroll checks. With the MEM Connector for Decentralized Payroll, a Signature ID needs to be defined
for each payroll checkbook. This setup is used to determine which signatures print on the checks and when
the signatures should be printed.

1. Open the Mekorma Password and Signature Setup window (Microsoft Dynamics GP > Tools >
Setup > Payroll > Mekorma US Payroll > Facility Signature ID).

2. Enter information to define a Signature ID for each payroll checkbook. Please note, the Signature ID
must match the payroll Checkbook ID.

Signature 1 and Signature 2 will print in the Facility Signature 1 and Facility Signature 2 fields on the
check layout. Detailed instructions for defining Signature ID’s can be found in the Signatures & Passwords
by Checkbook section.

Setting Up Payroll Signature IDs

In standard MICR payroll processing when security is by checkbook, a default Signature ID is assigned for
all payroll checks. With the MEM Connector for Decentralized Payroll, a Signature ID needs to be defined
for each payroll checkbook. This setup is used to determine which signatures print on the checks and when
the signatures should be printed.

1. Open the Mekorma Security Setup window. This configuration applies to security by Checkbook, so
be sure that the Checkbook radio button is marked in the Set Passwords By section.

2. Click on the Checkbook ID to which you want to assign a Signature ID.
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3. Click the look-up next to Payroll Signature ID.

4. Choose the desired Signature ID.

5. Repeat for all payroll checkbooks.

Last modified: May 16, 2023
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6.15.5. Configure MEM Connector Payroll
Check Formats
The following fields are provided for placement on the stub layout and can be added using the Mekorma
Configurator:

These fields are available when the Checkbook Security window is set to the US Payroll module, and the
Configurator is opened to display a Payroll check format.

• Facility Name: The description field in the GL Segment Description Setup table where the Segment
Number = 1 and the Segment ID is the Facility ID.

• Facility Stub String: A concatenated field consisting of the Facility ID, Division Code (from the
Employee Master table), and the Employee ID. This field is separated by hyphens.

• Facility Check String: A concatenated field consisting of the Facility ID, Division Code (from the
Employee Master table), Employee ID, and Employee Class ID. This field is separated by hyphens.

• Facility Address: A multi-line field that will contain the street address, city, state, and zip code for the
facility.

All payroll checkbooks should be set up with the same stub layout file. Only one layout is
used when printing payroll checks.

!
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• Internet User Defined 1: From the Company Internet Information window.
• Internet User Defined 2: From the Company Internet Information window.

Last modified: May 16, 2023

The MEM Connector must be enabled in order to print MEM fields on checks and stubs.!
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6.16. Dynamics GP Web Client
Mekorma products are compatible with the Dynamics GP web client. You can easily print payments from a
browser of your choice, although Mekorma recommends using Google Chrome.

When doing so, you will have access to all Mekorma features with a few exceptions. The following actions
cannot be done in the web client and must be performed on a Microsoft Dynamics GP desktop client:

• Edit Mekorma check formats within the Configurator.
• Import or edit signature files, check formats and company logo files.

Before printing payments using the Dynamics GP web client, be sure you have completed the following
installation and configuration tasks:

1. Install the Mekorma Print Client.

2. Configure your browser settings.

3. Grant appropriate users security access to the Web Client.

https://www.youtube.com/embed/_nQVFo2Uwnk?rel=0
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Last modified: May 16, 2023

A limitation of the Dynamics GP Web Client is that it will not work with the Payment Hub
Action Board. If you are in a Dynamics GP Web Client environment and you would like to
use the Action Board, please log in to our online portal and open a new case with the
Mekorma Customer Success team.

!
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6.16.1. Browser Settings
In order to print checks using Mekorma on the Dynamics GP Web Client, there are a few browser settings
that will make the process run more smoothly.

Settings for .mcp (Mekorma Check Print) Downloads

1. Open Google Chrome and type in the following URL: chrome://settings.

2. Scroll and open Advanced.

https://www.youtube.com/embed/_nQVFo2Uwnk?rel=0

https://www.youtube.com/embed/_nQVFo2Uwnk?rel=0&start=208&end=314

Mekorma recommends Google Chrome, as Chrome allows you to bypass manually opening
the .mcp (Mekorma Check Print) file at print time. If you are using any other browser, you
will have to choose to open the Mekorma Print Client by selecting to open the .mcp file each
time it is generated.

*
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3. Scroll to Downloads. Choose the folder location path where the encrypted Mekorma Check Print file
(.mcp) will be written at print time.

4. Turn off Ask where to save each file before downloading.

To prevent further browser dialogs when using Chrome

1. Print a Mekorma test check in Web Client. You will see an .mcp file type in the lower left of the
browser.

2. Click the down-arrow and mark Always open files of this type. When printing a test check for the
first time, you will additionally need to click on the .mcp file to manually launch the Mekorma MICR
Print Client.

Last modified: May 16, 2023

This feature is available with all major browsers. Please consult your browser
documentation for specific steps to enable this feature.*
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6.16.2. Web Client Security
Once your browser settings are configured, you are ready to provide Web Client print access to your
Accounts Payable users as needed.

1. Log in to Dynamics GP as a System Administrator or Power User.

2. Open the Web Client Security Access window (Mekorma Area page > Setup > System > Web Client
Security Access).

3. Designate the ability to print over the GP web client by marking the box next to a User’s name.

https://www.youtube.com/embed/_nQVFo2Uwnk?rel=0

https://www.youtube.com/embed/_nQVFo2Uwnk?rel=0&start=208&end=314

https://www.youtube.com/embed/_nQVFo2Uwnk?rel=0&start=314&end=345
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6.17. Omit Zero Dollar Checks
Enable this feature if you do NOT want to print a $0 checks when you process batches using Mekorma
functionality.

Example: a credit memo is fully applied to an invoice and zero dollars is left on the payment, and you do not
want the check to print.

1. Log in to Dynamics GP as an Admin or Power User.

2. Open the Mekorma System Options window (Mekorma Area Page > Setup > System > Mekorma
System Options).

3. In the section labeled Additional Printing Options, check the box next to Omit $0 checks in
Payables:

4. Click Save before closing the window.

Last modified: May 16, 2023
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6.18. Disable Print Blank Checks
On occasion, you might want to print a Blank Check for making a handwritten payment, such as if you need
a check to take off-site.

Some companies consider this to be a security risk. If you would like to deny users access to the Print Blank
Checks option from the Mekorma Payment Hub Payables, US Payroll and Canadian Payroll menus, the
Print Blank Checks Menu Option can be disabled.

1. Open the Mekorma Security Setup window (Mekorma Area Page > Setup > System > Security
Setup).

2. With the Task-Based tree expanded, check the box next to Disable ‘Print Blank Checks’ Menu
Option.
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6.19. Bypassing Mekorma and Printing
through Dynamics GP
From time to time, some users want to use Mekorma Payment Hub in some companies or with some
checkbooks and use Dynamics GP’s native functionality (bypass Mekorma) with other.

Within the same company, a single user cannot process payments both using Mekorma Payment Hub and
with native Microsoft Dynamics GP. If you need to do this, you will need to configure both a second
Microsoft Dynamics GP user and a second launch folder that launches Dynamics GP without Mekorma
Payment Hub.

Last modified: May 16, 2023
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7. Using the Mekorma Payment Hub for
Payables
This section of the User Guide will explain, guide and demonstrate how to use the Mekorma Payment Hub.

Last modified: May 16, 2023
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7.1. Build Batches
Use Action Board to Build All your Batches at Once

The method of choice for building your payment batches and processing payments is to use the Mekorma
Payment Hub Action Board. The Action Board roboticizes your standard GP procedures by giving you the
power to define and store batch-building rules. It then applies those rules when you’re ready to build
batches.

Before you can build batches using the Action Board, you need to create at least one Build ID and use it to
create a Process ID. Then you are ready to build batches in the Action Board. See Action Board Setup for
more information.

Building Batches for Payment Outsourcing (Mekorma Remote Payment Services)

Batches intended to be processed as remote payments by one of the Mekorma outsourcing providers can
be created using the Action Board or by using Dynamics GP with manual procedures. This is one of the
slickest ways of automating your payments—set up your rules, push a few buttons and you’re done—no
checks to fold, seal and mail.

When you build for remote payments—just select the batches as if they are check batches — Mekorma and
your outsource provider will do the rest.

Building Batches Manually

Of course, you can still use the standard Microsoft Dynamics GP manually to create your batches and then
pay the through the Payment Hub. Use this method if you are not able to identify any repeatable rules for
pulling invoices into your batches. The following windows can be used to manually build a payment batch:

• Build Payment Batch
• Edit Payment Batch
• Edit Vendor Payment

Assigning Checkbooks before Building Payment Batches

Mekorma Payment Hub gives you the ability to designate checkbooks for certain vendors or for certain
vouchers as an enhancement to the Batch Building process. If you would like to do that, you will want to
Assign Checkbooks before building your payment batches.

Last modified: May 16, 2023

Mekorma Mekorma Products User Guide for GP - Build x91_en

Copyright © 2022 Mekorma Enterprises. All Rights Reserved. Page 240 of 379



7.1.1. Action Board: Build All Your Batches at
Once
The Action Board allows you to build all of your batches across companies with one click of a button. Refer
to Action Board Setup prior to building batches from the Action Board.

1. Open the Mekorma Action Board (Mekorma Area Page > Transactions > Payables > Mekorma Action
Board).

2. Click on the Action drop-down menu and select Build Payment Batches (this is the default selection
upon first opening the action board).

3. Choose the desired Process ID. The system will list all associated Build IDs that make up the Process
ID, in addition to pending Batch Numbers (this number will change after batches have actually been
built), company, checkbook, type of payment included in the batch, and the currency used. If there are
any issues preventing a particular batch from being built, this will display in the column Reason Batch
will not be created.

4. Once you have confirmed there are no errors, click Process. The system will build batches using the
saved build criteria stored within the Process ID. Any vouchers that meet the criteria will be pulled into
the appropriate batch.

5. During the process, each company login window will display as the Action Board changes through
companies. You can choose to show or hide other windows.
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Action Board Build Results Report

6. When all batches have been built, the Build Results Report is generated and can be displayed on the
screen, printed, or saved as a file in a location of your choice. You may prefer to set up your options
so the Results Report is emailed instead, in which case this window will not display:

Example:
The Report will show you:

• Batches that were built because there were payments that met the criteria of the designated Build ID.
• Batches that were not built or REMOVED because no transactions were found to meet the applied

build criteria.
• How much time it took to build all the batches.

If you need to access Dynamics GP while batches are being built, it is possible to pause the
process by clicking Pause, then Resume when ready. If you do not want to complete the
process after pausing, click Finish.
*
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Last modified: May 16, 2023

If you are using the MEM Connector in conjunction with the Action Board, you can build
batches for Centralized and Decentralized processes at the same time.*
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7.1.2. Build Remote Batches
One of the advantages of Mekorma Remote Payment Services is that all standard GP procedures for
building batches can be used to build remote batches and all payment types can be combined in a single
batch. The batches are built as standard check batches, yet the vendors will be paid by their choice of
payment method.

As a review, here are the methods for building batches from most to least automated:

• Mekorma Payment Hub Action Board (Mekorma Area Page > Transactions > Payables > Mekorma
Action Board)

• Build Payment Batch (Mekorma Area Page > Transactions > Payables > Build Payment Batch)
• Edit Payment Batch (Mekorma Area Page > Transactions > Payables > Edit Payment Batch)
• Edit Vendor Payment (Mekorma Area Page > Transactions > Payables > Edit Vendor Payment)

When creating a batch for payment outsourcing:

• Choose Check as the payment method. Payments sent for outsourcing must originate as a Computer
Check batch. Please note that manual payments and payments entered as Transaction Payments in
a voucher will not be processed by Remote services.

• Select a checkbook that is configured for Remote Payment Services.
• Build your batch by selecting the desired payments/ payment criteria.

When batches contain payments for vendors Excluded from the service – those payments will NOT be sent
electronically. Mekorma Remote Payment Services will automatically split the batch when processing and
print those vendor payments locally as checks.

Last modified: May 16, 2023

Please note, if your company has multiple checkbooks with some checkbooks not
configured for remote payments, those payments would not be processed using Remote
Payment Services even if they are made to vendors who are enrolled in the service. And for
those checkbooks, batch creation rules would fall back to standard GP functionality where
EFT and check payments cannot be combined in the same batch.

*
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7.1.3. Using the Action Board with Multi-Entity
Management
Before processing payments using Binary Stream’s Multi-Entity Management (MEM) with the Action Board,
the following steps must be taken:

• MEM must be activated for all entities you want to process with the Action Board.
• All users must have a default entity assigned. That entity ID will be pulled by default from the

Payables Batch Entry window when the Action Board goes through the automated build process. If
you do not have an entity ID set up for a company that is going to be included in your Action Board
processes, you will be notified through a warning message.

When using the Action Board, you can Centralize or Decentralize your process when you are building a
Process ID.

Build Batches

1. Open the Mekorma Process Maintenance window (Mekorma Area Page > Setup > System >

https://www.youtube.com/embed/0S48R6wKMv0?rel=0
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Mekorma Process Maintenance).

2. Type in the name of a new or existing Process ID. If creating a new one, select a combination of a
company, checkbook, Build ID, and payment type to add to the Process ID.

3. Click Insert.

4. Select the build parameter you would like to Centralize or Decentralize.

5. Click on the MEM button at the top of the window to open the Multi-Entity Management Settings
window.

6. Select a Centralized or Decentralized processing type. One or both processing types can be
included within a Process ID.

7. Click OK to close the window.

8. On the Action Board, select the Process ID that contains the Centralized and/ or Decentralized build
criteria.

9. Check the box next to each batch you would like to build, and click Process. Centralized and
Decentralized processes can be built simultaneously, or one at a time.

10. When building batches for a Centralized process:
• The system will build one batch from all invoices that meet the selected build criteria from each

of the child entities within the designated parent entity. See the Build Results Report:

11. When running a Decentralized process:
• One batch is built for each entity, resulting in multiple total batches. See the Build Results

Report:

12. Continue with the next steps in the Action Board to process and post your batches.

Last modified: May 16, 2023
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7.1.4. Assign Checkbooks for Invoice
Selection
Mekorma’s Assign by Checkbook enables you to indicate that each invoice or each vendor should be paid
by a specific checkbook. There is more extensive information about this feature on the page Enable Assign
by Checkbook page to help you decide if you want to use this feature and help you get started.

Follow these links for instructions on how to assign checkbooks to:

• Individual invoices
• Payment batches
• Purchase orders
• Vendors

After assigning checkbooks, you can use the feature to select invoices by “vendor” or voucher when building
batches. This process can be also be automated into your Action Board process when you create a build ID.

Last modified: May 23, 2023

Please note, credit memos and returns cannot be assigned to checkbooks. Instead they
must be applied to the appropriate invoices to be credited to the specified checking account.

!
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7.1.4.1. Assign a Checkbook to an Invoice
You can assign a checkbook to each invoice when you enter it in the system. This is the method you should
use if you have a group of invoices that are each paid by different checkbooks. Configuring Assign by
Checkbook explains why you might want to do that.

Building Batches:

• When you build your batches with the Mekorma Action Board, you will want to include Select by
Voucher Checkbook on your Build ID.

• When you build your batches with Dynamics GP Build Payment Batch, you will need to check the
option Select Vouchers by Voucher Checkbook ID. If you do not, the vouchers from the vendor will
be included in a check batch from any checkbook.

• If you use a manual method for creating your payment batches, the Vendor checkbook will not be
enforced.

To assign a checkbook to a Voucher:

1. Open the Payables Transaction Entry window (Mekorma Area Page > Transactions > Payables >
https://www.youtube.com/embed/BtB5CR_v6Uk?rel=0&start=84&end=111
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Transaction Entry).

2. Create a new payment or use the look-up to open an existing voucher.

3. Click on Additional and select Assign by Checkbook to open the Assign by Checkbook Entry
window.

4. Use the look-up in the Checkbook ID field to select the checkbook you want to assign this specific
payment to.

If you don’t see the Assign by Checkbook window option, please enable the feature.*
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5. Click OK to save.

Posted Invoice Assignments

If you have already posted an invoice but haven’t paid it yet, the checkbook assignment can be changed.

1. Open the Payables Transaction Inquiry by Vendor window or the Payables Transaction Inquiry
by Document window (Mekorma Area Page > Inquiry > Payables > Transaction by Vendor or
Transaction by Document).

2. Select the payment you want to reassign and open the Additional menu > Assign by Checkbook to
open the Assign by Checkbook Inquiry window.

3. Using the look-up, select the Checkbook ID you’d like to assign this payment to.
Please note: posted invoices that have already been paid cannot be reassigned.
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4. Click OK to close this window.

5. Click OK on the Payables Transaction Inquiry by Vendor or Payables Transaction Inquiry by
Document window to save.

Last modified: May 16, 2023
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7.1.4.2. Assign a Checkbook to a Payment
Batch
Assigning a checkbook to an entire batch works well if you have a group of invoices that should all be paid
by the same checkbook.

The Assign by Checkbook feature must be enabled before any assignments can be made.

1. Open the Payables Batch Entry window (Mekorma Area Page > Transactions > Payables >
Batches).

2. Select the batch you want to assign using the look-up next to Batch ID, or create a new batch.

3. Use the look-up to choose the appropriate checkbook.

https://www.youtube.com/embed/BtB5CR_v6Uk?rel=0&start=84&end=111

https://www.youtube.com/embed/BtB5CR_v6Uk?rel=0&start=58&end=83
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4. Click Save.

Last modified: May 16, 2023
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7.1.4.3. Assign a Checkbook to a Purchase
Order
The Assign by Checkbook feature can also be applied to the Purchase Order (PO) system. A checkbook
can be assigned to the original Purchase Order, and that assignment will be carried through to the invoice.

The Assign by Checkbook feature must be enabled before any assignments can be made.

1. Open the Purchase Order Entry window (Mekorma Area Page > Transactions > Purchasing >
Purchase Order Entry).

2. Use the look-up to pull up an existing PO, or create a new one.

3. Click on the Additional menu > Assign by Checkbook to open the Assign by Checkbook Entry
window.

https://www.youtube.com/embed/BtB5CR_v6Uk?rel=0&start=84&end=111

https://www.youtube.com/embed/BtB5CR_v6Uk?rel=0&start=58&end=83

https://www.youtube.com/embed/BtB5CR_v6Uk?rel=0&start=112&end=130
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4. Use the look-up to choose the appropriate Checkbook ID.

5. Click OK.

6. Click Save on the Purchase Order Entry window.

A checkbook assignment can also be made when you receive the shipment by following the exact same
steps in this window:
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Or you can assign it when you match the invoice:

Last modified: May 16, 2023
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7.1.4.4. Assign a Checkbook to a Vendor
You can assign a specific checkbook to a Dynamics GP vendor. Configuring Assign by Checkbook explains
why you might want to do that.

Building Batches:

• When you build your batches with the Mekorma Action Board, you will want to include Select by
Vendor Checkbook on your Build ID.

• When you build your batches with Dynamics GP Build Payment Batch, you will need to check the
option Select Vouchers by Vendor Checkbook ID. If you do not, the vouchers from the vendor will
be included in a check batch from any checkbook.

• If you use a manual method for creating your payment batches, the Vendor checkbook will not be
enforced.

To assign a vendor to a checkbook:

1. Open the Vendor Maintenance window (Mekorma Area Page > Cards > Payables > Vendor).

2. Click on Options at the bottom of the window to open the Vendor Maintenance Options window.

3. Select the appropriate Checkbook ID.
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4. Click OK to save and return to the Vendor Maintenance window.

Last modified: May 23, 2023
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7.1.4.5. Select Vouchers by Vendor
Checkbook ID
Assigning a payment by vendor Checkbook ID is most useful when you want to pay a certain type of vendor
from a particular checkbook.

Examples:

• You are paying grants, and the grant vendors can only be paid by the grant checkbook and not your
operating checkbook.

Once a checkbook has been assigned to a vendor, you can build check batches using the Assign by
Checkbooks feature in the Build Payment Batch (Select Payables Checks) window. The Assign by
Checkbooks feature cannot be used with the Edit Payment Batch (Edit Payables Checks) functionality.

Video tutorial for GP2018

https://www.youtube.com/embed/BtB5CR_v6Uk?rel=0&start=84&end=111

https://www.youtube.com/embed/BtB5CR_v6Uk?rel=0&start=58&end=83
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1. Create a new batch in the Build Payment Batch (Select Checks) window.

2. Choose Computer Checks in the origin field.

3. Select the Checkbook ID that you want to build payments for and Save the batch.

4. You will then be back on the Build Payment Batch window. Click the box next to Select Vouchers by
Vendor Checkbook ID on the Assign by Checkbook window (which should already be open).
Clicking this box activates the feature – only payments to vendors that have been assigned to the
checkbook that you’re building payments from will be pulled.

5. Fill out any additional selection criteria you wish to use to build your batch. Only vendors assigned
to this Checkbook ID will be selected.

Last modified: May 23, 2023

https://www.youtube.com/embed/BtB5CR_v6Uk?rel=0&start=112&end=130

https://www.youtube.com/embed/BtB5CR_v6Uk?rel=0&start=190&end=260

Please note that if this box is not checked, then the assign by checkbook
feature will not work when you build your payment batch.!

In GP 2018, you have the ability to create a Payment Option ID that can be applied to
any of your batches. This ID will store selected settings from the Build Payment
Batch window, including your choice for checkbook assignments.
*
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7.1.4.6. Select Vouchers by Voucher
Checkbook ID
Assigning a payment by voucher checkbook ID is most useful when you want to pay a certain type of
voucher from a particular checkbook.

Examples:

• You are paying grants, and the grant vouchers can only be paid by the grant checkbook and not your
operating checkbook.

• You manage properties and each property has its own checkbook to pay the bills.

Once a checkbook has been assigned to an invoice, you can build check batches using the Assign by
Checkbooks feature in the Build Payment Batch (Select Payables Checks) window. The Assign by
Checkbooks feature cannot be used with the Edit Payment Batch (Edit Payables Checks) functionality.

Video tutorial for GP2013-2016

https://www.youtube.com/embed/vyYhx6svE24?rel=0
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Video tutorial for GP2018

1. Create a new batch in the Build Payment Batch window.

2. Choose Computer Checks in the origin field.

3. Select the Checkbook ID that you want to build payments for and Save the batch.

4. You will then be back on the Build Payment Batch window. Click the box next to Select Vouchers by
Voucher Checkbook ID on the Assign by Checkbook window (which should already be open).
Clicking this box activates the feature – only payments that have been assigned to the checkbook that
you’re building payments from will be pulled. Please note that if this box is not checked, then the
assign by checkbook feature will not work when you build your payment batch.

5. Fill out any additional selection criteria you wish to use to build your batch. Only invoices assigned to

https://www.youtube.com/embed/tLt4TewtyBc?rel=0

In GP 2018, you have the ability to create a Payment Option ID that can be applied to any
of your batches. This ID will store selected settings from the Build Payment Batch window,
including your choice for checkbook assignments.
*
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this Checkbook ID will be selected.

Last modified: May 16, 2023
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7.1.4.7. Select Vouchers Using the Action
Board
To use the Assign by Checkbooks feature when automating the batch building process in the Action Board,
you can Select Vouchers by Vendor or Voucher Checkbook ID when you create a Build ID.

1. Create a Build ID with either Select by Vendor Checkbook ID or Select by Voucher Checkbook ID
marked. This feature will work with both check and EFT batches.

2. Add any other filter you want to include in your batch build process (Ex. Due Date, Discount Date,
Payment Priority, etc.).

3. Use this Build ID in your Process ID. Please note that you need to repeat the use of this Build ID for
each of your checkbooks to be sure that all of your invoices get selected.

Follow the hyperlinks for more detailed instructions on how to create Build IDs and Process IDs.

Last modified: May 16, 2023
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7.2. Approve with Secure Approval Workflow
After building a batch of payments, the batch can be locked before printing. Configure an approval workflow
to notify designated users (Mekorma Approvers) that there are transaction payments needing their approval.

Workflow must first be configured by by setting up Approvers for Payables and applying them to
checkbooks.

The experience for Approvers will vary, depending on which security model has been configured. In order to
complete the workflow task, Approvers/Authorizers must navigate to the appropriate Mekorma Navigation
List where transactions/ batches can be reviewed and approved/authorized.

Last modified: May 16, 2023
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7.2.1. Request Approval for a Single Payment
Batch
After batches are built, a user must request approval for each batch to initiate the workflow.

Automate Approval Requests

When using the Action Board to build payment batches, approval requests can be sent automatically as the
batches are built. This completely eliminates the need to manually request approval. See here for how to
enable automatic approval requests.

Manually Request Approvals

1. After building a payment batch using standard GP procedures, Requestors can alert the appropriate
users that their approval or authorization is needed. Navigate to Mekorma Area Page >
Transactions > Payables. The Request Approval button can be selected from any one of these
options:

• Build Payment Batch (under Additional)
• Edit Payment Batch (under Additional)
• Edit Payments (under Additional)
• Print Payments (replaces Print button)
• Mekorma Payment Batch Status List
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2. An email or text message will be sent to all eligible Approvers that they have transactions needing
their review, according to each Approver’s notification settings.

Last modified: May 16, 2023

To configure notifications, go to the Mekorma Preferences window.*
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7.2.2. Cancel Approval Request
Once a request for approval has been sent for a particular batch, that batch will be locked and can no longer
be edited. To unlock the batch for editing purposes, the request itself can be canceled.

1. Go to the Mekorma Payment Batch Status List (Mekorma Area Page > click on Mekorma Payment
Batch Status List in the left Navigation pane).

2. Check the box next to the batch(es) you would like to unlock.

3. Click Cancel Request.

4. Choose OK to confirm cancellation or Close if you do not want to cancel.

5. The batch(es) can now be edited as needed.

Last modified: May 16, 2023
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7.2.3. What Makes Batches Split when you
Request Approval?
The idea behind Split Batch is that different dollar-value levels may have different people approving them.
By splitting the batches into these threshold levels, a batch can go on to be processed once it is fully
approved and even if another batch with higher dollar-value levels is still awaiting approval.

Split batches are enabled on a Threshold ID which is then assigned to a checkbook. When a batch goes
through the approval workflow and approvals are requested, the batches will be split based on the
Threshold ID logic applied to the checkbook.

When the batches are split, the naming convention changes and the original batch name is appended to
include “_01,” “_02”, and so forth, depending on configured threshold logic included within the Threshold ID.

Example of Split Batch Feature in Action

In the example below, the Threshold ID named “TASKEXAMPLE1” is configured with 3 different threshold
levels:

When approvals are requested for a batch with this Threshold ID, the batches are split like this:
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• Transactions in the first Threshold Level (from $0.01 to $1,000.00) remain in the first batch with the
name “APBATCH”. Notice that they are automatically FULLY APPROVED because at this threshold
level the Threshold ID did not require approvers.

• Transactions in the second Threshold Level (from $1,000.01 to $4,999.99) are split into the next batch
named “APBATCH_01.” In this batch, anyone with MEKORMA_APROVER_LEVEL_2 security access
can approve and then the batch will be ready to process.

• Transactions in the third Threshold Level (from $5,000.00 to $999, 999, 999, 999, 999.99) are split
into the next batch named “APBATCH_02.” This batch will need two people to approve, one with
MEKORMA_APROVER_LEVEL_2 security access and one with MEKORMA_APROVER_LEVEL_3
security access before it can be processed.

This pattern continues depending on the number of threshold levels you have in your Threshold ID logic.

Splitting batches with Vendor Class and Checkbook Security

Threshold IDs can be applied to a Vendor Class as well as a Checkbook. If you have Vendor Class security
configured, then the “Split Batch” setting on Vendor Class Threshold will determine how your batches split
as follows:

1. If the Vendor Class is assigned a Threshold ID with split batches enabled:
Any payments associated with this Vendor class will be split from the original batch regardless of
whether the Checkbook’s Threshold ID has Split Batch enabled.

2. If the Vendor Class is assigned a Threshold ID that does not have Split Batches enabled:
Payments associated with that vendor class will split based on the Checkbook’s Threshold ID.
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Split Batch Naming

When the batches are split, either an “A1” or an “A2” is appended to the original batch name, depending on
the number of approvers required. So for example, a batch named “AP JUNE” may become “AP JUNE-A1”
and “AP JUNE-A2”. For that reason, your original batch name is limited to 12 characters or less once you
enable the Split Batch feature.

Last modified: May 23, 2023

If you use the same batch name multiple times while the split batches (A1 and/or A2) are
still in the approval process, the system generates B1 and B2 batches, and the letter
continues to increase up to Z1 and Z2 until all batches have been cleared from the pending
approval queue. After the “Z” batches, the system can no longer split the batches, causing
the entire original batch to enter the approval process.

!
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7.2.4. Review and Approve
If the approval workflow has been configured, Mekorma Approvers must approve transactions within their
designated threshold levels before checks/ EFTs can be printed and processed.

Review Payment Transactions

1. To complete approval tasks, approvers must navigate to the Mekorma Approval Area Page (Mekorma
Area Page > click on Mekorma Approval in the upper left-hand menu).

If Multi-Entity Management (MEM), is installed and enabled, the Entity ID column can be viewed in
the results list. Only the pending approval payments in an entity to which the user has access will be
displayed.

https://www.youtube.com/embed/aV_lONtVQLM?rel=0&start=194&end=352
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2. Transactions can be viewed using the following filters:
• All Transactions: displays all transactions needing approval whether they are in the user’s

threshold range or not. The user will not be able to approve transactions of a greater amount
than their assigned threshold level.

• Approvable Transactions: displays payment transactions within or below the user’s assigned
threshold range, all of which that user has the ability to approve.

• My Specific Transactions: displays the transactions specifically assigned to the user (those
transactions within their designated threshold range).

• By Batch: displays all transactions the user has permission to approve, grouped together by
batch.

3. Review payments by clicking the box next to a payment, then on the Payment Vouchers button. This
will display all vouchers that make up that vendor payment in the bottom section of the drop-down
window. Please note, when the Payment Vouchers window is open, all payments by vendor for that
batch are listed in the top section; clicking on a payment will display all vouchers that make up that
vendor payment in the bottom section.
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4. Double-click on the desired payment in the upper section of the window. This will open the Mekorma
Approval Batch Drill Down window.

5. In the Vendors section, click on a vendor payment and a list of vouchers included in that payment will
display on the right-hand side.

6. Double-click on any individual voucher to open the Payables Transaction Entry Zoom window. If
using DocAttach or a similar 3rd party plug-in that integrates with the inquiry window, the image of the
corresponding invoice can be accessed by selecting the note for a voucher, the relevant image, then
Preview.
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7. You can reject vendor payments, or reject individual vouchers once reviewed.
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7.2.4.1. Review and Approve
If the approval workflow has been configured, Mekorma Approvers must approve transactions within their
designated threshold levels before checks/ EFTs can be printed and processed.

Review Payment Transactions

1. To complete approval tasks, approvers must navigate to the Mekorma Approval Area Page (Mekorma
Area Page > click on Mekorma Approval in the upper left-hand menu).

If Multi-Entity Management (MEM), is installed and enabled, the Entity ID column can be viewed in
the results list. Only the pending approval payments in an entity to which the user has access will be
displayed.

https://www.youtube.com/embed/aV_lONtVQLM?rel=0&start=194&end=352

https://www.youtube.com/embed/aV_lONtVQLM?rel=0&start=194&end=352
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2. Transactions can be viewed using the following filters:
• All Transactions: displays all transactions needing approval whether they are in the user’s

threshold range or not. The user will not be able to approve transactions of a greater amount
than their assigned threshold level.

• Approvable Transactions: displays payment transactions within or below the user’s assigned
threshold range, all of which that user has the ability to approve.

• My Specific Transactions: displays the transactions specifically assigned to the user (those
transactions within their designated threshold range).

• By Batch: displays all transactions the user has permission to approve, grouped together by
batch.

3. Review payments by clicking the box next to a payment, then on the Payment Vouchers button. This
will display all vouchers that make up that vendor payment in the bottom section of the drop-down
window. Please note, when the Payment Vouchers window is open, all payments by vendor for that
batch are listed in the top section; clicking on a payment will display all vouchers that make up that
vendor payment in the bottom section.
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4. Double-click on the desired payment in the upper section of the window. This will open the Mekorma
Approval Batch Drill Down window.

5. In the Vendors section, click on a vendor payment and a list of vouchers included in that payment will
display on the right-hand side.

6. Double-click on any individual voucher to open the Payables Transaction Entry Zoom window. If
using DocAttach or a similar 3rd party plug-in that integrates with the inquiry window, the image of the
corresponding invoice can be accessed by selecting the note for a voucher, the relevant image, then
Preview.
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7. You can reject vendor payments, or reject individual vouchers once reviewed.
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7.2.4.2. Approve or Reject Vouchers
Approvers have the ability to reject specific vouchers in the same way that vendors may be selected for
rejection. Approvers no longer have to reject the entire vendor payment if only one of the invoices should
not be included. When Multi-Entity Management (MEM) is installed and enabled, users can only review the
pending approval payments in an entity to which they have access.

The following steps outline how a designated approver can reject a payment voucher:

1. Navigate to the Mekorma Approval list.

2. Check the box next to the batch you’d like to review.

3. Select the drop-down next to Payment Vouchers (in top menu bar). This will open a window that lists
the batch’s vendor payments in the top pane. When you click on any particular vendor payment, the
bottom pane will list the vouchers that make up that payment.

4. Double-click a vendor payment in the top pane to open the Mekorma Approval Batch Drill Down
window. This window will list all vendor payments on the left-hand side. By clicking on a vendor
payment, you will see a list of the vouchers contained in that payment on the right-hand side.
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5. To remove a voucher from the batch, unmark the box next to that voucher. The Reason for Rejection
window will open. You can type in a reason, or insert a Quick Reason (if Quick Messages have been
configured for the company you are working in.)

Please note, the voucher rejection will not appear on the Payment Batch Rejection report.!
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6. Click OK on the Reason for Rejection window, then OK on the Mekorma Batch Drill Down window
to save.

7. Rejecting a voucher will result in:
• The rejection reason will be attached to the note of the voucher (invoice) and the voucher will

return to an Open state.
• The user who originally requested approval on the batch will receive an email notification.
• When reviewing the voucher, if there are notes on both the Voucher and the Voucher Reject

table, two separate notes windows will appear when the Voucher Notes window is opened.

Last modified: Jun 19, 2023
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7.2.4.3. Review, Edit and Move Rejected
Payments
The navigation list allows you to see all the payments that were rejected during the approval process (and
subsequently placed in the MICR_REJECT batch). When Multi-Entity Management (MEM) is installed and
enabled, users can only review the pending approval payments in an entity to which they have access.

The Mekorma Rejected Payments navigation list allows authorized users to work with rejected payments in
the following ways:

1. Review all rejected payments: drill into payment details and reasons for rejection.

2. Drill into an individual payment by choosing the Edit Payment option: delete it entirely from the
MICR_REJECT batch, sending the payment vouchers back to Open status.

3. Move individual rejected payments into a new batch by choosing the Move Payment option.

Review Rejected Payments
To view the reason a payment was rejected:

1. On the navigation list, check the box next to a payment.

2. Click on Show Rejection Notes.
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To view payment / voucher details:

1. On the navigation list, check the box next to a payment.

2. Click on Payment Vouchers. A window will open to display all listed payments (top section). By
clicking on a payment, vouchers included in that payment will display in the lower section.

3. Double-click on a voucher to open the Payables Transaction Entry Zoom window for more details.

Edit Payments
You can open the GP Edit Payments window to view the rejected payment. You have the option to delete
the payment from the MICR_REJECT batch.

1. Select a payment and click Edit Payment. The Edit Payment window will open.
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2. Click Delete to remove the payment from the MICR_REJECT batch and all vouchers will be returned
to Open status.

Move Payments
From the Rejection navigation list, you can select one or more payments and move them out of the MICR
reject batch to existing payment batches for further processing.

Depending on the original payment method of each payment, you can move them to an EFT and/or a check
batch.

• Payments that were EFTs in the original (but rejected) batch can be moved to either a check or an
EFT batch. You will see a blue arrow icon on the Move Payments button to indicate the payments
being moved are all EFTs; both check and EFT batches will be available on the batch drop-down
menu.

• Checks can only be moved to a check batch, because the associated vendors may not be set up in
GP for EFT processing. If you choose check payments from the list, or a combination of check and
EFT payments, you will see a red information warning on the Move Payments button. The batch drop-
down will only display available check batches.
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• When a MEM payment has been rejected, those payments can only be moved to a batch associated
with the same entity. If the selected Payments have different Entity IDs, you will see an “X” icon on
the Move Payments button, and an error message will display.

Last modified: Jun 19, 2023
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7.2.5. Mobile Approvals with PowerApprovals
App
Approvers can perform their tasks outside of Dynamics GP using the PowerApprovals application. After the
system requirements have been met, and the necessary setup has been completed, designated Users can
perform approvals in PowerApprovals.

If you haven’t downloaded the PowerApprovals app yet, read Install PowerApprovals on your Mobile device
to install it.

These sections explain the daily use of Power Approvals:

1. Start the PowerApprovals App
2. Sort and Filter the Payment List
3. View Payment Details
4. Reject or Approve Payments

Last modified: Jun 19, 2023
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7.2.5.1. Start the PowerApprovals App
From your Mobile Device

Once the home screen loads, click Pending Approvals.
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Browser access

You can also launch from a browser. In this case you will be able to launch this directly from your
PowerApprovers email notification. You can also bookmark the site for future access.

Last modified: May 16, 2023
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7.2.5.2. Sort and Filter the Payment List
Payments pending approval will display, based on the Threshold assignments as configured with the
approval workflow. Depending on the filter in place, approvers will be able to see approvable transactions or
all transactions in the companies they have access to.

If MEM is installed and enabled, the Entity ID will appear on the main screen of the Power Approvals app.
You can filter the payments by entering the Entity ID in the search box.

Using the drop-down menu, you can choose to view payments for all companies, or on an individual
company basis.
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Click on the filter icon in the top right-hand of the screen to customize your view:

• Group By View All Transactions, Approvable Transactions, My Specific Transactions, or Batch
Number.

• Sort By Batch Number, Vendor Name, Vendor ID, Amount, or Transaction Number.
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7.2.5.3. View Payment Details
Please note, viewing payment details is optional. You can approve or Reject payments without drilling into
them. But if you would like to see the voucher details or the attached invoice images, this is the way to do it.

If MEM is installed and enabled, the Entity ID will appear on the main screen of the Power Approvals app.
You can filter the payments by entering the Entity ID in the search box.

First, click on the drop-down for an individual payment:

The payment detail screen will list all vouchers that make up that payment. In this example there is only one
voucher for this payment.
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If you’d like to see the transaction detail typed in Dynamics GP for an individual voucher, click on a
hyperlinked voucher number to open the Voucher Detail screen:

If a voucher has an invoice attached to it, that can be viewed by clicking on the attachment icon. Please
note, invoices in PDF and image formats will be accessible in the PowerApprovals app. For optimal
performance, please limit file attachments to 5mb or less. Larger files may cause disruptions and should be
avoided.
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Notice on the screen below, there is a drop-down list that shows the name of the attachment you are
viewing. If your transaction has multiple attachments, you can shift from one to the other using the drop-
down list.

Once you have looked at what you want and are back on the detail screen, you decide whether to select for
Approval or Rejection, or just go back to the payment list. If you check the box at the bottom of the screen, it
mark that payment and automatically bring you back to the Approval list to either reject or approve.

In addition to GP DocAttach, we currently support five additional external Document
Management systems. Contact our Customer Success team if you would like a quote for
integrating your invoice images to Power Approvals.
*
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7.2.5.4. Reject or Approve Payments
From the transaction list, check the transactions you want to Reject or Approve. Then, click Reject or
Approve at the bottom of the screen. Dynamics GP will be updated in real-time, and approval Requestors
will receive notifications so the batches can go on to be processed.

You can select multiple payments, or Mark All / Unmark All on the approval list to reject or approve as
needed.
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7.3. Process Payments

Payables Batches

After Creating Payment Batches and getting them Approved, the next step in the process is to Process
Payments. This could entail:

• Printing checks.
• Creating and sending EFT remittances.
• Sending your batches to an outsource provider.

Essentially it is the process of conveying payment instructions through one of these methods.

As part of your implementation process, start with Processing a Single Batch. This is important as a first
step to getting to know your system and testing that payments are working properly.

Once single batches are flowing well, move into the Action Board, where you can process all your batches
at once instead of one by one.

Other Payment Situations

In addition to supporting Payables Batch payments, the Mekorma Payment Hub also supports

• Payables Transaction Checks
• EFT Remittance Processing
• US Payroll Checks
• Canadian Payroll Checks
• Miscellaneous Checks

On occasion, you might also want to print a Blank Check for making a handwritten payment, such as if you
need a check to take off-site.

Last modified: May 16, 2023

Before processing payments—note that any change to your operating system, server, or
printer could cause printing variations. Please retest the formatting of your checks and the
MICR line before processing if you have altered your system configuration or peripherals in
any way.

!
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7.3.1. Process a Single Payment Batch
Processing a single AP payment batch within Mekorma Payment Hub is accomplished with the same steps
you would use for printing standard Dynamics GP payables batch checks. Mekorma has modified the
standard window to enhance the functionality using a Dynamics feature called an Alternate Window. This
Alternate window must be assigned to each user printing payables batch checks in the company, using the
Dynamics GP security system.

Once your batch is Built and Approved:

1. Open the Print Mekorma Payments window (Mekorma Area page > Transactions > Payables > Print
Payments).

2. Verify that the title of the window includes the words Mekorma. If not, abort the procedure and setup
security to the Alternate Print Mekorma Payments window.

3. Use the look-up to select the desired batch.

4. Once approved or authorized, the batch can be printed by clicking on Print. If you are not using the
Mekorma Payment Hub Action Board and you have more than one approval threshold set for a batch,
each sub-batch will need to be printed separately.

5. If you have set up your system to ask you for a print at run-time, the Mekorma MICR Check Printing

Print Payments also shows up as a shortcut within the Build Payment Batch or Edit
Payment Batch windows*

If you see the Request Approval as in the below, the batch must be approved before you
can process it.

!
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screen is displayed. Click Print to print checks. If you have setup automatic selection of printers, it will
simply print.

6. Once the checks have printed, you will be prompted to post, reprint or void the payments. Verify the
payments processed correctly before posting. For more information, refer to the Microsoft Dynamics
GP User Guide.

Outsourced Payments

If you are outsourcing your payments, the system will help you verify that the payments made it to the
outsource provider. See Processing an Outsourced Payments Batch for information.

Action Board Printing

Once you have your setup working for Processing a Single Payment Batch, the next step is to automate
all of your batches with the Mekorma Payment Hub Action Board.

Last modified: May 16, 2023
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7.3.2. Process an Outsourced Payments
Batch
Procedures for Process an Outsourced Payments Batch start just like processing any other single
payment batch. This topic provides additional information for outsourced payments.

Document numbering for Outsourced Payments

Each payment is processed in Dynamics GP as it normally is when printing checks or processing EFT
payments. A Document Number (“Check Number”) is assigned to each payment. The Document Number will
be the identifying Payment ID in your outsource provider portal, and will serve as a Reference Number when
the provider prints a physical check.

The Importance of the Security Approval Workflow

We highly recommend that you configure the secure approval workflow before sending to the outsource
provider. Just like you would want approvals before printing checks with automatic signatures—you would
want to make sure the payments have been approved before sending them electronically.

Verifying your Batch

After you click Print on the Print Mekorma MICR Payables Checks window, the Remote Payment
Services Batch Status window will open to display the batch status. Initially the status will read Batch
Check in Progress. GP is fully accessible while the system is processing.

When the provider has completed processing, the Remote Payment Services Batch Status window will
show “Batch is available to Post”. This verification is important—it completes the “handshake” with the
service provider to read a results file that shows that all the payment instructions were received intact. It’s
like making sure that none of the checks jammed in the printer before posting.
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Batch Splitting for Local Printing

If the original batch contained a blend of payments for vendors enrolled with the outsource provider, along
with vendors you have excluded to process locally, the Remote Payment Services batch will be split. An
underscore is added to the original batch name for the payments sent to the outsource provider. Local
payments will remain in the original batch. For example, in the screenshot above, the original batch name
was 10232. The payments sent to the outsource provider are now contained in a batch named 10232_.

Batch Splitting for Bulk Funding

• If the Remote Payment Services batch contains individually funded payments, it is released for
posting. The batch status description updates to Batch is available to post, and the status displays
as Processed.

• If the Remote Payment Services batch contains bulk funded payments (available with Corpay), the
batches will be split and processed in this way:

◦ Payments are moved to a new Credit Card batch – the associated credit card can be viewed in
the Remote Payment Services configuration window.

◦ This Batch ID will be the original batch name with a ‘_V’ suffix.
◦ In addition, a new payment is added to the original batch to pay the outsource provider.
◦ Batch_V is then released for further processing, and the batch status description updates to

Batch is available to post, and the status displays as Processed.

Posting the Batches

1. Batches can be posted by highlighting each batch and clicking on the Actions menu > Post in the
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Remote Payment Services Response Check Status window.

2. If the original batch included payments for vendors either not enrolled or set to Local Processing,
those payments will remain in the original batch and continue on to print from your local printer. The
Post Payments window will automatically open, and you can post those payments immediately, or at
a later time.

Last modified: Jun 19, 2023

To process multiple batches at once using the automation functionality of the Payment Hub
Action Board, see Action Board: Processing All Your Batches at Once.*
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7.3.3. Action Board: Process All Your Batches
at Once
The Action Board provides an ability to automate the printing and posting of payables batches across
multiple companies and checkbooks. Refer to Action Board Setup prior to processing from the Action Board.

Instead of needing to log in to each company separately, all batches can be viewed and selected for
processing within one window. Batches are further filtered out by the user’s access level. This means users
can only view and select batches from companies to which they have access.

1. Open the Mekorma Action Board (Mekorma Area page > Transactions > Payables > Mekorma Action
Board).

2. Select the action Process Checks and EFTs from the drop-down menu. This will display all batches
ready to be processed.

3. Choose the batches you would like to print/process by checking the box next to each batch. You can
choose to Mark All or Unmark All, or select each batch individually.

4. Click Process.

Last modified: May 16, 2023

Mekorma Mekorma Products User Guide for GP - Build x91_en

Copyright © 2022 Mekorma Enterprises. All Rights Reserved. Page 305 of 379



7.3.4. Action Board: Process Remote Payment
Batches

1. Open the Action Board (Mekorma Area page > Transactions > Payables > Mekorma Action Board).

2. Choose Process Checks and EFTs from the Action drop-down menu.

3. Select one or more fully approved batches and click Process. You can process batches that contain
payments for vendors enrolled in payment outsourcing, in addition to those not included in the
service. In the example above, batch DOCNO5 contains 3 transactions for enrolled vendors, and 1
transaction for an Excluded vendor.

4. The Action Board will then generate payment files (1 per batch) and send them to the outsource
provider, and those payments designated as local processing will print on your printer.

5. When all selected batches have finished processing – ie., outsourced payment files sent to the
provider platform and local payments printed – the Results Report will be available:
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As you can see, payments will be split into two separate batches: all locally processed payments
remain in the original batch; outsourced payments will move to a new batch that retains the original
name of the batch with an added underscore. In our example, DOCNO05_ is labeled ePayment:
Processed. If a batch only contains payments for enrolled vendors, the batch will not be split and the
remote payments will remain in the original batch.

6. The Remote Payment Services Batch Status window will also open to indicate the results as the
outsource portal communicates with Dynamics GP. When batches have completed processing on the
provider portal, the window response will update:

• If the Remote Payment Services batch contains individually funded payments, it is released for
posting. The batch status description updates to Batch is available to post, and the status displays
as Processed.

• If the Remote Payment Services batch contains bulk funded payments (only available if processing
with Corpay), the batches will be split and processed in this way:

◦ If you are running GP2015, payments are moved to a local Payments batch. The Batch ID will
be the original Batch ID with a ‘_V’ suffix.

◦ If you’re running GP2016+, payments are moved to a new Credit Card batch – the associated
credit card can be viewed in the Remote Payment Services configuration window.

▪ This Batch ID will be the original batch name with a ‘_V’ suffix.
▪ In addition, a new payment is added to the original batch to pay the outsource provider.
▪ Batch_V is then released for further processing, and the batch status description updates

to Batch is available to post, and the status displays as Processed.

7. After processing completes, the payment provider will analyze the batches and get them ready to pay
after the daily cutoff time. That process can be seen similarly to the process of printing checks in the
sense that you want to be sure that it completed successfully before posting. The Action Board blocks
posting until this verification process is complete. That gives you a chance to intervene for any errors
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occurred during that validation process before you post. Wait a few minutes and then use the “Update
Remote Payment Services Status” action. The Action Board will go to each company that processed
batches to confirm that the validation completed successfully before you post.

8. Both Remote Payment Services and locally processed batches can then be posted simultaneously by
choosing the Post Batches option on the Action Board.

Last modified: May 16, 2023

Mekorma Mekorma Products User Guide for GP - Build x91_en

Copyright © 2022 Mekorma Enterprises. All Rights Reserved. Page 308 of 379



7.3.5. Action Board with Pre-Printed Check
Stock
Action Board is designed to work without interruptions. Using pre-printed check stock would require
automated printing to stop between check runs for different companies, so that the correct starting check
number could be adjusted in GP. While we recommend using blank check stock as a best AP practice, this
feature will be useful for those of you who want efficient processing with Action Board automation but have
large amounts of pre-printed check stock to use up before transitioning to blank stock.

To use this feature for one or more companies, enable the ‘Use pre-printed check stock’ setting in the
Mekorma checkbook setup window. But don’t check Print Separate Remittances. Pre-printed check stock
with Print Separate Remittances cannot be used with the Action Board.

Indicators

The Action Board will identify batches that are to print on pre-printed stock with a yellow indicator. When it’s
time to print each of these batches, the Action Board will stop, and you will be prompted to enter the correct
check number. Once the check number is verified, the batch will print.
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Batch Selection Differences

When using pre-printed check stock, only batches from the same checking account may be printed together
in order to keep the check number synchronized between Dynamics GP and the check stock. These special
rules apply to the batch selection on the Action Board:

1. ‘Mark All’ only auto marks all the batches which do not use preprinted check stock.
2. ‘Unmark All’ works as normal.
3. Check batches using pre-printed stock must be selected manually. Once a batch is marked, it will

auto disable selection for

• Check batches using blank stock
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• EFT batches
• Batches using pre-printed stock on different checkbooks and other companies.

Process Differences

After clicking the Process button, a Check Number Setup window will open to confirm the next check
number. If ‘Over Check Number’ option is marked in GP Checkbook Maintenance, it allows to reset next
check number. Otherwise, the next check number field will be locked.
Then the regular action board process runs until it is completed.

Note that on the Check Number Setup, the Next Check Number cannot be changed unless Override Check
Number is selected on the GP Checkbook Maintenance window for that checkbook.
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7.3.6. Print or Email EFT Remittances
If you are printing EFT remittances, you can select the format for printing the remittances by entering an
option in the EFT Remittance Options field. The selected format is displayed in the Mekorma MICR Check
Printing screen when you print the remittances.

The same security parameters applied to your checks can also be applied to your EFT Remittances by
marking the EFT Security option.

Before printing EFT remittances, verify that you have completed the following processes:

• Enable EFT in Microsoft Dynamics GP.
• Configure a Checkbook for EFT.
• Set up pre-notes (if applicable).
• Configure a vendor for EFT (please see your Microsoft Dynamics GP documentation for more

information).
• Select a remittance format for each checkbook from which you will be printing EFT remittances.

To print EFT remittances after you have created an EFT batch:

1. Click the Process or the Print button in the Print Mekorma MICR Payables Checks window or open
the Process Payables Remittance window (Mekorma Area Page > Transactions > Payables >
Process Remittance).

2. Verify that Remittance Form is selected.

3. Click the desired Destination option – either Print Document or Send Document in E-mail.

4. Click Process. If sending the remittance via email fails for any reason, the remittance will be printed
instead.
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7.3.7. Changing your Check Date or GL
Posting Date

Last modified: May 16, 2023
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7.4. Miscellaneous Processing Scenarios
The topics in this section highlight specific optional features of the Mekorma Payment Hub:

• The Payment Hub supports printing special remittance formats for Refund checks arising from the
Dynamics GP SOP module.

• You can use the PDF Check Archive to continually export PDF copies of your checks to a hard drive
location, for example for inclusion in an external document management system.

• If you are using the Multi-Entity Management (MEM) module from Binary Stream, you can use
Mekorma MEM Connector to include MEM fields on your check.

• If you are setup for remote processing through one of our outsource service providers, you can still
make exceptions and print some checks yourself.

• if you are using the Dynamics GP Web client, there are some special procedures to follow when you
process.

• On occasion, you may also need to reprint a batch.

* Finally, you have the option to use the MICR functionality to print a check that you can fill in by hand if you
need to—we call these “.

Last modified: May 16, 2023
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7.4.1. Print Payables Transaction Checks
Transaction Check Printing Security Concerns

For transaction checks, our recommendation is that you don’t allow transaction check printing because
giving access to the same person to enter an invoice into the system and to cut a payment is a security
concern. Best practice recommends separation of duties. However, if you decide to allow it, the Security
Workflow rules still apply. For more information, see Setting Security rules for Transaction Checks.

If you do allow printing of transaction checks and have setup “security rules”, then only a user with Approval
permission for that checks payment amount will be able to print it and only if the check requires a single
approver or no approvers. If the check requires two approvers, it cannot be printed. The invoice must be
posted and added to a regular payment batch to go through the approval workflow.

Lastly, you will need to grant access to Mekorma alternate windows to print transaction checks.

To print a transaction check:

1. Open the Transaction Entry window and enter the invoice information.

2. To pay by check, click the arrow to the right of the Check Amount field. This will open the standard
GP Payables Check Entry window.

3. Choose the checkbook ID you want and click Actions > OK to close.

4. Back on the Payables Transaction Entry window, make certain all necessary transaction information
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has been entered and click Print Check at the bottom of the window.

5. The Print Mekorma MICR Transaction Check window will open. Click Print.

6. Verify that the title of the window includes the words Mekorma. If not, abort the procedure and setup
security to the Alternate Print Mekorma MICR Transaction Check window.

7. If you have setup your system to ask you for a print at run-time, the Mekorma MICR Check Printing
screen is displayed. Click Print to print checks. If you have setup automatic selection of printers it will
simply print.

Last modified: May 23, 2023
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7.4.2. Print Miscellaneous Checks
The Dynamics GP Miscellaneous Check feature allows you to print a check to any entity without creating the
entity as a vendor. Mekorma Payment Hub uses the Dynamics GP Miscellaneous Check screen, but
intercepts the check printing process and prints the checks using the Mekorma Payment Hub check format
assigned to the checkbook.

Unlike payables batch checks, payables transaction checks and payroll checks, there is no alternate window
for Miscellaneous Checks when using Mekorma Payment Hub and no security settings are available. If
Mekorma Payment Hub is installed and registered, Miscellaneous Checks print using Mekorma Payment
Hub. However, the Miscellaneous Checks will not come out signed.

If you do not want to use Mekorma Payment Hub to print Miscellaneous Checks, you can turn off this
feature by checking the “Payables” box on the Mekorma Payment Hub Suppress Warnings screen.

To print a Miscellaneous Check:

1. Open the Miscellaneous Check window (Mekorma Area Page > Transactions > Financial >
Miscellaneous Check).

2. Enter values in all required fields.

3. Click Print Check and Post.
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4. After entering any required User IDs and/or Passwords, the Mekorma Payment Hub Check Printing
window will open.

5. Click Print.

Last modified: May 16, 2023
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7.4.3. Print Refund Checks
To print a refund check with Mekorma Payment Hub, follow the standard GP processes to create the
return(s). If you need help configuring refund check formats, please see this page.

1. Open the Mekorma Payment Hub Payables Checks window (Mekorma Area page > Transactions >
Payables > Print Payments) and bring up the refund check batch.

2. Click Print from the Print Mekorma Payments window.

3. If your system is configured to request a printer at print time, this will open the Mekorma Check
Printing window. Note that the Refund Check Stub format will not be displayed in the Check Stub field
but the system will replace the format with the refund format when you print (or preview) checks.

4. Click Print to print checks or Preview to preview the checks before printing. After printing, the Post
Payments window will open.

5. Click Process to post the checks.

Last modified: May 16, 2023
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7.4.4. Print Check Copies to PDF
Some Mekorma customers like to feed PDF check copies into their external document management system.
If you have this feature configured, automatic check copies will be generated on your hard-drive when you
print. PDF Check Copies follow the standard Mekorma Payment Hub check copy rules, which is that they
do NOT display the MICR line, signatures or signature lines.

Check copies will be generated wherever the Payment Hubs generates payments:

• Payables Batch Checks
• Payables Transaction Checks
• US Payroll Checks
• Canadian Payroll Checks
• Miscellaneous Checks

To view PDFs:

1. After posting, if you would like to see the check copies, navigate to the folder location defined for the
PDF check copies on the Mekorma System Options screen.

2. Open the PDF file.

Last modified: May 16, 2023

Read Setting up Check, Check Remittance Copies and EFT Remittances to learn more
about this feature and learn how to configure it.*
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7.4.5. Print Using the MEM Connector
You can print batches using the MEM Connector from GP’s Build Payment window, where you can select
whether to Centralize or Decentralize the process. The configuration for Sorting and Subtotal options will
effect the results as follows:

Setup Options
Print
Category

Print Results

No Sort, No
Subtotal

Decentralized Prints one line only for ID and name; prints facility address; no check sorting

No Sort, No
Subtotal

Centralized No MEM fields print, no sorting

Sort by ID, No
Subtotal

Decentralized Sorts checks by Facility ID, no Facility fields print

Sort by ID, No
Subtotal

Centralized
Sorts vouchers on stub by Facility ID; sorts checks by Facility ID; Facility ID
and Name print on the stub

Sort by Name,
No Subtotal

Decentralized Sorts checks by Facility Name; no Facility fields print; no subtotal line

Sort by Name,
No Subtotal

Centralized
Sorts vouchers on stub by Facility Name; sorts checks by Facility Name,
Facility ID and Name print on the stub; no subtotal line

Subtotal By ID,
No Sort

Decentralized
One subtotal line prints since only one facility is on the check; checks are
not sorted

Subtotal By ID,
No Sort

Centralized
Vouchers are sorted on the stub by Facility ID with a subtotal line at the end
of each Facility group; checks are not sorted

Subtotal By
Name, No Sort

Decentralized
One subtotal line prints since only one facility is on the check; checks are
not sorted

Subtotal By
Name, No Sort

Centralized
Vouchers are sorted on the stub by Facility Name with a subtotal line at the
end of each Facility group; checks are not sorted

Subtotal By
Name, Sort by
Name

Decentralized
One subtotal line prints since only one facility is on the check; checks are
sorted by Facility Name

Subtotal By
Name, Sort by
Name

Centralized
Vouchers are sorted on the stub by Facility Name with a subtotal line at the
end of each Facility group; checks are sorted by Facility Name

Subtotal By ID,
Sort by ID

Decentralized
One subtotal line prints since only one facility is on the check; checks are
sorted by Facility ID
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Subtotal By ID,
Sort by ID

Centralized
Vouchers are sorted on the stub by Facility ID with a subtotal line at the end
of each Facility group; checks are sorted by Facility ID

Batches configured using the MEM Connector can also be printed and processed from the Multi-Batch
Action Board.

Last modified: May 16, 2023

Please note, MEM Connector fields will not be displayed on a test check. You must print an
actual check in order to test.

!
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7.4.6. Exceptions for Remote Payments--Local
Printing Options
When using Mekorma Remote Payment Services to send your payments to a service provider, there may be
times when you want to override the system to process certain payments locally.

The following topics explain the configuration settings for making exceptions:

• Add Checkbooks for Remote Payments explains how the company and checkbooks get set up initially
for sending to a remote payment service.

• Vendor Enrollment explains how vendors get enrolled in outsourcing initially and ongoing.
• Local Printing Options explains how you can make exceptions on a vendor or payment level or turn off

a company or a checkbook

In addition, some payments are always processed locally:

• If you use Transaction Check printing (from the Payables Transaction Entry window), which is also
called “Check on the fly,” these checks will print locally. This must be done at the point of invoice
entry and before it is posted.

• If you create an EFT or Credit Card batch in Dynamics GP Payables, those batches will be processed
locally.

Last modified: May 16, 2023
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7.4.7. Print Payments Using the Web Client
These instructions apply to printing within the Dynamics GP Web Client, assuming the Mekorma Print Client
has been installed and the user who needs to print has been granted security access to the Web Client.

1. Open the Print Payments window.

2. Use the look-up to select a batch.

3. The Mekorma MICR Web Client Print Job Preparation window will open. From within this window,
you can change your check or remittance format for check printing as needed.

4. Click the Prepare and Download button to open the Mekorma Print Client. (this assumes you have
configured your browser to automatically launch the downloaded mcp file).

5. The Mekorma Print Client allows you to preview and print check files in the same way that you would

https://www.youtube.com/embed/_nQVFo2Uwnk?rel=0

https://www.youtube.com/embed/_nQVFo2Uwnk?rel=0&start=208&end=314

https://www.youtube.com/embed/_nQVFo2Uwnk?rel=0&start=314&end=345

https://www.youtube.com/embed/_nQVFo2Uwnk?rel=0&start=346&end=474
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handle them through the GP desktop application. You can:
• Select whether you would like to print check copies.
• Choose to navigate to the next check batch. If you select to navigate to the next batch, you will

be prompted with a question asking if you want to delete the Mekorma Check Print (or .mcp) file
that accords to the batch that you are currently on. To print the batch that you’ve skipped at a
later date, generate another .mcp through the print process.

• Select to print to any local printer, or any remote printer (if you are connected to your network
through a VPN).

Last modified: May 16, 2023
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7.4.8. Reprint Checks
The Microsoft Dynamics Post Payments window is used to reprint checks. You can reprint all checks or a
selected range of checks.

1. Open the Post Payments window (Mekorma Area Page > Transactions > Payables > Post
Payments).

2. Set the Process field drop-down list to Reprint Payments.

3. Select a range for reprinting checks. Click the lookup icon on the From option to display a list of
checks.

4. Enter a check range and click Process to reprint the checks.

Last modified: May 16, 2023
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7.4.9. Print Blank Checks
On occasion, you might want to print a Blank Check for making a handwritten payment, such as if you need
a check to take off-site.

Blank checks are not posted to the General Ledger when they are printed. To record them, they must be
entered later as manual payments. Though the blank checks are not recorded at the time of printing, if the
default starting check number is used, the Next Check Number field for the checkbook will be advanced by
the number of checks printed. This can lead to missing check numbers if one or more of the blank checks
are never entered as manual payments.

To avoid this, change the starting check number for the blank check batch. This prevents the Next Check
Number from advancing. When printing blank checks, only one check Approver is required, but the approver
must be assigned to the checkbook you are printing the blank checks from.

1. Open the Print Blank Checks window (Mekorma Area Page > Transactions > Payables > Print Blank
Checks).

2. Enter the Checkbook ID and the Number of Checks you would like to print. If desired, enter a
different Starting Check Number for the batch of blank checks you plan on printing.

3. Select the number of Signature lines to print on each check. Signature lines are blank lines upon
which a signature can be written.

4. Click Print. After entering any required User IDs and/or Passwords, the Mekorma MICR Check
Printing window will open.

Some clients consider this a security risk. This feature can be disabled.!
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5. Enter your print settings and click Print when you are ready to print checks.
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7.5. Inquiries and Routines
There are a number of ways to make inquiries on payments/batches processed by the outsource provider.
Additionally, depending on the status, certain actions will be available to further or complete processing if an
issue arises.

Some common inquiries will need to be made in the outsource provider’s portal; certain actions (like voiding
a batch) must be done in both the payment portal and within Dynamics GP.

Last modified: May 16, 2023

Mekorma Mekorma Products User Guide for GP - Build x91_en

Copyright © 2022 Mekorma Enterprises. All Rights Reserved. Page 330 of 379



7.5.1. The Check Image Archive
The Check Image Archive feature allows you to view and print an image of a posted check/EFT remittance
from the following Payables, US Payroll and Canadian Payroll windows:

• Payables Payments Zoom
• Payroll Check Inquiry
• Payroll Transaction Inquiry
• Canadian Payroll Inquiry
• Miscellaneous Check Inquiry

The Check Image Archive archives using the format specified in the Copy Stub field of the Mekorma
Payment Hub Check Printing screen at the time the check was printed. If no format was specified in the
Copy Stub field, the format in the Check Stub field will be used.

For security, check copy images do not display the MICR Line, Signatures, or Signature Lines. They also
contain the word VOID.

Access the Check Image Archive from Dynamics GP inquiry windows

1. From the Mekorma Area Page, go to Inquiry > Payables > Transaction by Vendor or Transaction
by Document.

a. If selecting Transaction by Vendor, enter a vendor ID in the field or choose one from the
dropdown menu by clicking on the magnifying glass icon, then choose Select.

b. If selecting Transaction by Document, enter a range of document numbers in the “From” and
“To” fields, then click Redisplay. Clicking Redisplay without entering a range of document
numbers will display all documents.

2. Choose the applicable vendor, highlight the check number you want to zoom to, and click the
Voucher/Payment Number or Document Number hyperlinks.

3. The Zoom window will display with the check image automatically located to the right. Or, if automatic
display is disabled, select Additional > Show Inquiry Check Preview to display the check/
remittance image.

Note that transactions processed before Mekorma was installed will not have images
available.

!

For instructions on how to disable this feature or change the auto-display the check
preview setting, see Setting up Check, Check Remittance Copies and EFT Remittances.*
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4. To print the check/ remittance image, click the Print icon on the toolbar.

Access the Check Image Archive from the Mekorma Audit Log

The Check Image Archive can also be accessed directly from the Mekorma Audit Log.

1. Open the Mekorma Audit Log (Mekorma Area Page > Inquiry > System > Audit Log).

2. Select the appropriate batch, using the filters as needed.

3. Click on the Number of Checks link.

4. Select the check or EFT payment you would like to view, and click on the Payment Number link.

5. As above, the Zoom window will display with the check image automatically located to the right. Or, if
automatic display is disabled, select Additional > Show Inquiry Check Preview to display the check/
remittance image.

Last modified: May 16, 2023
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7.5.2. Track Payment History with the Audit
Log Report
The Audit Log report records the details of posted check/ EFT batches, including the Approvers/
Authorizers of each batch. This feature provides an added layer of security when processing payments with
Mekorma.

1. Open the Mekorma MICR Audit Log Report window (Mekorma Area Page > Inquiry > System >
Audit Log).

2. From here, you can filter your results in the following way:

• Use the Sort By drop-down list options to filter the list, then click Redisplay to view the new sort
order.

• Use the radio buttons at the top of the screen to filter on Checkbook ID, Batch ID, or Posting Date.
• Click the Print button to view the Check Audit Log Summary report.

https://www.youtube.com/embed/aV_lONtVQLM?rel=0&start=194&end=352

https://www.youtube.com/embed/aV_lONtVQLM?rel=0&start=194&end=352

https://www.youtube.com/embed/aV_lONtVQLM?rel=0&start=431&end=490
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• To drill down to check batch detail, highlight a line item and click on the No. Checks column
hyperlink. This will open the Mekorma MICR Audit Detail Log window and the details from the
selected check batch are displayed. Click the Print button to select the Check Audit Log Detail report.
Only batches currently selected are displayed on the report.

Last modified: May 16, 2023

Please note, reprinted checks will display as zero dollar checks.*
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7.5.3. Payment Inquiry
You can view all payments that have been processed by the outsource service within the Remote Payment
Services Payments window.

1. Open the Remote Payment Services Payments window (Mekorma Area Page > Routines >
Payables > Remote Payment Services Payments) to view all posted payments that have been
processed by the outsource provider. Use the filters in the upper section of the window to create a
customized view. Filters include: Checkbook ID; Payment Date; Vendor ID; Expiration Date;
Remaining Balance; Payment Method; and Card Status.

2. The following information displays:
• Payment Method: Shows the method the outsource provider used to pay the vendor. For the

most accurate and up-to-date information, please refer to the payment information in the
provider portal.

• Payment Amount: This is the amount received by the outsource provider portal (equals the
amount processed in GP).
The additional columns support a legacy version of Mekorma Remote Payment Services.

3. Click on a payment and then use the Actions drop-down menu to get a list of actions that are
available to perform on that payment. For any payment listed, you will have the ability to View by
Payment or View by Vendor, which will take you to the standard Dynamics GP inquiry windows.

Last modified: May 16, 2023
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7.5.4. Batch Inquiry
Any batch that has been created and sent to the outsource provider can be accessed from the Remote
Payment Services Batches (Batch Maintenance) window. From this window, you can filter your view based
on the status of the batch, Batch Number, Remote Batch ID (found in the provider’s portal) and Created
Date.

Depending on the batch’s status, certain actions can be performed.

Batch Status

Batches can have the following File Status:

• Created: when the Print button (on the Print Payments window) or Process button (on the Action
Board) is first clicked to send a batch, a local record is created; you will probably never see a batch in
this status as it is sent to the outsource provider platform almost immediately.

• Sent: The batch has been created and sent to the provider for processing; the provider has not yet
sent a response back to Dynamics GP.

• Processed: The batch has been sent to the outsource provider portal and the portal has
communicated back to Dynamics GP; Mekorma has created all associated records in GP.

• Posted: Finish the process in GP, batch will be posted
• Validation Failed: The batch could not be sent to the portal because of missing or incorrect

information, or it was rejected by the outsource provider; you can resend the file for processing using
the Action menu.

• Abandoned: The batch has been deleted out of GP; this would be a very rare circumstance.
• Voided: The batch has been voided in Dynamics GP; you must confirm it has also been voided in the

outsource provider portal.
• Sending Failed: In this case, you can send the batch again and the system will try to call the API

again; this may be necessary if internet was unavailable on the first send.
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Batch Actions

When you click on an individual batch, it will show the status and give you actions that can be performed on
that batch in the Actions drop-down menu

• Void: If a batch is in Sent status, but it doesn’t work in the portal or didn’t reach the portal, you can
come here to void the batch. Only batches in a Sent status can be voided – be sure to first void the
batch in the outsource provider portal.

• Reprocess
• Resend
• Post

Last modified: May 16, 2023
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7.5.5. Handling Stop-Pays and Voids for
Outsourced Payments
Overview

From time to time, errors occur and you may want to do a “Stop-Pay” on a payment sent out through MEEP.
This guide was written to help you determine how to handle those void payments both with our outsource
provider and within Dynamics GP.

Note that this guide only pertains to cases where you are in contact with the Vendor and want to correct an
error on the Vendor account. This is not a situation of unclaimed funds but rather an error situations. We
have a different guide that you should use when a vendor doesn’t cash their payment and doesn’t respond
to repeated contacts. Please see Handling Returned Outsourced Payments.

Void Scenarios

Voiding payment because of the invoice

1. Accidentally double enter and double pay an invoice

2. Accidentally enter wrong information on an invoice

3. Entered invoice on wrong vendor ID

Voiding payment because of the payment

1. Payment is stale

2. Wanted different payment method

3. Incorrect spelling on payee name

Accounting for Void Scenarios

1. Vendor account accurately reflects their total invoice amounts less return amounts and you can
always see their total number of transactions and accurate transaction volume

2. Vendor account accurately reflects their balance of outstanding amounts due or credits

3. GL accurately reflects on the AP and cash accounts

4. Bank rec accurately reflects the payment funding transactions and any returned payment funds
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Voiding Payments with MEEP

Voiding Payments in GP is needed if you have had to issue a “Stop-Pay” on an uncashed payment and you
want to reissue, or correct an error and then reissue. The process is as follows:

1. Register a “Stop-Pay” with the outsource provider

2. Receive the Refund from the outsource provider

3. Account for the incoming cash for the returned payment

4. Correct the error and reissue

Register a “Stop-Pay” with the Outsource Provider

Contact your outsource provider using their designated customer services procedures to request a Stop-
Pay. Once you have received confirmation that the Stop-Pay was successful, it is safe to proceed with the
additional procedures here.

Once you have confirmed the stop-pay, you would also want to account for the Stop-Pay on the GP side.

Account for the incoming cash for the returned payment

You cannot use standard void procedures when you receive your refund. This is because the original
payment was funded to the outsource provider and it cleared your bank. If you were to void it, it would
wreak havoc on your bank reconciliation.

The way to handle this situation is similar to a situation where you paid a vendor by check, they cashed the
check and then discovered an error and refunded it to you. This article on Recording Vendor Refunds
written by ACE Microtechnology explains what to do if you encounter this scenario. This is standard
Dynamics GP use and does not vary based on the payment funding method.

Last modified: May 16, 2023
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7.5.6. Handling Returned Payments When the
Vendor Won’t Respond
Overview

From time to time, vendors do not cash their checks. This was written to help a client determine how to
handle these returned payments and the differences of handling them in Dynamics GP with and without
MEEP.

Uncashed Payments and Vendor Doesn’t Respond

If your service provider cannot get in touch with the vendor to clear the payment within a certain amount of
time (varies by service provider), the payment amount will be returned with a notification to your AP
department of the vendor, payment date, payment reference (i.e. check number) and payment amount.

As you may know, states require diligence in getting your payments to your vendors. Most have passed
“Unclaimed Property” laws. This process is called escheatment which is defined as follows:

• When money lies dormant in a deposit account or appears to be abandoned, the bank or other
organizations with which the money was deposited aren’t necessarily allowed to just keep that money
for their own use. After a period of time, they’re required to turn it over to the state. This is called
escheatment.

From the Journal of Accountancy:

• WITH MORE STATES CONDUCTING AUDITS, CPAs need to encourage companies to pay greater
attention to their unclaimed property liability. This includes both reporting unclaimed assets to the
right state and making sure the company properly reflects the liability on its balance sheet.

• UNCLAIMED PROPERTY HOLDERS MUST exhaust all options to locate the property’s rightful owner
before determining to which state they should report the assets. Companies should have policies and
procedures in place to track potential unclaimed property and comply with the applicable state
reporting requirements.

For more information, see Unclaimed Property.

Note that this guide pertains to cases where the vendor is non-responsive and you need to
treat this as an unclaimed payment. We have a different guide for when you are in contact
with the vendor and need to Stop-Pay a payment and void to correct and error and reissue.
Please see Handling Stop-Pays and Voids for Outsourced Payments.

*
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AP Processes for Unclaimed Payments When You are Paying them Yourself

In the AP department, the most common reasons that unclaimed properly can occur is from uncashed
checks or returned ACHs. Most accounting departments will find out about these when they do their bank
reconciliation. There will be an outstanding check in Dynamics GP that does not show cleared by the bank.

Seeing the outstanding check is the normal trigger for contacting the vendor to find out if their contact
information has changed and trying to get them their payment.

How to Track Returned Payments When You are Sending Payments Thru a
Service Provider (Outsourcing)

The difference when you have a service provider pay on your behalf is that the payments all clear the bank
the day they are funded. So you will never see a payment that didn’t clear. The service provider will be the
one that notices on their bank statement if something doesn’t clear.

The service provider will repeatedly attempt to contact the vendor, however, after a certain number of
attempts and time elapses, they will return the payment amount to you with identifying information. This is
the key difference. Instead of seeing the outstanding checks on your bank statement, you will use these
notifications to trigger your contact to the vendor.

In addition to contacting the vendor, the question remains: how should these returned payments be tracked
in the accounting system? These amounts should be booked by JE to a GL account set aside for
“Unclaimed Funds”. The JE should reference back to the original vendor and transaction that was returned.

You should then contact the vendor and try to resolve it. Once you know what the vendor wants to do, you
can void and resubmit payment and JE the money for that payment from “Unclaimed Funds” back into cash
with a reference to the resolution.

You will need to maintain a ledger of transactions in the “Unclaimed Funds” GL account so you can identify
transactions that have never been actually sent to your vendors. This ledger will serve 2 purposes:

1. Continuing to make a good faith effort to communicate with your vendors.

2. Once the transactions pass a certain state-specific time period (anywhere from 1-5 years), you will
need to submit this money to the state. When you are ready to do that, you will transfer the liability to
cash to clear it from your “Unclaimed Funds” account and pay the state to clear it out of cash.

References

These articles have additional information and advice for how to handle these issues.
Weekly Dynamic: Escheat/Unclaimed Property in Dynamics GP – DynamicAccounting.net
Escheatment and unclaimed property procedures in Microsoft Dynamics GP | RSM Technology Blog
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7.5.7. Void Remote Payment Batches for a
Processing Error
On occasion, a batch may not have successfully processed on the outsource provider’s portal, and will need
to be voided.

The batch must FIRST be voided in the provider’s portal, then in Dynamics GP.

Step 1: Void in your outsource provider’s portal

Please login to your outsource provider portal (AvidXchange (AvidPay) or Corpay portal), locate the batch
and Void.

Step 2: Void in Dynamics GP

1. Open the Remote Payment Services Batch Maintenance window (Mekorma Area Page > Routines
> Payabales > Remote Payment Services Batches).

2. Use the drop-down menu to view batches with a status of Sent, or by searching for the GP Batch
Number/ Remote Batch ID.

3. Click on the batch you want to void.

4. Choose Action > Void.

Last modified: May 16, 2023

Be sure you are voiding the entire batch, and NOT an individual payment. Mekorma
currently only supports voiding outsourced payments at the batch level.

!
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7.5.8. Change status of a virtual credit card
payment
In rare cases, a payment made by virtual credit card may be unresponsive or “stuck” in the provider’s portal.
In that instance, a GP user assigned with the Mekorma MEEP Admin security role can change the
status of that virtual card payment within Dynamics GP.

Please note: this action does not handle any adjustments that need to be made from an accounting
perspective.

1. Open the Enhanced ePayment Payments window (Mekorma Area page > Routines > Payables >
Enhanced ePayment Payments).

2. Select the virtual card payment you want to change. Set the Payment Method filter to Vcard to display
only those payments.

3. Click on Actions > Change Status to open the Enhanced ePayment Vcard Status Maintenance
window.

4. Use the New Status drop-down to select the appropriate status:
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Options are:
• Issued: This means the card has been issued by the virtual card company and sent to the

vendor, but the vendor has not yet “swiped” it.
• Used: A used card signifies that the vendor has received and “swiped” the card, but not for the

fully issued amount.
• Drained: means the virtual card has been used by the vendor for its fully issued amount, or the

vendor has used a partial amount and the remainder has been written off.
• Voided indicates a card that has been voided and is no longer active.

5. Confirm your choice and the new status will appear in the Status column.

Last modified: May 16, 2023
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8. Using Mekorma Payment Hub for US and
Canadian Payroll

Last modified: May 16, 2023
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8.1. Authorize Payroll Batches
If Authorization has been configured for Payroll, a Mekorma Authorizer(s) must be designated to Build,
Calculate and Print Payroll Checks. No one will be able to do this unless they have been assigned the Batch
Authorizer Task ID.

Last modified: May 16, 2023

Mekorma Mekorma Products User Guide for GP - Build x91_en

Copyright © 2022 Mekorma Enterprises. All Rights Reserved. Page 347 of 379



8.2. Print US Payroll Checks and Direct
Deposit Remittance
You are ready to print US Payroll checks after the following steps have been completed:

1. Create a US payroll batch using the standard Microsoft Dynamics GP procedures.

2. Build and calculate your checks.

To Print:
1. Open the Print Mekorma US Payroll window (Mekorma Area page > Transactions > Payroll > Print

Checks).

2. Verify that the title of the window includes the words Mekorma. If not, abort the procedure and set up
security to the Alternate Mekorma US Payroll window.

3. For Direct Deposit, select the Calculate Employee Deposits option for the Process field.

4. Click Process to process the Direct Deposits. After calculating the Direct Deposits or if you are not
running Direct Deposits, from the Print Mekorma US Payroll screen, select a sort order using the
Sort Checks By drop-down list.

5. If desired, change the Starting Check Number and Check Date. To change the Starting Check
Number, the Override Check Number option on the Checkbook Maintenance screen must be
selected.

6. Verify the Print field is set to Checks and click Print.

7. Click Print to proceed. After entering any required User IDs and/or Passwords, you see the Mekorma
MICR Check Printing screen.

8. Define your print settings and click Print when you are ready to print checks.

Last modified: May 16, 2023

Checks will be numbered after being sorted in the order specified in the drop-down list.
However, if checks are being printed in threshold groups, they will be grouped after being
numbered so the checks will not print sequentially by number. For this reason, threshold
group sorting cannot be used with pre-printed checks.

!
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8.3. Print Canadian Payroll Checks

You are ready to print Canadian Payroll checks after the following steps have been completed:

1. Create a Canadian payroll batch using the standard Microsoft Dynamics GP procedures.

2. Build and calculate your checks.

3. Open the Payroll Cheque Reports – Canada dialog box (Mekorma Area page > Reports > Payroll –
Canada > Transactions > Cheque Reports).

4. Enter any required User IDs and /or passwords.

5. On the Mekorma MICR Check Printing screen, confirm that the Check Printer is the printer you want
to use. If not, select another printer from the drop-down list.

6. Click the Print to print checks.

7. Click OK to proceed. The Mekorma MICR Check Printing screen is displayed again with the Check
Stub defaulting to the stub you entered in the Earnings Statement field on the Mekorma Checkbook
Setup (Payroll – Canada) screen.

8. Click Print to print Direct Deposits.

Last modified: May 16, 2023

The check numbering system for Canadian Payroll checks is configured on the Payroll
Control Setup – Canada screen, not the Checkbook Maintenance screen.*
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8.4. Inquiry and Routines for Payroll
Last modified: May 16, 2023
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9. Requesting Support, Implementation or
Customization
We are here to help!

If you are having a specific issue with your Mekorma products and require assistance from our Customer
Success Team, please log in to our online portal and open a new case.

• Technical Support is included with your yearly enhancement plan (for users on a supported version of
Dynamics GP). Open a support case.

• Implementation Support is available to help you prepare, install or configure any aspect of Mekorma
Payment Hub.

• Customization Support is available if you want to go beyond the built-in feature set of our product.
• Automation Support is available through our Power Platform support team.

Last modified: May 16, 2023
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10. Appendix: About This Window
This “About This Window” section is activated when a user chooses “About This Window” on a Mekorma
window in the Microsoft Dynamics GP help system. Each of the pages in this appendix gives an overview of
the use and fields of each of the Mekorma windows.

Last modified: May 16, 2023
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11. Appendix 2: Mekorma Configurator Fields
This appendix lists all the fields available in the Mekorma Configurator.

Legend:

ST: single text field

SC: single currency field

MT: multi-lined field

MD: multi-Date field

MN: multi-number

LB: label

PF: logical field

OV: overflow

MC: multi-Currency

MTR: multi-Amount in Words

SIG: signature

CATEGORY: General Information

Approver 1   ST   Width= 100   Align= L
Approver 2   ST   Width= 100   Align= L
Bank Account Number   ST  Width= 100  Align= L
Bank Address   MT  Width= 100  Align= L
Bank Branch   ST  Width= 100  Align= L
Bank Fax Number   ST  Width= 100  Align= L
Bank ID   ST  Width= 100  Align= L
Bank Master Transit Number   ST  Width= 100  Align= L
Bank Name   ST  Width= 100  Align= L
Bank Phone 1   ST  Width= 100  Align= L
Bank Phone 2   ST  Width= 100  Align= L
Bank Phone 3   ST  Width= 100  Align= L
Check Comment 1   ST  Width= 100  Align= L
Check Comment 2   ST  Width= 100  Align= L
Check Comment 3   ST  Width= 100  Align= L
Checkbook Description   ST  Width= 100  Align= L
Checkbook ID   ST  Width= 100  Align= L
CM User Defined 1   ST  Width= 100  Align= L
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CM User Defined 2   ST  Width= 100  Align= L
Company Address   MT  Width= 100  Align= L
Company Contact   ST  Width= 100  Align= L
Company Fax Number   ST  Width= 100  Align= L
Company Location Name   ST  Width= 100  Align= L
Company Name   ST  Width= 100  Align= L
Company Phone 1   ST  Width= 100  Align= L
Company Phone 2   ST  Width= 100  Align= L
Company Phone 3   ST  Width= 100  Align= L
GL Posting Date   SD  Width= 100  Align= L
Printed By   ST  Width= 100  Align= L
Requester   ST  Width= 100  Align= L
Transit Number   ST  Width= 100  Align= L
User ID   ST  Width= 100  Align= L

CATEGORY: Commonly Used Labels

AMOUNT   LB  Width= 0  Align= L
Amount   LB  Width= 0  Align= L
Canadian Funds   LB  Width= 0  Align= L
Check Date   LB  Width= 0  Align= L
CHECK NO   LB  Width= 0  Align= L
Cheque Date   LB  Width= 0  Align= L
CHEQUE NO   LB  Width= 0  Align= L
Date   LB  Width= 0  Align= L
DATE   LB  Width= 0  Align= L
DDMMYYYY   LB  Width= 0  Align= L
Description   LB  Width= 0  Align= L
Description Reference   LB  Width= 0  Align= L
Discount Taken   LB  Width= 0  Align= L
Dollars   LB  Width= 0  Align= L
GL Account Number   LB  Width= 0  Align= L
Invoice Date   LB  Width= 0  Align= L
Invoice Number   LB  Width= 0  Align= L
MMDDYYYY   LB  Width= 0  Align= L
Net Check Amt   LB  Width= 0  Align= L
Net Cheque Amt   LB  Width= 0  Align= L
Net Paid Amount   LB  Width= 0  Align= L
Net Paid Amt   LB  Width= 0  Align= L
ORDER OF   LB  Width= 0  Align= L
Outstanding Amt   LB  Width= 0  Align= L
Paid Amount   LB  Width= 0  Align= L
Pay   LB  Width= 0  Align= L
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PAY   LB  Width= 0  Align= L
Pay to the Order of   LB  Width= 0  Align= L
Payee   LB  Width= 0  Align= L
Payment Number   LB  Width= 0  Align= L
PO Number   LB  Width= 0  Align= L
TO THE   LB  Width= 0  Align= L
to the Order of   LB  Width= 0  Align= L
US Funds   LB  Width= 0  Align= L
Voucher Amount   LB  Width= 0  Align= L
Voucher Number   LB  Width= 0  Align= L
Write Off   LB  Width= 0  Align= L
YYYYMMDD   LB  Width= 0  Align= L

CATEGORY: Logical Fields

EFT Comment   ST  Width= 100  Align= L
EFT Logo   PF  Width= 100  Align= L
EFT Non-Negotiable   ST  Width= 100  Align= L
EFT VOID   ST  Width= 100  Align= L
Facility Signature 1   PF  Width= 100  Align= L
Facility Signature 2   PF  Width= 100  Align= L
Line 1   SIG  Width= 100  Align= L
Line 2   SIG  Width= 100  Align= L
Continued   OV  Width= 0  Align= L
Signature File 1   PF  Width= 100  Align= L
Signature File 2   PF  Width= 100  Align= L
Signature File 1 Based on PO Number   PF  Width= 100  Align= L
Signature File 2 Based on PO Number   PF  Width= 100  Align= L
Signature Line 1 Based on PO Number   SIG  Width= 100  Align= L
Signature Line 2 Based on PO Number   SIG  Width= 100  Align= L
Company Logo   PF  Width= 100  Align= L

MEKORMA PAYABLES

CATEGORY: Detailed Addresses

Bank Address 1   ST  Width= 100  Align= L
Bank Address 2   ST  Width= 100  Align= L
Bank Address 3   ST  Width= 100  Align= L
Bank City-State-Zip   ST  Width= 100  Align= L
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Bank Country   ST  Width= 100  Align= L
Company Address 1   ST  Width= 100  Align= L
Company Address 2   ST  Width= 100  Align= L
Company Address 3   ST  Width= 100  Align= L
Company City-State-Zip   ST  Width= 100  Align= L
Company Country   ST  Width= 100  Align= L
Payment Address 1   ST  Width= 100  Align= L
Payment Address 2   ST  Width= 100  Align= L
Payment Address 3   ST  Width= 100  Align= L
Payment Address ID   ST  Width= 100  Align= L
Payment City-State-Zip   ST  Width= 100  Align= L
Payment Contact   ST  Width= 100  Align= L
Payment Country   ST  Width= 100  Align= L
Payment Zip   ST  Width= 100  Align= L
Vendor Main Address 1   ST  Width= 100  Align= L
Vendor Main Address 2   ST  Width= 100  Align= L
Vendor Main Address 3   ST  Width= 100  Align= L
Vendor Main City-State-Zip   ST  Width= 100  Align= L
Vendor Main Country   ST  Width= 100  Align= L

CATEGORY: General Information

Number Of TRX   ST  Width= 100  Align= R
Batch Comment   ST  Width= 100  Align= L
Batch Number   ST  Width= 100  Align= L
Batch Total   SC  Width= 100  Align= R

CATEGORY: GL Distribution

1099 Amount   MC  Width= 100  Align= R
Account Alias   MT  Width= 100  Align= L
Account Description   MT  Width= 100  Align= L
Account Number   MT  Width= 100  Align= L
Account User Defined 1   MT  Width= 100  Align= L
Account User Defined 2   MT  Width= 100  Align= L
Credit Amount   MC  Width= 100  Align= R
Debit Amount   MC  Width= 100  Align= R
Distribution Reference   MT  Width= 100  Align= L
Document Type   MT  Width= 100  Align= L
Enhanced Net Check Amount   MC  Width= 100  Align= R
Freight Amount   MC  Width= 100  Align= R
Intercompany ID   MT  Width= 100  Align= L
Misc Charges Amount   MC  Width= 100  Align= R
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Multi-Currency Debit Minus Credit Amount   MC  Width= 100  Align= R
New Amount Paid (Tech Knowledge 18381)   MC  Width= 100  Align= R
New Document Amount (Tech Knowledge 18381)   MC  Width= 100  Align= R
Originating Credit Amount   MC  Width= 100  Align= R
Originating Debit Amount   MC  Width= 100  Align= R
Payment Terms ID   MT  Width= 100  Align= L
Posting Date   MD  Width= 100  Align= L
Purchase Order Number   MT  Width= 100  Align= L
Purchases Amount   MC  Width= 100  Align= R
Shipping Method   MT  Width= 100  Align= L
Tax Amount   MC  Width= 100  Align= R
Tax Schedule ID   MT  Width= 100  Align= L
Trade Discount Amount   MC  Width= 100  Align= R
TRX Source   MT  Width= 100  Align= L
Voucher Amount Paid   MC  Width= 100  Align= R
Voucher Credit Amount   MC  Width= 100  Align= R
Voucher Credit Document Amount   MC  Width= 100  Align= R
Voucher Discount Date   MD  Width= 100  Align= L
Voucher Discount Taken Amount   MC  Width= 100  Align= R
Voucher Discount Taken Total   MC  Width= 100  Align= R
Voucher Document Amount   MC  Width= 100  Align= R
Voucher Document Date   MD  Width= 100  Align= L
Voucher Document Number   MT  Width= 100  Align= L
Voucher GST Discount Amount   MC  Width= 100  Align= R
Voucher Net Check Amount   MC  Width= 100  Align= R
Voucher Net Paid Amount   MC  Width= 100  Align= R
Voucher Outstanding Amount   MC  Width= 100  Align= R
Voucher Paid Total   MC  Width= 100  Align= R
Voucher PPS Amount Deducted   MC  Width= 100  Align= R
Voucher Total Document Amount   MC  Width= 100  Align= R
Voucher Transaction Description   MT  Width= 100  Align= L
Voucher Voucher Number   MT  Width= 100  Align= L
Voucher Write Off Amount   MC  Width= 100  Align= R
Voucher Write Off Total   MC  Width= 100  Align= R

CATEGORY: MEM Centralized DexName= MEM Centralized

Facility ID   MT  Width= 100  Align= L
Facility Name   MT  Width= 100  Align= L
Facility Company Name   MT  Width= 100  Align= L
Document Number   MT  Width= 100  Align= L
Transaction Description   MT  Width= 100  Align= L
Discount Taken Amount   MC  Width= 100  Align= R

Mekorma Mekorma Products User Guide for GP - Build x91_en

Copyright © 2022 Mekorma Enterprises. All Rights Reserved. Page 357 of 379



Purchase Order Number   MT  Width= 100  Align= L
Net Paid Amount   MC  Width= 100  Align= R
New Amount Paid (Tech Knowledge 18381)   MC  Width= 100  Align= R
Document Date   MD  Width= 100  Align= L
Voucher Number   MT  Width= 100  Align= L
Voucher Date   MD  Width= 100  Align= L
Document Amount   MC  Width= 100  Align= R
Original Document Amount   MC  Width= 100  Align= R
Internet User Defined 1   MT  Width= 200  Align= L
Internet User Defined 2   MT  Width= 200  Align= L

CATEGORY: MEM Decentralized DexName= MEM Decentralized

Facility ID   ST  Width= 100  Align= L
Facility Name   ST  Width= 100  Align= L
Facility Company Name   ST  Width= 100  Align= L
Facility Address   MT  Width= 100  Align= L
Internet User Defined 1   ST  Width= 200  Align= L
Internet User Defined 2   ST  Width= 200  Align= L

CATEGORY: Payment

Amount in Words   MTR  Width= 300  Align= L
Amount in Words with Word Wrapping   MTR  Width= 300  Align= L
Amount in Words (Techknowledge 857824)   MTR  Width= 300  Align= L
Amount in Words (Techknowledge 857824) with Word Wrapping   MTR  Width= 300  Al

ign= L
Check Comment   ST  Width= 100  Align= L
Check Amount with ***   ST  Width= 100  Align= R
Check Number   ST  Width= 100  Align= L
Check Total   SC  Width= 100  Align= R
Document Date   SD  Width= 100  Align= C
Document Date-D1   ST  Width= 20  Align= C
Document Date-D2   ST  Width= 20  Align= C
Document Date-M1   ST  Width= 20  Align= C
Document Date-M2   ST  Width= 20  Align= C
Document Date-Y1   ST  Width= 20  Align= C
Document Date-Y2   ST  Width= 20  Align= C
Document Date-Y3   ST  Width= 20  Align= C
Document Date-Y4   ST  Width= 20  Align= C
EFT or Regular Check Total   SC  Width= 100  Align= R
Payment Comment (from Edit Payables Checks)   ST  Width= 100  Align= L
Payment Number   ST  Width= 100  Align= L
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CATEGORY: POP Single Line Per Invoice

1099 Amount   MC  Width= 100  Align= R
Amount Paid   MC  Width= 100  Align= R
Credit Amount   MC  Width= 100  Align= R
Credit Document Amount   MC  Width= 100  Align= R
Discount Date   MD  Width= 100  Align= L
Discount Taken Amount   MC  Width= 100  Align= R
Discount Taken Total   MC  Width= 100  Align= R
Document Amount   MC  Width= 100  Align= R
Document Date   MD  Width= 100  Align= L
Document Number   MT  Width= 100  Align= L
Document Type   MT  Width= 100  Align= L
Due Date   MD  Width= 100  Align= L
Enhanced Net Check Amount   MC  Width= 100  Align= R
Freight Amount   MC  Width= 100  Align= R
GST Discount Amount   MC  Width= 100  Align= R
Misc Charges Amount   MC  Width= 100  Align= R
Net Check Amount   MC  Width= 100  Align= R
Net Paid Amount   MC  Width= 100  Align= R
New Amount Paid (Tech Knowledge 18381)   MC  Width= 100  Align= R
New Document Amount (Tech Knowledge 18381)   MC  Width= 100  Align= R
Outstanding Amount   MC  Width= 100  Align= R
Paid Total   MC  Width= 100  Align= R
Payment Terms ID   MT  Width= 100  Align= L
POP Extended Cost   MC  Width= 100  Align= L
POP Item Description   MT  Width= 100  Align= L
POP Item Description or Voucher Description   MT  Width= 100  Align= L
POP Item Number   MT  Width= 100  Align= L
POP or Voucher PO Number   MT  Width= 100  Align= L
POP QTY Invoiced   MN  Width= 100  Align= L
POP Receipt Date or Voucher Date   MD  Width= 100  Align= L
POP Receipt Number or Voucher Number   MT  Width= 100  Align= L
POP Reference or Voucher Description   MT  Width= 100  Align= L
POP Unit Cost   MC  Width= 100  Align= L
POP Unit of Measure   MT  Width= 100  Align= L
POP Vendor Document Number   MT  Width= 100  Align= L
Posting Date   MD  Width= 100  Align= L
PPS Amount Deducted   MC  Width= 100  Align= R
Project Contract Name   MT  Width= 100  Align= L
Project Contract Customer   MT  Width= 100  Align= L
Project Contract Number   MT  Width= 100  Align= L
Project Contract ID   MT  Width= 100  Align= L
Project Cost Category Name   MT  Width= 100  Align= L
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Project Customer Number   MT  Width= 100  Align= L
Project Number   MT  Width= 100  Align= L
Project Purchase Order Number   MT  Width= 100  Align= L
Project User Defined1 Contract   MT  Width= 100  Align= L
Project User Defined2 Contract   MT  Width= 100  Align= L
Purchase Order Number   MT  Width= 100  Align= L
Purchases Amount   MC  Width= 100  Align= R
Shipping Method   MT  Width= 100  Align= L
Tax Amount   MC  Width= 100  Align= R
Tax Schedule ID   MT  Width= 100  Align= L
Total Document Amount   MC  Width= 100  Align= R
Trade Discount Amount   MC  Width= 100  Align= R
Transaction Description   MT  Width= 100  Align= L
TRX Source   MT  Width= 100  Align= L
UD Date01   MD  Width= 100  Align= L
UD Date02   MD  Width= 100  Align= L
UD Date03   MD  Width= 100  Align= L
UD Date04   MD  Width= 100  Align= L
UD Date05   MD  Width= 100  Align= L
UD Date06   MD  Width= 100  Align= L
UD Date07   MD  Width= 100  Align= L
UD Date08   MD  Width= 100  Align= L
UD Date09   MD  Width= 100  Align= L
UD Date10   MD  Width= 100  Align= L
UD Date11   MD  Width= 100  Align= L
UD Date12   MD  Width= 100  Align= L
UD Date13   MD  Width= 100  Align= L
UD Date14   MD  Width= 100  Align= L
UD Date15   MD  Width= 100  Align= L
UD Date16   MD  Width= 100  Align= L
UD Date17   MD  Width= 100  Align= L
UD Date18   MD  Width= 100  Align= L
UD Date19   MD  Width= 100  Align= L
UD Date20   MD  Width= 100  Align= L
UD List01   MT  Width= 100  Align= L
UD List02   MT  Width= 100  Align= L
UD List03   MT  Width= 100  Align= L
UD List04   MT  Width= 100  Align= L
UD List05   MT  Width= 100  Align= L
UD Text01   MT  Width= 100  Align= L
UD Text02   MT  Width= 100  Align= L
UD Text03   MT  Width= 100  Align= L
UD Text04   MT  Width= 100  Align= L
UD Text05   MT  Width= 100  Align= L
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UD Text06   MT  Width= 100  Align= L
UD Text07   MT  Width= 100  Align= L
UD Text08   MT  Width= 100  Align= L
UD Text09   MT  Width= 100  Align= L
UD Text10   MT  Width= 100  Align= L
Voucher Number   MT  Width= 100  Align= L
Write Off Amount   MC  Width= 100  Align= R
Write Off Total   MC  Width= 100  Align= R

CATEGORY: POP Multiple Lines Per Invoice

1099 Amount   MC  Width= 100  Align= R
Amount Paid   MC  Width= 100  Align= R
Credit Amount   MC  Width= 100  Align= R
Credit Document Amount   MC  Width= 100  Align= R
Discount Date   MD  Width= 100  Align= L
Discount Taken Amount   MC  Width= 100  Align= R
Discount Taken Total   MC  Width= 100  Align= R
Document Amount   MC  Width= 100  Align= R
Document Date   MD  Width= 100  Align= L
Document Number   MT  Width= 100  Align= L
Document Type   MT  Width= 100  Align= L
Due Date   MD  Width= 100  Align= L
Enhanced Net Check Amount   MC  Width= 100  Align= R
Freight Amount   MC  Width= 100  Align= R
GST Discount Amount   MC  Width= 100  Align= R
Misc Charges Amount   MC  Width= 100  Align= R
Net Check Amount   MC  Width= 100  Align= R
Net Paid Amount   MC  Width= 100  Align= R
New Amount Paid (Tech Knowledge 18381)   MC  Width= 100  Align= R
New Document Amount (Tech Knowledge 18381)   MC  Width= 100  Align= R
Outstanding Amount   MC  Width= 100  Align= R
Paid Total   MC  Width= 100  Align= R
Payment Terms ID   MT  Width= 100  Align= L
POP Extended Cost   MC  Width= 100  Align= L
POP Item Description   MT  Width= 100  Align= L
POP Item Description or Voucher Description   MT  Width= 100  Align= L
POP Item Number   MT  Width= 100  Align= L
POP or Voucher PO Number   MT  Width= 100  Align= L
POP QTY Invoiced   MN  Width= 100  Align= L
POP Receipt Date or Voucher Date   MD  Width= 100  Align= L
POP Receipt Number or Voucher Number   MT  Width= 100  Align= L
POP Reference or Voucher Description   MT  Width= 100  Align= L
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POP Unit Cost   MC  Width= 100  Align= L
POP Unit of Measure   MT  Width= 100  Align= L
POP Vendor Document Number   MT  Width= 100  Align= L
Posting Date   MD  Width= 100  Align= L
PPS Amount Deducted   MC  Width= 100  Align= R
Project Contract Name   MT  Width= 100  Align= L
Project Contract Customer   MT  Width= 100  Align= L
Project Contract Number   MT  Width= 100  Align= L
Project Contract ID   MT  Width= 100  Align= L
Project Cost Category Name   MT  Width= 100  Align= L
Project Customer Number   MT  Width= 100  Align= L
Project Number   MT  Width= 100  Align= L
Project Purchase Order Number   MT  Width= 100  Align= L
Project User Defined1 Contract   MT  Width= 100  Align= L
Project User Defined2 Contract   MT  Width= 100  Align= L
Purchase Order Number   MT  Width= 100  Align= L
Purchases Amount   MC  Width= 100  Align= R
Shipping Method   MT  Width= 100  Align= L
Tax Amount   MC  Width= 100  Align= R
Tax Schedule ID   MT  Width= 100  Align= L
Total Document Amount   MC  Width= 100  Align= R
Trade Discount Amount   MC  Width= 100  Align= R
Transaction Description   MT  Width= 100  Align= L
TRX Source   MT  Width= 100  Align= L
UD Date01   MD  Width= 100  Align= L
UD Date02   MD  Width= 100  Align= L
UD Date03   MD  Width= 100  Align= L
UD Date04   MD  Width= 100  Align= L
UD Date05   MD  Width= 100  Align= L
UD Date06   MD  Width= 100  Align= L
UD Date07   MD  Width= 100  Align= L
UD Date08   MD  Width= 100  Align= L
UD Date09   MD  Width= 100  Align= L
UD Date10   MD  Width= 100  Align= L
UD Date11   MD  Width= 100  Align= L
UD Date12   MD  Width= 100  Align= L
UD Date13   MD  Width= 100  Align= L
UD Date14   MD  Width= 100  Align= L
UD Date15   MD  Width= 100  Align= L
UD Date16   MD  Width= 100  Align= L
UD Date17   MD  Width= 100  Align= L
UD Date18   MD  Width= 100  Align= L
UD Date19   MD  Width= 100  Align= L
UD Date20   MD  Width= 100  Align= L
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UD List01   MT  Width= 100  Align= L
UD List02   MT  Width= 100  Align= L
UD List03   MT  Width= 100  Align= L
UD List04   MT  Width= 100  Align= L
UD List05   MT  Width= 100  Align= L
UD Text01   MT  Width= 100  Align= L
UD Text02   MT  Width= 100  Align= L
UD Text03   MT  Width= 100  Align= L
UD Text04   MT  Width= 100  Align= L
UD Text05   MT  Width= 100  Align= L
UD Text06   MT  Width= 100  Align= L
UD Text07   MT  Width= 100  Align= L
UD Text08   MT  Width= 100  Align= L
UD Text09   MT  Width= 100  Align= L
UD Text10   MT  Width= 100  Align= L
Voucher Number   MT  Width= 100  Align= L
Write Off Amount   MC  Width= 100  Align= R
Write Off Total   MC  Width= 100  Align= R

CATEGORY: UK Cheques

UK Cheque Amount   ST  Width= 100  Align= L
UK Vendor Name Only   ST  Width= 100  Align= L
UK Vendor Name*   ST  Width= 100  Align= L
UK Vendor Name=   ST  Width= 100  Align= L
UK Document Date   SD  Width= 100  Align= L
UK Amount in Words with Word Wrapping   MTR  Width= 300  Align= L

CATEGORY: Vendor

1099 Amount YTD   SC  Width= 100  Align= R
1099 Type   ST  Width= 100  Align= L
Account Number With Vendor   ST  Width= 100  Align= L
Account Type   ST  Width= 100  Align= L
Bank Account Number   ST  Width= 100  Align= L
Bank Name   ST  Width= 100  Align= L
Bank Transit Number   ST  Width= 100  Align= L
Contact Name   ST  Width= 100  Align= L
Fax Number   ST  Width= 100  Align= L
Governmental Corporate ID   ST  Width= 100  Align= L
Governmental Individual ID   ST  Width= 100  Align= L
Parent Vendor ID   ST  Width= 100  Align= L
Payment Address   MT  Width= 100  Align= L
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Payment Address with Country   MT  Width= 100  Align= L
Payment Priority   ST  Width= 100  Align= L
Payment Terms ID   ST  Width= 100  Align= L
Phone 3   ST  Width= 100  Align= L
Phone Number 1   ST  Width= 100  Align= L
Phone Number 2   ST  Width= 100  Align= L
Shipping Method   ST  Width= 100  Align= L
Tax ID Number   ST  Width= 100  Align= L
Tax Registration Number   ST  Width= 100  Align= L
Vendor Address with Contact Name   MT  Width= 100  Align= L
Vendor Check Name   ST  Width= 100  Align= L
Vendor Check Name - SAFE PAY   ST  Width= 100  Align= L
Vendor Class ID   ST  Width= 100  Align= L
Vendor Comment 1   ST  Width= 100  Align= L
Vendor Comment 2   ST  Width= 100  Align= L
Vendor Contact   ST  Width= 100  Align= L
Vendor ID   ST  Width= 100  Align= L
Vendor Main Address   MT  Width= 100  Align= L
Vendor Name   ST  Width= 100  Align= L
Vendor Name - SAFE PAY   ST  Width= 100  Align= L
Vendor Note   MT  Width= 100  Align= L
Vendor Short Name   ST  Width= 100  Align= L
Vendor User Defined 1   ST  Width= 100  Align= L
Vendor User Defined 2   ST  Width= 100  Align= L
DBA   ST  Width= 100  Align= L

CATEGORY: Voucher

1099 Amount   MC  Width= 100  Align= R
Amount Paid   MC  Width= 100  Align= R
Credit Amount   MC  Width= 100  Align= R
Credit Document Amount   MC  Width= 100  Align= R
Discount Date   MD  Width= 100  Align= L
Discount Taken Amount   MC  Width= 100  Align= R
Discount Taken Total   MC  Width= 100  Align= R
Document Amount   MC  Width= 100  Align= R
Document Date   MD  Width= 100  Align= L
Document Number   MT  Width= 100  Align= L
Document Type   MT  Width= 100  Align= L
Due Date   MD  Width= 100  Align= L
Enhanced Net Check Amount   MC  Width= 100  Align= R
Freight Amount   MC  Width= 100  Align= R
GST Discount Amount   MC  Width= 100  Align= R
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Misc Charges Amount   MC  Width= 100  Align= R
Net Check Amount   MC  Width= 100  Align= R
Net Paid Amount   MC  Width= 100  Align= R
New Amount Paid (Tech Knowledge 18381)   MC  Width= 100  Align= R
New Document Amount (Tech Knowledge 18381)   MC  Width= 100  Align= R
Outstanding Amount   MC  Width= 100  Align= R
Paid Total   MC  Width= 100  Align= R
Payment Terms ID   MT  Width= 100  Align= L
Posting Date   MD  Width= 100  Align= L
PPS Amount Deducted   MC  Width= 100  Align= R
Purchase Order Number   MT  Width= 100  Align= L
Purchases Amount   MC  Width= 100  Align= R
Shipping Method   MT  Width= 100  Align= L
Tax Amount   MC  Width= 100  Align= R
Tax Schedule ID   MT  Width= 100  Align= L
Total Document Amount   MC  Width= 100  Align= R
Trade Discount Amount   MC  Width= 100  Align= R
Transaction Description   MT  Width= 100  Align= L
TRX Source   MT  Width= 100  Align= L
Voucher Number   MT  Width= 100  Align= L
Write Off Amount   MC  Width= 100  Align= R
Write Off Total   MC  Width= 100  Align= R

CATEGORY: Refund Single Document

Document Amount   SC  Width= 100  Align= R
Document Date   SD  Width= 100  Align= L
Document Description   ST  Width= 100  Align= L
Document Number   ST  Width= 100  Align= L
Document Type   ST  Width= 100  Align= L
Customer Name   ST  Width= 100  Align= L
Customer Number   ST  Width= 100  Align= L
Customer PO Number   ST  Width= 100  Align= L
Extended Price   MC  Width= 100  Align= R
Freight Amount   SC  Width= 100  Align= R
Item Description   MT  Width= 100  Align= L
Item Number   MT  Width= 100  Align= L
Markdown Amount   MC  Width= 100  Align= R
Misc Amount   SC  Width= 100  Align= R
Quantity   MT  Width= 100  Align= L
Salesperson ID   ST  Width= 100  Align= L
Sales Territory   ST  Width= 100  Align= L
Shipping Method   ST  Width= 100  Align= L
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Tax Amount   SC  Width= 100  Align= R
Trade Discount Amount   SC  Width= 100  Align= R
U Of M   MT  Width= 100  Align= L
Unit Price   MC  Width= 100  Align= R

CATEGORY: Refund Multiple Documents

Document Amount   MC  Width= 100  Align= R
Document Date   MD  Width= 100  Align= L
Document Description   MT  Width= 100  Align= L
Document Number   MT  Width= 100  Align= L
Document Type   MT  Width= 100  Align= L
Customer Name   MT  Width= 100  Align= L
Customer Number   MT  Width= 100  Align= L
Customer PO Number   MT  Width= 100  Align= L
Misc Amount   MC  Width= 100  Align= R
Salesperson ID   MT  Width= 100  Align= L
Sales Territory   MT  Width= 100  Align= L
Shipping Method   MT  Width= 100  Align= L
Tax Amount   MC  Width= 100  Align= R
Trade Discount Amount   MC  Width= 100  Align= R

MEKORMA USA PAYROLL

CATEGORY: Benefits

Benefit Amount Array   MC  Width= 100  Align= R
Benefit Amount YTD Array   MC  Width= 100  Align= R
Benefit Code Array   MT  Width= 100  Align= C
Benefit Description   MT  Width= 100  Align= C
Total Benefits   SC  Width= 100  Align= R

CATEGORY: Check

Amount in Words   MTR  Width= 300  Align= L
Amount in Words with Word Wrapping   MTR  Width= 300  Align= L
Check Amount with ***   ST  Width= 100  Align= R
Check Date   SD  Width= 100  Align= C
Check Date-D1   ST  Width= 20  Align= C
Check Date-D2   ST  Width= 20  Align= C
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Check Date-M1   ST  Width= 20  Align= C
Check Date-M2   ST  Width= 20  Align= C
Check Date-Y1   ST  Width= 20  Align= C
Check Date-Y2   ST  Width= 20  Align= C
Check Date-Y3   ST  Width= 20  Align= C
Check Date-Y4   ST  Width= 20  Align= C
Check Number   ST  Width= 100  Align= C
Facility Name   ST  Width= 100  Align= L
Facility Stub String   ST  Width= 100  Align= L
Facility Check String   ST  Width= 100  Align= L
Facility ID   ST  Width= 100  Align= L
Facility Company Name   ST  Width= 100  Align= L
Facility Address   MT  Width= 100  Align= L
Internet User Defined 1   ST  Width= 200  Align= L
Internet User Defined 2   ST  Width= 200  Align= L
Net WagesPay Run   SC  Width= 100  Align= R
CheckDirect Deposit Amount   SC  Width= 100  Align= R

CATEGORY: Deductions

Deduction Amount Array   MC  Width= 100  Align= R
Deduction Amount YTD Array   MC  Width= 100  Align= R
Deduction Code Array   MT  Width= 100  Align= C
Deduction Description   MT  Width= 100  Align= C
Total Deductions   SC  Width= 100  Align= R

CATEGORY: Detailed Addresses

Bank Address 1   ST  Width= 100  Align= L
Bank Address 2   ST  Width= 100  Align= L
Bank Address 3   ST  Width= 100  Align= L
Bank City-State-Zip   ST  Width= 100  Align= L
Bank Country   ST  Width= 100  Align= L
Company Address 1   ST  Width= 100  Align= L
Company Address 2   ST  Width= 100  Align= L
Company Address 3   ST  Width= 100  Align= L
Company City-State-Zip   ST  Width= 100  Align= L
Company Country   ST  Width= 100  Align= L
Employee Address 1   ST  Width= 100  Align= C
Employee Address 2   ST  Width= 100  Align= C
Employee Address 3   ST  Width= 100  Align= C
Employee City-State-Zip   ST  Width= 100  Align= C
Employee Country   ST  Width= 100  Align= C
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Employee Country Code   ST  Width= 100  Align= C
Employee County   ST  Width= 100  Align= C
Employee Fax   ST  Width= 100  Align= C
Employee Foreign Postal Code   ST  Width= 100  Align= C
Employee Foreign StateProvince   ST  Width= 100  Align= C
Employee Phone 1   ST  Width= 100  Align= C
Employee Phone 2   ST  Width= 100  Align= C
Employee Phone 3   ST  Width= 100  Align= C
Employee Zip   ST  Width= 100  Align= C
First Name   ST  Width= 100  Align= C
Last Name   ST  Width= 100  Align= C
Middle Name   ST  Width= 100  Align= C

CATEGORY: Direct Deposit

DD Array12 Account Number   MT  Width= 100  Align= C
DD Array12 Amount   MC  Width= 100  Align= R
DD Array12 Transaction Code   MT  Width= 100  Align= C
DD Array12 Transit Number   MT  Width= 100  Align= C
DD Number of Accounts   ST  Width= 100  Align= R
Net WagesPay Run (Stub Only)   SC  Width= 100  Align= R

CATEGORY: Earnings

Business Expense Earnings   SC  Width= 100  Align= R
Charged Tips Earnings   SC  Width= 100  Align= R
Commission Earnings   SC  Width= 100  Align= R
Double Time Earnings   SC  Width= 100  Align= R
EIC Earnings   SC  Width= 100  Align= R
Holiday Earnings   SC  Width= 100  Align= R
Min Wage Bal Earnings   SC  Width= 100  Align= R
Overtime Earnings   SC  Width= 100  Align= R
Pension Earnings   SC  Width= 100  Align= R
Piecework Earnings   SC  Width= 100  Align= R
Piecework Units   ST  Width= 100  Align= R
Regular Earnings   SC  Width= 100  Align= R
Reported Tips Earnings   SC  Width= 100  Align= R
Sick Time Earnings   SC  Width= 100  Align= R
Special Earnings   SC  Width= 100  Align= R
Total Earnings   SC  Width= 100  Align= R
Vacation Earnings   SC  Width= 100  Align= R
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CATEGORY: Employee

Alternate Name   ST  Width= 100  Align= C
Class Description   ST  Width= 100  Align= C
Department   ST  Width= 100  Align= C
Department Additional Description   ST  Width= 100  Align= C
Department Description   ST  Width= 100  Align= C
Division Address 1   ST  Width= 100  Align= C
Division Address 2   ST  Width= 100  Align= C
Division City-State-Zip   ST  Width= 100  Align= C
Division Code   ST  Width= 100  Align= C
Division Name   ST  Width= 100  Align= C
Employee Address   MT  Width= 100  Align= L
Employee Class   ST  Width= 100  Align= C
Employee Full Name - SAFE PAY   ST  Width= 100  Align= C
Employee ID   ST  Width= 100  Align= C
Employee Name   ST  Width= 100  Align= C
Employee Name with Suffix   ST  Width= 100  Align= C
Employee Note   MT  Width= 100  Align= L
Employee Suffix   ST  Width= 40  Align= L
Employee User Defined 1   ST  Width= 100  Align= C
Employee User Defined 2   ST  Width= 100  Align= C
Federal Classification Code   ST  Width= 100  Align= C
First Name   ST  Width= 100  Align= C
Job Title   ST  Width= 100  Align= C
Job Title Description   ST  Width= 100  Align= C
Last Name   ST  Width= 100  Align= C
Location ID   ST  Width= 100  Align= C
Middle Name   ST  Width= 100  Align= C
NickName   ST  Width= 100  Align= C
Rate Class   ST  Width= 100  Align= C
Social Security Number   ST  Width= 100  Align= C
Social Security Number-MASKED   ST  Width= 100  Align= C
Supervisor Code   ST  Width= 100  Align= C
Type of Employment   ST  Width= 100  Align= C
Union Code   ST  Width= 100  Align= C

CATEGORY: Federal Taxes

Dependent Claim Amount   SC  Width= 100  Align= R
Estimated Federal Withholding   SC  Width= 100  Align= R
Federal Additional Withholding   SC  Width= 100  Align= R
Federal Filing Status   ST  Width= 100  Align= C
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Federal Withholding Exemptions   ST  Width= 100  Align= R
Federal Withholding YTD   SC  Width= 100  Align= R
Federal WithholdingPay Run   SC  Width= 100  Align= R
FICA Withholding YTD   SC  Width= 100  Align= R
FICAMedicare Withholding YTD   SC  Width= 100  Align= R
FICAMedicare WithholdingPay Run   SC  Width= 100  Align= R
FICASocial Security Withholding YTD   SC  Width= 100  Align= R
FICASocial Security WithholdingPay Run   SC  Width= 100  Align= R
Total FICA Tax Withheld   SC  Width= 100  Align= R
Uncollected FICAMed TaxPay Run   SC  Width= 100  Align= R
Uncollected FICASS TaxPay Run   SC  Width= 100  Align= R
Employer ID Number   ST  Width= 9  Align= R

CATEGORY: Hours

Days Worked YTD   ST  Width= 100  Align= R
Double Time Hours   ST  Width= 100  Align= R
Holiday Hours   ST  Width= 100  Align= R
Hours Worked YTD   ST  Width= 100  Align= R
Overtime Hours   ST  Width= 100  Align= R
Regular Hours   ST  Width= 100  Align= R
Sick Time Available   ST  Width= 100  Align= R
Sick Time Hours   ST  Width= 100  Align= R
Time Available Array   MN  Width= 100  Align= R
Time Code Array   MT  Width= 100  Align= C
Time Code Description Array   MT  Width= 100  Align= C
Total Hours   ST  Width= 100  Align= R
Vacation Available   ST  Width= 100  Align= R
Vacation Hours   ST  Width= 100  Align= R
Weeks Worked YTD   ST  Width= 100  Align= R
Work Hours Per Year   ST  Width= 100  Align= R

CATEGORY: Local Taxes

Local Tax Array   MT  Width= 100  Align= C
Local Tax Description   MT  Width= 100  Align= C
Local Tax Withholding Array   MC  Width= 100  Align= R
Local Tax YTD   MC  Width= 100  Align= R
Local Withholding YTD   SC  Width= 100  Align= R
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CATEGORY: Pay Data

Pay Code Array   MT  Width= 100  Align= C
Pay Code Description   MT  Width= 100  Align= C
Pay Earnings Array   MC  Width= 100  Align= R
Pay Hours Array   MN  Width= 100  Align= R
Pay Hours Array-Blank for Salary   MN  Width= 100  Align= R
Pay Rate Array   MC  Width= 100  Align= R
Pay Rate Array-Blank for Salary   MC  Width= 100  Align= R
Pay Type Array   MT  Width= 100  Align= C
Pay Type Array-Short   MT  Width= 100  Align= C
Pay Type Description   ST  Width= 100  Align= R
Pay Type Description-Short   ST  Width= 100  Align= R
Pay YTD Array   MC  Width= 100  Align= R
Total YTD Pay Code Earnings   SC  Width= 100  Align= R

CATEGORY: Pay Stub Information

End Pay Period   SD  Width= 100  Align= C
Federal WagesPay Run   SC  Width= 100  Align= R
Gross Wages YTD   SC  Width= 100  Align= R
Gross WagesPay Run   SC  Width= 100  Align= R
Net Wages YTD   SC  Width= 100  Align= R
PaymentAdjustment Number   ST  Width= 100  Align= R
Start Pay Period   SD  Width= 100  Align= C
Total Taxes   SC  Width= 100  Align= R
Total Taxes YTD   SC  Width= 100  Align= R
User ID   ST  Width= 100  Align= C

CATEGORY: State Taxes

Additional Allowances   MT  Width= 100  Align= R
State Additional Withholding   MC  Width= 100  Align= R
State Filing Status   MT  Width= 100  Align= C
State Name   ST  Width= 100  Align= C
State Number of Dependents   MT  Width= 100  Align= R
State Tax Array   MT  Width= 100  Align= C
State Tax Withholding Array   MC  Width= 100  Align= R
State Tax YTD   MC  Width= 100  Align= R
State Withholding YTD   SC  Width= 100  Align= R
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CATEGORY: Tips

Allocated Tips YTD   SC  Width= 100  Align= R
Charged Receipts YTD   SC  Width= 100  Align= R
Charged Tips YTD   SC  Width= 100  Align= R
Federal Tax On Tips YTD   SC  Width= 100  Align= R
Federal Tips YTD   SC  Width= 100  Align= R
FICAMed Tax On Tips YTD   SC  Width= 100  Align= R
FICAMed Tips YTD   SC  Width= 100  Align= R
FICASS Tax On Tips YTD   SC  Width= 100  Align= R
FICASS Tips YTD   SC  Width= 100  Align= R
Reported Receipts YTD   SC  Width= 100  Align= R
Reported Tips YTD   SC  Width= 100  Align= R
Uncollected FICAMed Tax YTD   SC  Width= 100  Align= R
Uncollected FICASS Tax YTD   SC  Width= 100  Align= R

CATEGORY: Payroll Custom DexName= Payroll Custom

Hours Array   MN  Width= 100  Align= R

MEKORMA CANADIAN PAYROLL

CATEGORY: Detailed Addresses

Bank Address 1   ST  Width= 100  Align= L
Bank Address 2   ST  Width= 100  Align= L
Bank Address 3   ST  Width= 100  Align= L
Bank City-State-Zip   ST  Width= 100  Align= L
Bank Country   ST  Width= 100  Align= L
City   ST  Width= 100  Align= L
Company Address 1   ST  Width= 100  Align= L
Company Address 2   ST  Width= 100  Align= L
Company Address 3   ST  Width= 100  Align= L
Company City-State-Zip   ST  Width= 100  Align= L
Company Country   ST  Width= 100  Align= L
Country   ST  Width= 100  Align= L
Employee Address 1   ST  Width= 100  Align= L
Employee Address 2   ST  Width= 100  Align= L
Employee City-Province-Postal Code   ST  Width= 100  Align= L
First Name   ST  Width= 100  Align= L
Last Name   ST  Width= 100  Align= L
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Middle Name   ST  Width= 100  Align= L
Phone   ST  Width= 100  Align= L
Postal Code   ST  Width= 100  Align= L
Province   ST  Width= 100  Align= L

CATEGORY: Detailed Advice

Income Pay Code   MT  Width= 100  Align= L
Income Description   MT  Width= 100  Align= L
Income Rate   MC  Width= 100  Align= R
Income Units   MN  Width= 100  Align= R
Income Current $   MC  Width= 100  Align= R
Income YTD Units   MN  Width= 100  Align= R
Income YTD Dollars   MC  Width= 100  Align= R

CATEGORY: Employee

Address   MT  Width= 100  Align= L
Birth Date   SD  Width= 100  Align= L
City   ST  Width= 100  Align= L
Class ID   ST  Width= 100  Align= L
Country   ST  Width= 100  Align= L
Department   ST  Width= 100  Align= L
Employee ID   ST  Width= 100  Align= L
First Name   ST  Width= 100  Align= L
Full Name   ST  Width= 100  Align= L
Last Name   ST  Width= 100  Align= L
Middle Name   ST  Width= 100  Align= L
Phone   ST  Width= 100  Align= L
Position   ST  Width= 100  Align= L
Postal Code   ST  Width= 100  Align= L
Province   ST  Width= 100  Align= L
SIN   ST  Width= 100  Align= L
Start Date   SD  Width= 100  Align= L
Taxable Province   ST  Width= 100  Align= L
User Defined 1   ST  Width= 100  Align= L
User Defined 2   ST  Width= 100  Align= L
User ID   ST  Width= 100  Align= L

CATEGORY: Payment Details

Deduction Description   MT  Width= 100  Align= L
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Deduction Employee Share   MC  Width= 100  Align= R
Deduction Employer Share   MC  Width= 100  Align= R
Deduction Paycode   MT  Width= 100  Align= L
Deduction Rate   MC  Width= 100  Align= R
Deduction Taxable Benefit Amount   MC  Width= 100  Align= R
Deduction Units   MN  Width= 100  Align= R
Earnings Amount   MC  Width= 100  Align= R
Earnings Dept   MT  Width= 100  Align= L
Earnings Description   MT  Width= 100  Align= L
Earnings Paycode   MT  Width= 100  Align= L
Earnings Rate   MC  Width= 100  Align= R
Earnings Transaction Date   MD  Width= 100  Align= L
Earnings Units   MN  Width= 100  Align= R

CATEGORY: Summary Advice

Income Pay Code   MT  Width= 100  Align= L
Income Description   MT  Width= 100  Align= L
Income Rate   MC  Width= 100  Align= R
Income Units   MN  Width= 100  Align= R
Income Current $   MC  Width= 100  Align= R
Income YTD Units   MN  Width= 100  Align= R
Income YTD Dollars   MC  Width= 100  Align= R
Benefit Pay Code   MT  Width= 100  Align= L
Benefit Description   MT  Width= 100  Align= L
Benefit Rate   MC  Width= 100  Align= R
Benefit Units   MN  Width= 100  Align= R
Benefit Current $   MC  Width= 100  Align= R
Benefit YTD Units   MN  Width= 100  Align= R
Benefit YTD Dollars   MC  Width= 100  Align= R
Deduction Pay Code   MT  Width= 100  Align= L
Deduction Description   MT  Width= 100  Align= L
Deduction Rate   MC  Width= 100  Align= R
Deduction Units   MN  Width= 100  Align= R
Deduction Current $   MC  Width= 100  Align= R
Deduction YTD Units   MN  Width= 100  Align= R
Deduction YTD Dollars   MC  Width= 100  Align= R

CATEGORY: Payment Summary

Accumulated Days   ST  Width= 100  Align= R
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Accumulated Overtime Hours   ST  Width= 100  Align= R
Accumulated Regular Hours   ST  Width= 100  Align= R
Accumulated User1   ST  Width= 100  Align= R
Accumulated User2   ST  Width= 100  Align= R
Accumulated User3   ST  Width= 100  Align= R
Accumulated User4   ST  Width= 100  Align= R
Advance Amount Drawn   SC  Width= 100  Align= R
Advance Amount Reclaim   SC  Width= 100  Align= R
Arrears Amount Created   SC  Width= 100  Align= R
Arrears Amount Reclaim   SC  Width= 100  Align= R
Batch Number   ST  Width= 100  Align= L
Bonus Income   SC  Width= 100  Align= R
Cheque Amount with ***   ST  Width= 100  Align= R
Cheque Date   SD  Width= 100  Align= C
Cheque Date-D1   ST  Width= 100  Align= 3
Cheque Date-D2   ST  Width= 100  Align= 3
Cheque Date-M1   ST  Width= 100  Align= 3
Cheque Date-M2   ST  Width= 100  Align= 3
Cheque Date-Y1   ST  Width= 100  Align= 3
Cheque Date-Y2   ST  Width= 100  Align= 3
Cheque Date-Y3   ST  Width= 100  Align= 3
Cheque Date-Y4   ST  Width= 100  Align= 3
Cheque Number   ST  Width= 100  Align= L
End Date   SD  Width= 100  Align= L
Net Pay   SC  Width= 100  Align= R
Net Pay Words MTR Width= 300  Align= L
Net Pay Words Numbers MTR Width= 300  Align= L
Overtime Income   SC  Width= 100  Align= R
Payment Method   ST  Width= 100  Align= L
Regular Income   SC  Width= 100  Align= R
Retroactive Income   SC  Width= 100  Align= R
Start Date   SD  Width= 100  Align= L
Total Withholdings   SC  Width= 100  Align= R

CATEGORY: Vacation

Accrual Amount   SC  Width= 100  Align= R
Accrual Units   ST  Width= 100  Align= R
Accrual Unpaid Units   ST  Width= 100  Align= R
Accruing Amount   SC  Width= 100  Align= R
Accruing Available After Date   SD  Width= 100  Align= L
Accruing Units   ST  Width= 100  Align= R
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Accruing Unpaid Units   ST  Width= 100  Align= R
Available Amount   SC  Width= 100  Align= R
Available Payout After Date   SD  Width= 100  Align= L
Available Units   ST  Width= 100  Align= R
Available Unpaid Units   ST  Width= 100  Align= R
Opening Balance   SC  Width= 100  Align= R
YTD Accrued Vacation   SC  Width= 100  Align= R

CATEGORY: YTD Tax Return

Basic Personal Amount - AB   SC  Width= 100  Align= R
Basic Personal Amount - BC   SC  Width= 100  Align= R
Basic Personal Amount - Federal   SC  Width= 100  Align= R
Basic Personal Amount - MB   SC  Width= 100  Align= R
Basic Personal Amount - NB   SC  Width= 100  Align= R
Basic Personal Amount - NL   SC  Width= 100  Align= R
Basic Personal Amount - NS   SC  Width= 100  Align= R
Basic Personal Amount - NT   SC  Width= 100  Align= R
Basic Personal Amount - NU   SC  Width= 100  Align= R
Basic Personal Amount - ON   SC  Width= 100  Align= R
Basic Personal Amount - PE   SC  Width= 100  Align= R
Basic Personal Amount - SK   SC  Width= 100  Align= R
Basic Personal Amount - YT   SC  Width= 100  Align= R
CPP Deducted 16   SC  Width= 100  Align= R
CPP Pensionable 26   SC  Width= 100  Align= R
EI Deducted 18   SC  Width= 100  Align= R
EI Insurable 24   SC  Width= 100  Align= R
Employment Income 14   SC  Width= 100  Align= R
Income Tax Deducted 22   SC  Width= 100  Align= R
Quebec TP-1015.3-V Base   SC  Width= 100  Align= R
Registered Pension 20   SC  Width= 100  Align= R
Taxable Benefits   SC  Width= 100  Align= R
Taxable Income   SC  Width= 100  Align= R
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12. Appendix 3: Mekorma Support Tool
Mekorma has created the Mekorma Support Tool within Payment Hub. For most of support cases, support
technician will ask client to provide their current configurations, i.e security, checkbook setup, …etc. based
on the request.
The Support tool saves the client a lot of work in grabbing the Mekorma configuration data and sending it
back to Support.

To access Mekorma Support tool, navigate to About GP window > Additional button > Mekorma
Products Manager.

In this window, user will be able to see all Mekorma Products installed and version. In order to access tool,
click on Support menu item and then on Mekorma Support Tool.

This will bring up the Mekorma Support Tool window.

Mekorma Mekorma Products User Guide for GP - Build x91_en

Copyright © 2022 Mekorma Enterprises. All Rights Reserved. Page 377 of 379



On the right column the last item is the Additional Files:

To add Additional Files (such as Dynamics.set and Dex.ini) right click to find the Attach files option.

Run a report

To run a new diagnostic report, the user will need to:

1. Add the case number provided by Mekorma support team. If you do not have one, leave this field
blank.

2. GP User ID is defaulted with current login user and is read-only.
3. Enter your own email address,
4. Select the companies that are experiencing support issues.

To send your file,

1. Click on File > Save.
2. Browse to the desire location to save the report. The file name is defaulted to

Mekorma_Support__yymmdd_hhmmss.gz. The file is a compressed gz file.

Once report file has been saved, attach the file to your Case via the Mekorma Portal.

You can also review the configuration data in the right column area by expanding Document section. This
will bring a series of sections extracted from the database that will display the report information in a
hierarchical manner. All information to be sent to support will be within this area for your review.
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Create a New Report

To clear selections and create a new report:

1. click on File > New.

This will clear existing selections and fields and will let the user generate another report with different
selections.

Review an Old Report

If you would like to review an old report, you have to know where you stored the generated json file.

1. Access Mekorma Support Tool
2. Select File > Open
3. Browse to existing report and select it

Last modified: May 16, 2023
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